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Introduction

AutoFlow Pro provides an extremely advanced solution for flowing and re-
flowing entire documents. With AutoFlow Pro you fully control the layout
of both text and images, using both master frames and non-master frames.
Please read this manual carefully and see our video tutorials as well, to fully
understand what AutoFlow Pro can do for you. Another valuable resource is
our online forums where you can find help with any issues you might have.
Once you understand the capabilities of AutoFlow Pro, we are confident that

AutoFlow Pro will change how you lay out documents forever!

AutoFlow Pro Basics

When laying out text in InDesign, the useris faced with some basic problems:

1. Text edited in InDesign does not flow dynamically. To correct the resul-

tant overset text, text frames must constantly be added and re-sized.

2. When laying out multiple columns in InDesign, text frames are flowed
to fill the first column before filling the second column. The only way to bal-

ance columns is to shrink the frames to fit the text.

AutoFlow Pro allows text frames to dynamically expand and shrink. The
automatic re-sizing can even be set for threaded stories. AutoFlow Pro does
not require the use of master text frames—an important advantage over

other products which offer auto-flow capabilities.

If you are familiar with PageMaker’s “springy” window-shades, and InDe-
sign CS4’s Smart Text Reflow, you will understand the basic AutoFlow Pro
settings. However, AutoFlow Pro goes far beyond the basic functionality of
either of these two functions. It will automatically identify whether the text

frame is snapped to margins, or column guides, set to a custom position,



http://in-tools.com/learning/video-tutorials/
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or is based on a master text frame. Depending on each of these situations,
AutoFlow Pro will flow the text in the appropriate way. Please see page 19 for
an in-depth explanation of Frame Types and how they behave.

Additionally, AutoFlow Pro can have different flow settings for different sto-
ries in your document. These settings can be set on six different levels as
explained on page 17. They can be set for both master text frames and regu-

lar text frames which are not connected to masters.

Advanced Features
AutoFlow Pro goes far beyond the basic text flow settings, which allow text
frames and pages to be added or deleted as you type or edit text. AutoFlow

Pro is a truly advanced pagination tool.

1. AutoFlow Pro can automatically determine which master pages are used
as the text flows, by creating master-page-to-paragraph-style links. When
AutoFlow Pro encounters a paragraph style which has a link defined, the
master page is automatically changed to the linked one, and the text frames

will be sized to fit. See page 35 for more details on Master Page Links.

2. AutoFlow Pro can be used to automatically repaginate your file as you
edit it. When used in conjunction with Story Tools, which can split a story
into smaller Story Strings, AutoFlow Pro can automatically add and remove

pages between articles as you edit text.

3. AutoFlow Pro allows you to simply set your text to Full Text Flow, and
your multi-column articles will always have the columns balanced at their

end.

4. AutoFlow Pro can be used to transform master pages into true dynamic

templates which can totally transform a live page by simply applying a new
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master page. Both text frames and graphic frames can be set up to be master
content holders and the content will dynamically reposition and optionally
resize themselves any time the page changes sides, or a different master page
is applied. It’s truly amazing to watch! Please refer to page 38 for more infor-
mation on Master Threads, and page 43 for information on Master Content
Frames.

AutoFlow Pro allows you to have complete control over how your layout will
look while automatically taking care to make sure that things don’t inadver-

tently change.

Once you use AutoFlow Pro, you will never look at master pages the same way
again!

nmm Please note: Because the Smart Text Reflow feature of InDesign
CS4 conflicts with AutoFlow Pro’s reflowing of text, setting any
of the six flow settings of AutoFlow Pro, automatically disables
Smart Text Reflow for the entire document. There will be
no warning of any kind. AutoFlow Pro is much more than a
replacement for Smart Text Reflow, so this should not be an
issue. However, with AutoFlow Pro, you must set each story

explicitly to flow.
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Examples of Use

The uses of AutoFlow Pro are extremely diversified. Below are just a few

examples of how AutoFlow Pro can be used to streamline your workflow.

Berkshire Encyclopedia of China

Brad Walrod recently headed a group of book compositors responsible for
laying out an encyclopedia of China. The project was a rather large one with
close to a thousand articles spread across many InDesign files. Part of the
challenge of the project was the application of the correct master page at the
start of each article. Additionally, the articles were to be laid out in a two-
column layout. The columns were to be balanced at the end of the articles
to maintain a balanced look. The articles changed sizes as the project pro-
gressed when text was edited or art was added and removed. Ensuring that
the layout retained its correct formatting was not a simple goal—especially

while the work changed hands among the different compositors.

AutoFlow Pro (while still in its alpha stage) was used in this project from the
start. AutoFlow Pro automatically applied the correct master pages when the
articles were placed. Story Tools (part of our Layout Tools plug-in) was used
to automatically split the articles into separate stories, and AutoFlow Pro
automatically balanced the articles and inserted/removed pages between

articles as needed.

Master Threads (page 38) and Master Page linking (page 35) were used
together with the Full Text Flow setting (page 18) to achieve the objective.
The use of AutoFlow Pro helped keep control of the project and saved count-

less hours of work.
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Examples of Use

Multi-Text Layout

One of the very big challenges of laying out technical Hebrew publications
is the composition of multiple related texts on the same page. This type of
complicated layout is commonly referred to (in the Hebrew typesetting
community) as “Rav” Text or Multi-Text layout. While AutoFlow Pro is not
intended to be a full solution for this kind of complicated layout, it can be

used to successfully make this kind of layout much less tedious.

In the example below, there are four different texts all being laid out in rela-
tion to each other. Some pages will contain all four texts, while others will
contain only the main commentary. All verso (left-hand) pages will contain
only the commentary text; some of the recto (right-hand) pages will con-
tain all the texts, and some only the commentary. Page sides can change as
text is flowed in and edited. With the appropriate application of AutoFlow
Pro settings, all texts will flow to the correct page placement, whether verso

or recto.

* a3 190 Aniu axin N3 997

T e Main Text

Commentary #1

— Commentary #2

Commentary #3
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The proper use of Master Threads can be used to easily add and remove the
different texts to individual pages as needed by simply changing master
pages. Additionally, the correct texts can be made to appear and disappear

automatically as sides change to keep the layout the way it was intended.
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To achieve this, we need to create a few different master pages, and we will
use two different layers. Shown above is a screen shot of the master page
which will enable all the texts on the recto page, and disable all but the com-
mentary on the verso page. We use InDesign’s ability to thread text across
layers to our advantage. Each Master Thread on the recto page is threaded to
a corresponding text frame on the verso page. With the exception of the
commentary thread, they are all threaded to text frames on the hidden layer.
As soon as the text frames are properly threaded we hide the layer by click-

ing on the eye icon. o "
[~ Hidden
= [ |.Text Layer Am
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Since the hidden text frames were created too small to actually hold any text,

the text will not be composed on verso pages.

Once we set up master pages for the different scenarios with small text
frames on hidden layers for all the “non-active” text, we only need to change

the master page to add or remove text from a page.

A Master
Applied

B Master
Applied

Threaded to
Tiny Text Frames
on Hidden Layer
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Magazine Layout

One of the big challenges of magazine layout is dealing with typefitting of
articles—very often under tight deadlines. Small changes to copy can drasti-
cally affect the layout of the whole page. To keep the proper appearance of
the page after copy is added or removed, it is often necessary to alter many
aspects of the layout structure. This is a time consuming process as well as

being very error prone—especially when working under pressure.

AutoFlow Pro can be an incredible time-saver, and is indispensable in keep-
ing control of design quality and avoiding mistakes. To use AutoFlow Pro in
this, way, master page templates should be set up in advance with different
variations on the page design. These different master pages can be applied
on the fly to quickly see variations on the current layout or improve the

copy-fitting of article copy.
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Installation
AutoFlow Pro was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page S7.

All the necessary components of AutoFlow Pro are installed in a single step

by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

(o NeNé) ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INylools.com
Package Name Action Size

@ Introduction T InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
8 Read Ma ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

It is recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Next = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick 'Next', If you would like to select a different folder, dlick 'Browse'.

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!tools.com

m Plugins

! ‘ Product Status Latest Version
World Tools Activated 1.0.5 Update:

P it arL AutoFlow Pro Activated 18

Column Flow Activated 1.0.7
Style Utilities Activated 1.0.8
- Proper V1 Activated 1.0.6
Gt Help Reflective Objects Activated 1.0.5
Power Headers Activated 2.0.5
Side Heads Activated 1.0.7
Story Cantrol Activated 1.0.7
—
Heport H Bug Drop Words Demo: 23 days left Fictiuate 1.0.5

Drop Words creates “drop werds” commanly used In classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your
plugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. Ifit is installed as part of a suite, all the
components of the suite will be activated as a whole. Wait a few moments

while the activation process completes. hen it

Connecting to In-Tools Website. Please wait...

does, you will need to restart InDesign.
Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@In-tools.com Password: Fdk HEHEEEE

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.



http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Getting Started

AutoFlow Pro has six basic settings: 1. Add Pages 2. Expand Frames and
Pages 3. Full Text Flow 4. Resize Down §. Resize Up 6. Resize
From Center. These settings are divided into two basic groups. The first
three settings will add pages, while the last three will only fit a story’s last
text frame, but will not add pages. Setting #1 is similar to “Smart Text Flow”
in InDesign CS4, and setting #4 is similar to the “springy window-shades”
in PageMaker.

The exact behavior of each of these settings depends heavily on how your
text frame is positioned. AutoFlow Pro automatically identifies four different

types of text frames and behaves differently for each kind. The four different
kinds of text frames are: 1. Margin Frames, 2. Column Frames, 3. Custom
Frames,and 4. Master Frames. Each of these kinds of frames and how they
are identified will be explained in detail on page 19, but for the sake of sim-
plicity while explaining the difference between the six different settings, we

will assume that your text frames fit the margins of your page.

1. “Add Pages” does just that. It adds as many pages as needed to fit your
text when the last frame in your story is over-set. If there is a blank page
following your story with the same master page applied, a text frame will
be created on this existing page. Otherwise, pages will always be added at
the end of the current story, and new text frames will be created as neces-
sary to fit the page margins. A blank page is defined as a page with no text
frames which fall within the margin area. If you have text frames which fall
entirely outside the margins of your page, the page will still be considered to
be “blank”.
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2. “Expand Frames and Pages” expands the last frame in your story to the
bottom margin as you add text. It will only add as much space as needed to
fit your text. If the frame is over-set after it is expanded to the bottom mar-
gin, AutoFlow Pro will add pages as needed. It will not shrink frames—only
expand them. If your computer has a slower processor, you might want to
use this setting rather than “Full Text Flow” when you only need to expand
(and not shrink) frames. “Full Text Flow” has more overhead and may slow

editing more than “Expand Frames”.

3. “Full Text Flow” offers the same functionality as “Expand Frames and
Pages”, plus it shrinks frames and removes empty pages when text is deleted.
There is a slight delay (about a second) between editing and shrinking to
prevent constant processing while editing text. If you are using multi-column

frames, “Full Text Flow” will ensure that your columns are always balanced.

4. “Resize Down” will make the last text frame in a story “springy” so that
it will expand downwards to fit the contained text. It will fit itself to the text
as text is added and removed. New text frames will not be added. When the
text frame reaches the bottom margin, and the text remains overset, the text

frame will stop resizing and the text will remain overset.

5. “Resize Up” is similar to “Resize Down’, but instead of the text frame
expanding down, it will expand upwards. This is especially useful for manu-

ally positioned footnote frames.

6. “Resize From Center” is similar to the last two options, but the text
frame is expanded equally upwards and downwards. The frame expands

until it reaches either the top or bottom margins.

Regardless of which settings you choose, AutoFlow Pro will only adjust the
last text frame in your story. It will not adjust frames in the middle of your
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story flow (for example, even if it might be able to be shrunk to balance col-
umns, or expanded to fit more text). If you would like to fit intermediate text
frames (for example to balance columns better), you can do so manually by
selecting either “Shrink Selected Frame(s)” or “Fit Selected Frame(s)”. The
difference between these two options is that “Fit Selected Frame(s)” will
either shrink, or expand to fit as much text a possible while remaining within
the margins, while “Shrink Selected Frame(s)” will only shrink to fit the text

currently contained by the text frame.

- Please note: Because the Smart Text Reflow feature of InDesign
CS4 conflicts with AutoFlow Pro’s reflowing of text, setting any
of the six flow settings of AutoFlow Pro, automatically disables
Smart Text Reflow for the entire document. There will be no
warning of any kind. AutoFlow Pro is much more than a replace-
ment for Smart Text Reflow, so this should not be an issue.
However, with AutoFlow Pro, you must set each story explicitly

to flow.

Frame Types

As mentioned earlier, AutoFlow Pro identifies four different frame types
while flowing text, and will flow the text accordingly. Below is an explana-

tion of these different frame types and the differences between them.

Margin Frames

Margin Frames are frames which fit exactly within the page margins. Margin
Frames do not need to fit to the top or bottom margins. If they fit exactly
between the inner and outer page margins, AutoFlow Pro will identify them

as being Margin Frames. The flowing of Margin Frames is very simple: text
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frames will always expand downwards until they reach the bottom margin if
the flow setting is set to Expand Frames or Full Text Flow. If the flow settings
are set to add pages, new text frames will be added to fill the margins of the
following page. New text frames which are created while flowing text will
always fill the margins on the sides as well as on top and bottom. This is true

even if the previous text frame does not snap to the top or bottom margin.

Column Frames

Column Frames are identified as frames which are snapped on their sides
to column guides. Like Margin Frames, Column Frames do not need to be
snapped to the top or bottom margins. The main difference between Margin
Frames and Column Frames, is that Column Frames will be created and flow
to fill each column of the page in turn, while Margin Frames will fit the entire
page margins. It is important to note that when there is only one column
defined on the page, text frames will always be defined as Column Frames—
not Margin Frames. In situations where there is only one margin there is no
practical difference between them, but this can have an effect when there are
paragraph style-to-master page links as explained later. In right-to-left docu-
ments, the column direction on column frames is inferred from the Story

Direction of the story—not the Binding Direction of the document.

Custom Frames

Custom Frames are text frames which do not fit the definition of either Mar-
gin Frames, or Column Frames. Basically any frame which is not snapped
to either the page margins or column guides on both sides and not based
on master text frames will be considered Custom Frames. The behavior of
Custom Frames depends on which flow settings are chosen as well as some

preference settings. For all settings, the position of the Custom Frames on





Frame Types

documents with facing pages will depend on the preference settings. There
are two possible positions: “Static Position” and “Spine Relative Position”
Static Position will place the new frames on the exact same coordinates,
while Spine-Relative Position will place them the same distance from the
spine. Usually “Spine Relative Position” will be the desirable setting for

documents with facing pages.

If “Add Pages” is selected, new text frames will be created as needed on new

pages in exactly the same location and size as the original.

If the “Expand” or “Full Text Flow” settings are selected, new frames will
be added with the same right and left positions (subject to the “Static” or
“Spine Relative” setting). The top of the frame will be the same as the origi-

nal, but the bottom will expand down to the bottom margin.

Master Frames

Master Frames are text frames which originated on master pages and were
overridden (partially detached from the master page) to flow the text into
them. When Master Frames are used, the text frames that are added by
AutoFlow Pro are always added as overridden master text frames, and they
are overridden and filled with text only as needed. If the text frames are
threaded on the master page/master thread, each text frame in the thread is
added to the local page as needed. If multiple master pages are being used in the
layout, it is very important to read about Master Threads on page 38.

When Master Frames are used, and the “Add Pages” setting is selected, mas-
ter frames will be overridden as needed and be correctly threaded. Only text

frames which are needed to flow the text will be overridden.
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When “Expand Frames and Add Pages” is selected, Master text frames, when
initially overridden will be sized to fit the text and will then expand up to the
size of the master text frame. When the size of the overridden frame reaches

that of the original master text frame, a new frame will be overridden in turn.

When “Full Text Flow” is selected, The text frames will be overridden as
described above, but the text frames will shrink and be returned to the mas-

ter page as they become empty as well.

nnm Setting up Master Frames with the “Full Text Flow” setting is a

very good way of creating a document which will balance mul-

tiple columns while constraining the text frame size.

Table of Frame Types and Behaviors

right to left docu-

ments is determined

selected in preferences.

If it’s not selected, new

Margin Column Custom Frames  Master Frames
Frames Frames
Special None The direction of col-  New pages will onlybe ~ New pages will only be
Notes umn frame flow for ~ added if the option is added if the option is

selected in preferences.

Ifit’s not selected, text

by the story direction = text frames will be frames will be overrid-
(not the document added to existing pages ~ den on existing pages
direction) which have the same which have the same

master page applied.
If Spine Reflective posi-
tioning is set in prefer-
ences, the position will
be the same distance

from the spine.

master thread.






Examples of Use

Margin
Frames

Column
Frames

Custom Frames

Master Frames

Add
Pages

Fits new frames to

page margins

Fits new frames to

column guides

Creates new frames
to original size and

position.

New frames are over-

ridden as needed. Each
text frame in the thread
on the master page will

be overridden in turn.

Expand
Text
Frames/
Full
Text
Flow

Fits new frames to
page margins, and
shrinks the frame to

fit the text.

Fits new frames to
the next column
guides, and shrinks
the frame to fit the

text.

Fits new frames to the
top and side bounds of
the original text frame,
and shrinks the frame

to fit the text.

Overridden text frames
will fit the top and side
bounds of the master
text frame and will
expand down to a maxi-
mum size of the master

text frame.

Resize
Down

Frame will expand
down to the bottom

page margin.

Frame will expand
down to the bottom

page margins.

Frame will expand
down to the bottom

page margins.

Frame will expand
down to the bottom
position of the master

text frame.

Resize
Up

Frame will expand
up to the top page

margin.

Frame will expand
up to the top page

margin.

Frame will expand up

to the top page margin.

Frame will expand up to
the top position of the

master text frame.

Resize
From
Center

Frame will expand
both up and down
equally. It will stop
expanding when
it reaches either
the top or bottom

margin.

Frame will expand
both up and down
equally. It will stop
expanding when
it reaches either
the top or bottom

margin.

Frame will expand both
up and down equally.
It will stop expanding
when it reaches either
the top or bottom

margin.

Frame will size from the
center of the master
text frame. It will stop
expanding when it
reaches either the top
or bottom of the master

text frame.
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Applying Settings

APID ToolAssistant... i
AutoFlow Pro » Remove All AutoFlow Settings

Add Pages Automatically
Expand Frames and Pages Automatically
Full Text Flow

Resize Down
Resize Up
Resize From Center

Shrink Selected Frame(s)
Fit Selected Frame(s)

Disable AutoFlow Pro

Rebuild Current Story

Reflow Current Story

Reflow Current Story String

Force Recompose AutoFlow Pro Stories

Create Paragraph Style to Master Links...

- -

Define Master
_;:1 ne iasie

Content Frame...

Define AutoFlow Pro Styles...
AutoFlow Pro Preferences...

AutoFlow Pro Remove All AutoFlow Settings
Reflective Objects > Add Pages Automatically
Paste EAY Expand Frames and Pages Automatically
v Full Text Flow
Font
Size > Resize Down
. Resize Up
Find/Change... 38F

Resize From Center

One important difference between AutoFlow Pro and Smart Text Reflow in
InDesign CS4 is: Smart Text Reflow is a document-wide property. You can’t
fine-tune it—it’s either on or off for a whole document. AutoFlow Pro’s prop-
erties work story-by-story—you turn it on for each story you want to reflow
intelligently. AutoFlow Pro does nothing unless you set it to work on your
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story. You cannot set different settings on different frames in one story, but
you can have different settings on different stories. Above are screen-shots

of the AutoFlow Pro menus.

Settings are applied via a contextual menu. Right-click (or control-click)
on a text frame, or in the text, to bring up the contextual menu. Under the
AutoFlow Pro menu the are seven auto-flow options : “No Setting” , “Add
Pages”, “Expand Frames and Pages” and “Full Text Flow” as well as “Resize

» «

Down”, “Resize Up’, and “Resize From Center”. Each of these settings are

described above. The current setting will have a check mark next to it.

Alternatively, you can access the settings via menu items. Select InTools >
AutoFlow Pro > [Preferred Setting]. If you apply the settings on a regular
basis, you can assign a keyboard shortcut (see page 48).

When you apply AutoFlow Pro settings to a story, an icon will appear on the
bottom right corner of each text frame in the story to indicate the AutoFlow
Pro status. The six icons are as follows: Add Pages: B Expand Frames: U

Full Text Flow: t/} Resize Down: § Resize Up:  and Resize From Center: $

You can turn the visibility of the icons on and off by selecting View > In-
Tools > Hide/Show AutoFlow Settings

i The icons are customizable. All you need to do is to change the
png files in the AutoFlow Pro folder to icons more to your lik-
ing. Make sure to create and include an alpha channel in the file
to ensure that the transparency is preserved. If you do create a

custom icon set, we'd love to see them and share!
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Globally Disabling AutoFlow Pro

There are times that you might be doing editing on a document and you
don’t want pages added and removed while working. While it is possible to
remove AutoFlow Pro settings for specific stories, very often that’s not a good
option. For instance, you might want to disable AutoFlow Pro only tempo-

rarily, or for many stories at once.

Whatever the reason, you have the option to temporarily disable AutoFlow
Pro. It is important to note that disabling AutoFlow Pro only disables the
expanding (and shrinking) of text frames and the adding (and removing)
of pages.

nmp- Even with AutoFlow Pro “disabled”, Master Threads (page 38)

will reflow when master pages are changed.

To disable AutoFlow Pro, just select InTools > AutoFlow Pro > Disable
AutoFlow Pro. While AutoFlow Pro is disabled, there will be a check mark
next to the menu item to indicate the status. The disabled status is temporary
and will revert to being enabled when a document is closed and reopened.
When reenabling AutoFlow Pro manually, all AutoFlow stories will be auto-

matically recomposed.

Reflowing Stories
As pictured above, two of the options of AutoFlow Pro are “Reflow Current
Story” and “Reflow Current Story String”. These options do two things:

1. These options enable intelligent flowing of stories which do not have

AutoFlow Pro settings applied, or if AutoFlow Pro is temporarily disabled.

2. These options enable the reflowing of stories to ensure the proper mas-

ter pages and text fitting without deleting pages—even once the text is set.
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The difference between the two commands is: “Reflow Current Story” will
reflow just the currently selected story. “Reflow Current Story String” will
reflow the entire String of stories related to the currently selected story. The
“Reflow Current Story String” command will only be available if the selected
story is already defined as being part of a Story String. This is very useful for
ensuring that an entire document has the correct master pages applied. Story
Strings are set up using the Story Tools plug-in. Please refer to the Story Tools
documentation for details.

Rebuilding Story Threading

There are times when the text frames in a story might not sit in the correct
positions. For instance, text frames might have been removed in the middle
of the text frame threading, or master pages might have been changed with-
out Master Threads being set up. Simply reflowing the story will not help in
these instances. Reflowing the story will not remove existing text frames or
pages unless it is required to do so to flow through new master text frames.

To totally reflow the text again requires much more drastic measures.

To totally reconstruct the threading of the current story, select InTools >
AutoFlow Pro > Rebuild Current Story. This will remove all text frames
except the first one, as well as all pages rendered empty, by removing the text
frames; and will recreate all the text frames and pages based on the current
AutoFlow settings. This option is only available if one of the settings which
creates text frames is selected (i.e.: “Add Pages”, “Expand Frames and Pages”,
or “Full Text Flow”). Please be aware that the effects of this command
are quite drastic and use it with care! If it is used unintentionally, it can

be undone.




http://www.in-tools.com/plugin.php?p=20

http://www.in-tools.com/downloads/StoryTools.pdf

http://www.in-tools.com/downloads/StoryTools.pdf
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AutoFlow Pro Preferences

To access the preferences dialog, select: InTools > AutoFlow Pro -

AutoFlow Pro Preferences...
‘ . ‘ .

Default New Frame Settings: E
— ™

Ceneral Flow Settings:

Flow Type: | Page Flow I-ﬁ-l
Facing Pages: [Spine—Relati\re Positions I-G-l

Additional Flow Options:

["1 Add Pages for Custom-Positioned Frames
Ehdd Pages for Master Frames

E Flow Locked Frames

E Force Overrides on Master Frames
EPreser\re Resizing on Master Frames

E Reflow Master Frames When Side Changes

The Preference dialog offers the ability to configure preferences for many of

AutoFlow Pro’s functions.

1. e — This option defines the default for

—_— @) new text frames. If a new text frame is

created and the story does not already
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have an AutoFlow Pro setting applied and the object style is not linked to an
AutoFlow Pro setting, the selected Default Setting will be used.

Please note: These settings will only apply to new text frames. Existing frames
will not be affected.

2.  Flow Type: [ Page Flow i) AutoFlow Pro can be assigned to flow

text on both pages of a spread, or only on the recto (right-hand) or verso
(left-hand) pages. This takes place by assigning “Flow Type” as either “Page
Flow” or “Spread Flow”.

If “Page Flow” is selected, text will flow to the next page regardless of whether

it’s a recto or verso page. “Page Flow” adds pages one at a time.

If “Spread Flow” is selected, pages are always added in pairs. This keeps sub-

sequent pages from switching from recto to verso and vice versa.

When “Spread Flow” is selected, non-master text frames will always flow
from recto page to recto page and verso to verso. This is useful in situations
where the content on one side is different from the content on the other
side, as is often the case with texts that have translations or commentaries. If
the master pages applied to the recto and verso pages are different, the cor-

rect master pages on each side will be preserved as pages are added.

Please note: If master text frames are used, AutoFlow Pro will intelligently
determine whether the text should be flowed across the entire spread, or
just on individual pages. This is not effected by the “Page Flow” or “Spread
Flow” settings.

3. Facing Pages: | Spine-Relative Positions  [$] This option only affects Custom
Frames. All other frame types are positioned based on margins, columns, or

master page positions. This option has two settings: “Spine-Relative
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Positions” and “Static Positions”. “Spine-Relative Positions” will position
the Custom Frames relative to the spine on documents with facing pages.
“Static Positions” will always position new Custom Frames at exactly the

same coordinates as the original.

4.  []Add Pages for Custom-Positioned Frames 'This option determines whether
pages are added when custom frames become overset. If the custom frames
are set to add pages, new frames will be added on pages which already exist
regardless of whether this option is set or not. If this option is not selected,

new pages will not be created if none already exist.

S.  MIAdd Pages for Master Frames  This is similar to the last option, but it applies

to master text frames.

6. MFlowLocked Frames If this option is selected, AutoFlow Pro will flow and
resize frames regardless of their locked state. This is very useful if you want
to prevent accidental manual movement of the text frames, but would like

them to automatically resize and the text to reflow.

7.  MForce Overrides on Master Frames  If this option is checked and the master text
frames were set to not allow overrides, those settings will be ignored. If it is

not checked, the settings for not allowing overrides will be honored.

8. ™ Preserve Resizing on Master Frames 'This option determines the behavior
when relinking master text frames which have been defined as part of a Mas-
ter Thread (see page 38). When master pages change (as when a new master
has been manually applied, or the page side changes) the text reflows into
new master text frames. When this happens, all local overrides on the text
frame are lost. Very often, text frames are resized to accommodate the text

they hold. For example, frames might be made a line longer or shorter to
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better balance text. If you do not want to lose the manual sizing adjustments

to the master text frames, you should check this option.

9. [ Reflow Master Frames When Side Changes 'Lhis option enables text to reflow
into new master text frames when the page side changes. InDesign still keeps
the master text frames connected to the local ones even when the text frame
is located on the opposite side of the spread. This can cause text frames to
become doubled up. If this option is checked, AutoFlow Pro will remove the
original text frame and flow the text into new master text frames as

necessary.
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AutoFlow Pro and Object Styles

To access AutoFlow Pro’s object styles, select: InTools > AutoFlow Pro >
Define AutoFlow Pro Styles...

— Object Styles — AutoFlow Pro Settings
¥ [None] Default Settings
[Basic Graphics Frame] No Flow

¥ [Basic Text Frame] Add Pages

Main Text Frame
Two Column Frame
One Column Frame
[Basic Grid]
P Anchored Screen Shots

Expand Frames
Full Text Flow
Resize Down
Resize Up

Resize from Center

Anchored Screen Shots

— Defined AutoFlow Pro Styles:

Main Text Frame set to: Full Text Flow
Two Column Frame set to: Full Text Flow
One Column Frame set to: Full Text Flow

- — — — — — — PRI

— Style Structure View:

® o gApplv Changes to Existing Text Frames
"Based On" Style Groups

( OK 3 (Cancel)

AutoFlow Pro offers an advanced dialog for associating object styles with
AutoFlow settings. The dialog presents the object styles of the current docu-
ment in a tree format. There are two distinct tree structure views available.
There is the “Based On” view and the “Style Groups” view. You can switch
between the two views at any time by clicking on the appropriate radio
button.





— Object Styles

[None]

[Basic Graphics Framel

[Basic Text Frame]

[Basic Grid]

¥ Anchored Styles

Text Frame Styles
Main Text Frame
Two Column Frame
One Column Frame

1> P ) < | >

— Style Structure View:
() "Based On" @) Style Groups

— Object Styles

¥ [None
[Basic Graphics Frame]
¥ [Basic Text Frame]
Main Text Frame
Two Column Frame
One Column Frame
[Basic Grid]
»  Anchored Screen Shots
Anchored Screen Shots

T —————— y<

[»

— Style Structure View:
) "Based On" () Style Groups

AutoFlow Pro and Object Styles

Style Groups View

The “Style Groups” view presents the
styles in an expandable tree, with a
folder structure similar to the folder
structure of InDesign’s Object Style
panel. If you organize your object
styles in style groups, you can use
this view to select either individual

styles or entire style groups.

When a style group is selected,
all the styles (and sub-group
styles) in the selected style
group will be associated with the

AutoFlow setting you choose.

Based On View

The “Based On” view presents a tree
structure of all the styles, in which
each style can be seen in its relation
to the style upon which it is based.
The root of the style tree will always
be the [None] style as all styles

are ultimately based on [None].

When the styles are viewed in the
“Based-On” structure, all styles
which are based on the selected
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style will be associated with the
AutoFlow setting you choose.

Associating AutoFlow Pro Settings

— AutoFlow Pro Settings

Default Settings Defined AutoFlow Pro Styles:

Mo Flow Main Text Frame set to: Full Text Flow
Add Pages One Column Frame set to: Pl Text Flow
Expand Frames

Full Text Flow

Resize Down

Resize Up

Resize from Center

Once the object style or style group is selected in the tree view, all that is
needed to associate an AutoFlow Pro setting with an object style is to select
the desired setting from the item list. This will apply the selected setting to
all sub-styles of the selected tree item as well. The settings are immediately
reflected in the list of defined AutoFlow Pro styles below the list of settings.

Please note: Besides the six available AutoFlow Pro settings, there are another
two selectable options in the settings list: “Default Settings”, and “No Flow”.
There is a distinct difference between the two. “Default Settings” means
that the AutoFlow Pro settings will default to the setting which is set in the
AutoFlow Pro preferences dialog. If, for instance, the defaults in the prefer-
ences dialog (see page 28) are set to “Full Text Flow”, new text frames cre-
ated with a style set to “Default Settings” will have “Full Text Flow” applied
to it. The “No Flow” setting however, will ensure that your text frame with
the selected style will not have any AutoFlow Pro settings applied regardless
of the defaults settings.





Linking Paragraph Styles to Master Pages

EApply Changes to Existing Text Frames When YOll ﬁnish deﬁl‘lll’lg the Settll’lgs fOI‘ the ObjeCt
@ Cancel

styles, click OK to apply the changes. If you want
your changes to be applied to all existing text frames make sure that “Apply
Changes to Existing Text Frames” is checked.

nnm AutoFlow Pro settings are applied to stories—not text frames.
Setting a text frame to auto-flow will affect the whole story—
even frames with a different style. The last style applied to any
text frame in a story will define the AutoFlow Pro settings for the
entire story. Please take care in which order you apply styles
which have AutoFlow Pro settings!

Default settings and styles are saved within the document, and will be pre-
served when transferring the document to a different computer. If the file is
exported to the InDesign Exchange format (inx) or the InDesign Markup
Language (idml), all defaults including the defaults for styles will be lost,
but existing settings on frames will be preserved.

Linking Paragraph Styles to Master Pages

AutoFlow Pro has the ability to associate specific paragraph styles with spe-
cific master pages. This “style linking” gives the ability to have master pages
automatically applied while flowing text. When a linked paragraph style is
encountered at the start of a page, the master page linked to that style will be
automatically applied to the page.

nnm Please note: Style linking only works when AutoFlow Pro does
the flowing of the text. If you use InDesign’s built in auto-flow or
add text frames manually, the master pages will not be applied.

Additionally, it only works when text is initially flowed and the
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text frames are created. It will not work on text which reflows
through existing text frames unless the Reflow Current Story or
Reflow Current Story String commands are selected. For details

on how AutoFlow Pro reflows text please see page 26.

Creating Master Page Links

— Style Structure View: — Default Master Page
{® "Based On" () Style Groups [ TXT-Text pages H
— Paragraph Styles — Master Pages
¥ [No Paragraph Style] | Mo Link
N [Basic Paragraph] .v TXT-Text pages
gsl‘ilvnhs | Art-Article opener
Folin LET-Letter opener
HeadwordBioaraphy
HeadwordTitle
»  HeadwordTranslation
Letter
ProverbFirst
¥ ProverbSecond
ProverbThird

ReadingHead
¥ RunheadVerso
TableColumn

— Defined Master Links:

P TableNote
P TableText % “HeadwordTitle" linked to: Art-Article
TableTitle [ opener
[ )
<> s BER

o) ()

Creating Master Page Links is very simple. First create your paragraph styles
and master pages. Then select InTools > AutoFlow Pro > Create Paragraph
Style to Master Page Links... and the above dialog will appear. Select the
desired paragraph style from the style tree on the left, and the correspond-
ing master page the right.






Linking Paragraph Styles to Master Pages

As with the AutoFlow Pro style dialog, the style tree is viewable in two differ-
ent structure views: “Based On” and “Style Group”. In either view, all the sub-
styles of the paragraph style selection will be linked to the selected master
page. In the “Based On” view, all styles which are based on the selected style
will be included. In the “Style Group” view, any sub-styles of the selected
style group will be included.

Default Master Page

[ TXT-Text pages H

’fDefault Master Page

It is not necessary to create links for every paragraph style used. If almost
all your styles should start a specific master page, there is an easier way. You
have the option of selecting a default master page. If a default master page is
selected, all new pages will have the selected master page applied regardless
of which style is applied to the text. In this way, you can avoid defining links

for many paragraph styles unnecessarily.

In the dialog shown on the previous page, there are two master pages with
style links set up: the Article Opener master page, and the Text pages mas-
ter page. The Article Opener master page is linked to the HeadwordTitle
paragraph style. The Text pages master page is set as the default. With this
configuration, the Article Opener master page will be applied when the
HeadwordTitle paragraph style starts a new page. When any other paragraph
style starts a page, the Text pages master page will be applied.

Using Master Page Links
Once set up, Master Links work automatically. Any time AutoFlow Pro flows

or reflows text, the master page will be changed to match the correct master
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based on the style links or the default master. This is true for the Reflow Cur-
rent Story and Reflow Current Story String Commands as well.

If Master Text Frames are used, it is critical that Master Threads are set up. If
Master Threads are not set up, AutoFlow Pro will not change the master page

because it will not be able to flow the text into new text frames.

Master Threads

Conceptual Introduction
Master Threads are a novel concept, so it might take a bit of time to “get it”,
but the potential of using Master Threads is enormous, so it’s well worth the

time spent learning what Master Threads are, and how they can be used.

Simply put, Master Threads are Master Text Frames which are assigned to a

specific thread of text frames.

Normally, Master Text Frames can be threaded, but only with other text
frames on the same master spread. It is not possible to thread master text
frames from Master A to Master B. Therefore if flowing text, and the mas-
ter page applied changes from page to page, there is no way of dictating
which text frames, the text will occupy. Additionally, when a master page is
changed and a new one is applied, any Master Text Frames will be detached
from the master page. Master Text Frames in InDesign can be described as
static objects, that once overridden from the master page have very little to
do with the original object they started out being.

Master Threads were created to overcome these shortcomings. When Mas-
ter Text Frames are designated as being Master Thread Frames, they have

the ability of being virtually threaded across master pages, so a text frame
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(or thread of frames)on Master A can be associated with a text frame (or
thread of frames) on Master B. Additionally, Master Thread Frames can be
described as dynamic as opposed to the standard static Master Text Frames.

These two properties of Master Threads open up exciting new possibilities.

Let’s explain some more. Master Threads are created by naming a master text
frame or thread of master text frames. The name can be anything, but once
you name the text frames, they are defined as belonging to a Master Thread
of the name you chose. It is only possible to use a specific name once per
master spread. Text frames which have the same Master Thread name on
different spreads will be defined as belonging to the same Master Thread. In
this way, it is possible to create virtual threading between different master
pages. You can create an infinite number of Master Threads in each docu-
ment, which enables parallel flowing of stories (i.e. you can have two sepa-

rate stories which flow side by side, or top and bottom, etc.).

But What do They do?

Once Master Threads are properly set up, they can be used to intelligently
flow text. When used in conjunction with Master Page Links (page 35), Mas-
ter Threads can change the positioning and flow of text as the applied master
page automatically changes. When the text is flowed and master pages are
switched to match the linked paragraph styles, the text will flow into the text
frames on the new master page which correspond to the text frames on the
previous master page. This correlation is created by naming both sets of text

frames with the same Master Thread name.

This combination of master page linking and Master Threads enables the
complete automatic flowing of entire books, even when master pages must

change to reflect the text, and even when chapter openers must be placed in
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different locations than body text. This is true even if chapter openers are set

up as single column text, while the body text is set up as two columns.

In addition to the automatic layout made possible while initially flowing
text, Master Threads can transform master pages from a simple starting point
for layout, into true dynamic page templates. When text frames are defined
as Master Threads, the text contained by them will automatically reflow into
new text frames any time the master page changes or the page side changes.
This means, you can drastically change the layout of your text by simply
applying a different master page. With one click of the mouse, or by dragging
a master page onto a local page in your pages panel, you can rearrange your
layout! No more manually reflowing text when you see a need to change the

master page—even if your text does not fit the page margins!

Defining Master Threads
Defining master text frames as a Master Thread could not be easier. Just
select a text frame on a master page and select InTools > AutoFlow Pro >

Define Master Thread..., which will bring up the following dialog:

Label the Master Thread EMailnextﬂow .........................................

Main text flow -+

Cancel

Type in the Master Thread name or select a previously named one from the

drop-down menu. Repeat this procedure on all master pages on which text

of the same thread will be located. Once a master text frame is labeled with
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a Master Thread label, the label name will appear attached to the top left of
every text frame in the thread. This is true both for the text frames on the

master page as well as the overridden text frames on local pages.

Please note: There is a bug on some installations of Windows where it is not
possible to type a label name into the dialog. We have not yet been able to
identify what exact system configurations cause this problem. If you see this
problem, please download this script and run the script once. This should
solve the problem by reversing the structure of the combo-box in the dialog

when it is re-opened. The effects of the script should hold indefinitely.

Take care to run the script only once. Each subsequent run of the script will
cause the structure of the combo-box to be reversed. This reversal will either
fix, or break the functionality of the combo-box, depending on its previous

state.

The Master Thread labels can be hidden. To toggle the visibility of the labels,
select View > In-Tools > Hide Master Thread Labels

Hide Notes L | | |

In-Tools » Hide AutoFlow Settings

Hide Master Thread Labels

Hide Master Content Frame Labels

Using Master Threads

Once Master Threads are set up, you can lay out your book as usual. You don’t
need to do anything differently to ensure that your Master Threads flow cor-
rectly. If the story which uses your Master Thread Frames is set to AutoFlow
(see page 24 and page 32), the Master Thread Frames will be overridden (i.e.
transferred to the local page) automatically as needed. Manually overrid-

den text frames will keep their Master Thread status as well. The status of




http://in-tools.com/downloads/FixComboBox.zip
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the Master Thread Frames become apparent when page sides change, or the
applied master page changes. In either of these scenarios, the text which
flows through the Master Thread Frames will automatically reflow into new

Master Thread Frames taken from the current master page.

When using Master Threads, there are two preference settings (see page 28)

which are important to note:

@Presewe Resizing on Master Frames
@ Reflow Master Frames When Side Changes

1. “Preserve Resizing on Master Frames” is an option which will keep the
dimensions of the text frame when reflowing the text into the new master
frames. This is important because the old frames are actually discarded when
the text content is reflowed. Very often text frames are resized to accommo-
date the text and you don’t want to lose those dimensions. It is important
to note that the sizing is only preserved if the two frames are considered
to be congruous. This is determined by examining the size and location of
the two original master frames. If the original Master Frame and the new
one into which the text is flowing are within one point of each other, they
are considered congruous, and the size will be transferred. Master Frames
are measured relative to the spine of the document, to preserve the layout

design of facing pages.
2. “Reflow Master Frames When Side Changes”: When the side of a

page changes in CS3 and later, an overridden master frame is not actually
detached from the master page. It is attached to a master item which doesn’t
really exist. When master pages are applied to a document page, the entire
master spread is applied to each page individually. You canlook at it as if every

page has all the items of an entire master spread on it, but only the items
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which corresponds to the current page side are actually visible. When the
page side changes, even overridden master items (even though they are now
within the visible bounds of the page) are still attached to the invisible mas-
ter page items which are outside the bounds of the page. This can result in
doubling of master items. If, for example, a recto page with overridden recto
master items becomes a verso page, the overridden recto items will be vis-

ible as well as the non-overridden verso ones.

AutoFlow Pro will eliminate these doubled frames by removing the overrid-
den one which is on the wrong page side, and overriding the corresponding
one on the current page side. If (for whatever reason) you want to preserve

these doubled up frames, you have the option of canceling this reflow.

nmm If you have a document which has text which should only
appear on either a recto or verso page, but there’s a chance for
page sides to change, it is advisable to create a master thread
which spans both pages. On the side which should not contain
the text, you should create the text frame too small to actually
hold any text. This will cause the text to “appear” and “disap-
pear” automatically as page sides change. You can place the
“blank” text frames in the page margins or on a hidden layer so

they will be out of the way.

Master Content Frames

AutoFlow Pro completes the concept of using master pages as dynamic tem-
plates by offering Master Content Frames. Just as Master Threads transform

the way text frames are automatically overridden and threaded as work pro-
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gresses, so too, Master Content Frames transform the way graphics frames

hold content.

Master Content Frames set the size and position of graphic objects prior
to their placement on the page. As in Master Thread Frames, when master
pages are changed, the content of Master Content Frames will be transferred
to the new corresponding Master Content Frames. If the size or location of
the graphic frames changes, the new size and location will be used. The new

frame fitting options will be honored as well.

The combination of Master Threads and Master Content Frames allows highly
structured layout to be set up in advance with multiple alternatives. Existing
layouts can be completely altered, with the text reflowing and the graph-
ics rearranging themselves to fit the new layout—totally automatically, by
simply applying a new master page. The application of Master Threads and
Master Content Frames to create dynamic master page templates will dramati-

cally increase your productivity!

Defining Master Content Frames

The process of defining Master Content Frames is very similar to the process
of defining Master Threads. Simply select a Frame or any object which can
contain graphics on a master page and select InTools > AutoFlow Pro >
Define Master Content Frame.... The labels are applied in the same way that
Master Thread labels are applied (see page 40), and the label will appear on
the top of the graphic frame as with master threads. The visibility is toggled
by selecting View > In-Tools > Hide/Show Master Content Frame Labels.
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Using Master Content Frames

For Master Content Frames to be effectively used, each master page which
could possibly be used should have corresponding Master Content Frames.
The Master Content Frames on each master can have unique placement and
fitting options. Fitting options can be predefined using InDesign’s Frame Fit-
ting Options. If the fitting options do not match, the content will be refitted
to the new fitting options. If no fitting options are set, the content will be
positioned and scaled proportionally to the existing positioning and scal-
ing. AutoFlow Pro uses a sophisticated algorithm to determine how the con-
tent should be positioned within the frame. If no Frame Fitting Options are
defined, AutoFlow Pro will determine whether the content is fit to the frame,

centered, or placed at a custom position and magnification.

Content of Master Content Frames can be any object type which can exist in
frames. This includes native InDesign objects such as rectangles, polygons,

text frames, lines, groups, etc. It can include linked graphics as well.

If the master page is switched to a master page which does not contain a
corresponding Master Content Frame, the frame will be disconnected from

the master and remain in it’s current position.

nmm If you are designing a layout which has a variable number of
graphics, you can have the graphics “appear” and “disappear”
when master pages are changed. To accomplish this, create
a hidden layer and place the Master Content Frames on this
hidden layer, for any page where you do not want a particular
graphic content to show. The graphic content will then “pop in

and out” automatically when master pages change.
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Other Commands
Shrink Selected Frame(s)
Fit Selected Frame(s)

Disable AutoFlow Pro
Rebuild Current Story
Reflow Current Story

Force Recompose AutoFlow Pro Stories

Shrink Selected Frame(s)

“Shrink Selected Frame(s)” will simply fit the selected frame or frames to
the smallest size which will not cause the text to be overset. This is similar
to the Fit Frame to Content command, but it works with threaded frames—
even frames in the middle of a story. “Shrink Selected Frame(s)” is useful
for balancing multi-column text frames. The command is honors AutoFlow
settings. If the story is set to Resize Up or Resize from Center, those settings
will be honored when resizing the frame. Otherwise the text frame will be

resized at the bottom.

Fit Selected Frame(s)

This option is very similar to the Shrink Selected Frame(s). The only differ-
ence between the two commands, is that Fit Selected Frame(s) will either
shrink or expand the text frame as necessary to fit the maximum amount of

text without going beyond the page margins.

Disable AutoFlow Pro
This command gives the option to temporarily disable flowing on stories set

to AutoFlow. For detailed information please see page 26.
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Rebuild Current Story

This command is a very drastic way of getting AutoFlow Pro to recompose
a story. It will remove all text frames except the first one, and if possible,
will remove pages as well. After the text frames are removed, it will re-create
them using the settings applied to the story. This command only works if a

story is set to add text frames.

We recommend only using this command if it’s truly necessary. It can some-
times cause major changes to your document. Please refer to page 27 for
further details.

Reflow Current Story / Reflow Current Story String.

This command forces the currently selected story to be reflowed. The text
frames will be fit as they would be when flowed for the first time, and any
Master page links will be used to correct the applied master pages. For full

information, please see page 26.

Force Recompose AutoFlow Stories

This command is used to force AutoFlow Pro to “wake up”. Under normal
circumstances this command should not be needed. However sometimes
stories might not be properly fitted because AutoFlow Pro was disabled, or
the document was edited on a computer without AutoFlow Pro installed.
Selecting this command when the file comes back to a computer with
AutoFlow Pro installed will get things back in order. The “Recompose All
Stories” command which is standard to InDesign should also work, but this

command is more direct.
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Shortcuts
All AutoFlow Pro commands can be applied using keyboard shortcuts or
with Quick Apply.

5] Quick Apply
& = full

F;] Active Page Item>Full Text Flow

P;I Active Page Item> Configure Column Flow

(= RIE

F;] Active Page Item=AutoFlow Pro Preferences...

F;I Active Page Item>Configure Reflective Defaults...

P;I Active Page Item>Configure Story Tools...

F;] Active Page ltem>Define AutoFlow Pro Styles...

P;I Active Page [tem>Disable AutoFlow Pro

E Active Page Item>Expand Frames and Pages Automatically

P;I Active Page Item=>Force Recompose AutoFlow Stories

gl e

To use quick apply, simply invoke the Quick Apply shortcut (Command/
Control Return) and start typing the name of the command. For example:
to set the current story to “Full Text Flow”, invoke Quick Apply and start
typing “Full..”. When Full Text Flow is highlighted, simply hit return to
apply it.

To create a keyboard shortcut for application of AutoFlow Pro commands,
open the Keyboard Shortcuts dialog (Edit > Keyboard Shortcuts...). Once
the dialog is opened, make sure “Active Page Item” is selected in the Product

Area drop-down. If you use a custom keyboard shortcut set, make sure your
set is selected.
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Set:

[ Harbs I-H ( New Set... ) ( Delete Set )
Product Area: ( Save j ( Show Set... )
[ Active Page Item l-ﬂ

Now we're going to create a keyboard shortcut for the Fit Selected Frame(s)
command which will make it very easy to shrink and expand specific text

frames at need.

P L* I DU - | PR - T | | [ -
Expand Selected Space Before

Fit Selected Frame(s)

Flow Stories In String Order

Footnote Numbering Formats...

In the “Commands” list, we selected the Fit Selected Frame(s) command.

Current Shortcuts:
Default: Ctrl+Cmd+F

Type Shortcut Here
Remove
New Shortcut: Context:
Ctrl+Cmd+H | [ Default Fi-l ( Assign )

Currently Assigned to:
Fit Selected Frame(s)

( Cancel )E oK 3

We then type Control+ Command+F (which is otherwise unused) into the
New Shortcut field and click “Assign”. Now we can use the shortcut to resize

the currently selected text frame or range of text frames.
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Compatibility and Known Issues

AutoFlow Pro fully supports InDesign CS3 and InDesign CS4. AutoFlow Pro
will work under InDesign CS2, but it is not recommended. AutoFlow Pro
has been highly optimized for performance in CS3 and CS4. These optimi-
zations do not work well with CS2 and the performance under CS2 will be

drastically degraded. InDesign CS is not supported at all.

We recommend a minimum of 2 GB of RAM when AutoFlow Pro will be
used extensively, although it will work with InDesign’s minimum system

requirements.

Rotated text frames will not expand correctly and new ones will not be cre-

ated correctly when flowed to a new page.

Text frames on rotated spread views (in CS4) will expand correctly if the
text frame is vertical when viewed. New frames created if text is flowed to

the next page will not be created correctly.

Whether or not we will give high priority to working around these limita-
tions will depend upon the feedback we receive. So, if flowing rotated text

frames or rotated spread views are important in your workflow, please let us

know!

AutoFlow Pro Dependencies

AutoFlow Pro does not create plugin dependencies. This means there should
be no issues sharing documents created while using AutoFlow Pro with other
users who do not have AutoFlow Pro installed. All AutoFlow Pro settings will

be preserved within the document as well.
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The only issue to watch out for, is when documents come back to an instal-
lation with AutoFlow Pro installed. If there are overset text frames, or text
frames which require reflow, there might be some layout changes when text

is recomposed (edited or reformatted).
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Scripting

Most of AutoFlow Pro’s commands can be accessed via scripting. Scripting
access to AutoFlow Pro is provided by sending custom events to the plugin.
To do this you must first get a reference to the AutoFlow Pro plugin. This
is done using the loadedScriptedPlugins document method. The loaded-
ScriptedPlugins method returns an Array. Therefore, to create a variable

which references AutoFlow Pro you'd write:

ExtendScript Code:
var autoFlowPro = myDoc.loadedScriptedPlugins("autoflowpro")[0]

AppleScript Code:
tell myDoc

set autoFlowPro to item 1 of (loaded scripted plugins label "autoflowpro™)
end tell

Visual Basic Code:
Set autoFlowPro = myDoc.LoadedScriptedPlugins("autoflowpro")[1]

Once you have a valid reference to AutoFlow Pro, you simply tell AutoFlow

Pro to handle a custom event:

ExtendScript Code:
autoFlowPro.handleScriptEvent (eventCode:String,[eventData:String],[delay:
integer]);

AppleScript Code:
tell autoFlowPro

handle script event event code (String) [event data (String)] [delay (Integer)]
end tell

Visual Basic Code:
autoFlowPro.HandleScriptEvent (eventCode:String,[eventData:String],[delay:
integer])
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In the above code, the event code is the custom event which you tell
AutoFlow Pro to handle. The event data is the data sent to the event handler,
although not all events require event data. The delay in milliseconds is when
the event is sent. This argument is totally optional. If left out, the event will
be sent immediately. If it’s 0, it will be sent when InDesign becomes idle.

Otherwise it will be sent after the specified delay.

Event Codes
Below is a list of acceptable event codes along with the description of what

they do and the required event data (if any):

Please Note: The event codes and event data are case sensitive.

Event Code Description Event Data

externalSetAutoFlow | Applies AutoFlow Pro String of two comma
settings to the specified | separated items. The first
story or array of stories | item is the story id, while the
second item is the desired
setting. Acceptable settings
are: “None”, “Add” “Expand”,
“Full” “Down”, “Up”, and “Out”.
To set multiple stories, the
event data for each story
should be separated by a
colon.

Examples in ExtendScript:
To set story with id 291 to Full Text Flow:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full");

To set story with id 291 to Full Text Flow, and story 264 to Add Pages:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full:264,Add");
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Event Code

Description

Event Data

externalTriggerFlow

Forces AutoFlow Pro to
compose a story with
AutFlow Pro settings
applied. This command
is useful if you need the
text to be flowed before
proceeding in your script

It accepts a single story id as
a String

Example:

autoFlowPro.handleScriptEvent ("externalTrigger

Flow","291");

externalShrinkFrame

Vertically shrinks the
text frame to the
smallest size possible
without causing the text
frame to become overset

Accepts the id of the text
frame as a String. It can
accept ids of more than one
frame separated by a comma.

Example: (given a text frame with an id of 487)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487");

To shrink multiple text frames: (with ids 487 and 562)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487,562");

externalFitFrame

Fits the text frame to
the text. It will either
shrink the frame or
expand it down to the
bottom page margiin as
necessary.

Accepts the id of the text
frame as a String. It can
accept ids of more than

one frame separated by a
comma. Syntax is the same as
externalShrinkFrame

externalFlowStory

Will AutoFlow a story or
list of stories. If there

is an AutoFlow seeting
set, it will flow the text
based on the current
setting. Otherwise it will
add/fit the text frames
as needed

Accepts the id of the stroy as
a String. It can accept ids of
more than one story separated
by a comma. Syntax is the
same as externalShrinkFrame
with the exception that the id
must be a story id—not a text
frame id
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Event Code Description Event Data
externalDisable Temporarily disables None
Autoflowing for the
whole document
externalEnable Re-enables the None
autoflowing after it has
been disabled
externalRecompose | Forces all AutoFlow Pro None

stories to recompose

externalLabelMasterThread

Sets a label for a Master
Thread

Comma separated string of
two items: the story id and
the Master Thread Label

Example: (given a story on a master page with an id of 291)
autoFlowPro.handleScriptEvent ("externalLabelMasterThread","291,Main Text");

externalLabelMasterContent

Sets a label for a Master
Content Frame

Comma separated string of
two items: the page item id
and the Master Content Label

Example: (given a graphic frame on a master page with an id of 723)
autoFlowPro.handleScriptEvent ("externalLabelMasterContent","723,Picture 1");
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Sample Script
Below is a sample script which will set the current story to Full Text Flow:

var doc = app.documents[0];
var story = app.selection[0].parentStory;
var id_as_string = String(story.id);
var autoFlowPro = doc.loadedScriptedPlugins ("autoflowpro™)[0];
if(autoFlowPro){// if AutoFlow Pro is not loaded, the item will be undefined
autoFlowPro.handleScriptEvent ("externalSetAutoFlow",id_as_string+",Full");
} else {
alert("AutoFlow Pro not loaded!");

b

Here’s the same script in AppleScript:

tell application "Adobe InDesign CS4"
set myStory to parent story of item 1 of selection
set theDocument to active document
tell theDocument
set myStoryID to id of myStory as string
set myEventString to myStoryID & ",Full"
set autoFlowProPluginList to loaded scripted plugins label "autoflowpro"
if length of items of autoFlowProPluginList is greater than 0 then
set autoFlowProPlugin to item 1 of autoFlowProPluginList
tell autoFlowProPlugin
handle script event code "externalSetAutoFlow" data (myEventString as
string)
end tell
end if
end tell
end tell
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Script Labels

APID, (and in turn AutoFlow Pro) makes extensive use of script labels for
tracking objects. If there is a script label applied to story, it will have the
AutoFlow Pro label added to the existing string when you use AutoFlow Pro
commands. If you must use script labels on stories, ideally you should use
private labels (used with the insert label and extract label methods). If you
must use the public labels you should append the existing labels instead of
simply replacing the existing ones. Otherwise you stand the risk of tram-

pling AutoFlow Pro settings specific to stories and/or frames.

In other words, always use:

myStoryOrPageltem.insertLabel("myCustomLabel")

or if absolutely necessary:

myStoryOrPageltem.label = myStoryOrPageltem.label+"myCustomLabel"

instead of:

myStoryOrPageltem.label = "myCustomLabel"

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,

it requires “event processing”. This means that certain events trigger specific
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processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using C++. Devel-
oping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine-grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to create
the collection of plug-ins we offer in the same amount of development time.
This increased programming efficiency means more functionality for the

end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.



http://www.rorohiko.com/wordpress/indesign-downloads/active-page-item-developer/
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use
of the In-Tools software and documentation which are provided to you by In-Tools
(collectively, the Software). By copying, installing, or otherwise using the Software,
you accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including
without limitation, ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials
All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-

lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement



http://in-tools.com/privacy.html
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shall grant you the license to use such Marks. All intellectual property rights in the
Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION OF
YOUR COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBIL-
ITY AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PART-
NERS, OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY
RESPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY
OR INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE, INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR
ANY LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS
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OPPORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN
ANY MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO
THIS AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS OR TO
THE USE OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES
EQUALLY TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO
A BINDING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE
THE SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT
BE LIABLE TO YOU OR ANY OTHER THIRD PARTY FOR ANY OF THE DAM-
AGES SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or to
anational or resident of Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any other
country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury
Department’s list of Specially Designated Nationals or the U.S. Commerce Depart-
ment’s Table of Denial Order. By downloading or using the Software, you are agreeing
to the foregoing and you are representing and warranting that you are not located in,

under the control of, or a national or resident of any such country or on any such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of Delaware. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. In-Tools may immediately terminate
the Agreement if you breach any representation, warranty, agreement or obligation
contained or referred to in the Agreement. Upon termination, you must dispose of the
Software and all copies or versions of the Software by destroying the Software. In-Tools
reserves the right to modify the Software at any time without providing notice to you.
In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE AND WEB SITE,
YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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“What does Column Flow do?” / Spanning Headers/Footers

“What does Column Flow do?”

Spanning Headers/Footers

Creating headers or footers which span multiple columns is a very difficult
task in InDesign. This is because all column settings are set by the text frame.
Creating different column settings requires creating a new text frame each
time that the number of columns change. The text frames must then be man-

ually positioned.

Column Flow attempts to simplify this process by allowing the setting the
number of columns within paragraph styles. Each style applied in the story

must have the number of columns defined.

Once properly set up, Column Flow will flow the text and add / remove text
frames as necessary to properly flow the text. It can flow text one page at a
time. It can flow an entire story. It can even flow an entire document com-

prised of many stories.

Precise Control of Positioning

To further insure proper positioning of the text frames, text blocks can be
automatically aligned to the baseline grid, and specific paragraph styles can
be defined as headers. (So they will always appear above the following text
block.) Additionally, Column Flow offers many advanced keeps options
which gives a tremendous amount of flexibility in controlling how your text

flows.

Boxed Sections/Styled Sections
Column Flow (in CS3 and later) allows object styles to be attached to spe-
cific paragraph styles. Any time the associated object style changes, Column
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Flow will break the text frame, and continue the text flow with a new text
frame below. This is very useful for creating sections with a box around it, or
a background color. It can even be used for automatically creating headings

with transparency effects!

Column Flow and CS5 Span Columns

InDesign CSS introduced a new feature called Span Columns. Span Col-
umns essentially does what Column Flow was created to accomplish. There
are however some differences that might make Column Flow a better choice
than Span (or Split) Columns:

1. The most obvious difference between Span Columns and Column Flow
is that Span Columns works dynamically, while Column Flow must be in-
voked to create separate text frames for each text section. While the dynamic
nature of Split Columns is usually desirable, there are cases where it is more
limiting. One example might be a case where you need to add or subtract

space between text sections.

2. Span and Split Columns gives very little control over keeps options, and
very often keeps are completely ignored to prevent columns from remaining
with no text. Column Flow gives very precise control over keeps with three
different levels of strictness to give you your preferred balance between

type-fitting and adherence to keeps rules.

3. Additionally, Column Flow gives an option to keep specific numbers of
columns together as a unit, so it will not break across pages, while Span Col-

umns does not offer this level of control.





“What does Column Flow do?” / Column Flow and CS5 Span Columns

4. Column Flow gives precise control over whether text sections are
snapped to the baseline grid. This ensures proper alignment of heading text

which is normally not baseline aligned.

S.  Column Flow performs more column balancing than Span Columns. It
can even make pages one line long or short if necessary to balance the col-

umns.

6. Column Flow can create spanning headings even across different stories

when Story Tools is used to set up Story Strings.

7. When Column Flow is used in conjunction with AutoFlow Pro, master

pages can be automatically applied.

8. Column Flow allows for boxed sections to be created with a border or

background.

9. Because Column Flow creates a separate text frame for each section,

transparency effects can be automatically applied to headings specifically.
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Examples of Use

Below are some samples of documents laid out using Column Flow.

members of the same species in general, and genetic changes
result from one or a combination of the four forces of evo-
lution: mutation, natural selection, genetic drift, and gene

Before

HARDY-WEINBERG LAW:
TESTING THE CONDITIONS
OF GENETIC EQUILIBRIUM flow.
In 1908, Godfrey Hardy (1877-1947), an English math-
ematician, and Wilhelm Weinberg (1862-1937), a German MUTA
obstetrician, independently recognized that some alleles are
in a state of equilibrium (Figure 4.4). If no mutation or narw- ~ SOUR(
ral selection or gene flow occurs, if the population is large,
if mating is random, and if all members of the population  During ccl
produce the same number of offspring, then genotype fre-  self exactl
quencies at a single gene locus will remain the same afterone  duces an o
generation. Moreover, the equilibrium frequencies will bea  the proble
function of the allle requencies at the locus. This iscalled  enzymes
the Hard I tion can b
(Table 4.1}, a single ocus has A (dominant) and a(recessive)  of genetic
alleles, with respective frequencies of p and . In assessing Becau:
the population as a whole, it is assumed that males and fe-  (see “Prod|
males have both alleles. The Hardy-Weinberg law predicts  chapter 2),
the genotype frequencies for the next generation after one  health, w
‘mating, where p is the genotype frequency for the AA ho-  DNA that]
‘mozygous alleles, 2pg is the genotype frequency for the Az sequences,
(hetcrozygous) allcles, and g is the genotype frequency for  might cody
the aa homozygous alleles. In other words, the toral popu- ferent fun
lation (100%) should be the sum of the frequencies of three  for in the
genotypes, expressed by the simple mathematical equation  might cre:
P +2pg+g* = 1. 1fa hypothetical population were 60% A or an abng
(p=.6) and 40% a (q = .4), the genotype frequencies in the ~ random, af
next generation would work out to AA = d  consequen]
a = .16. The frequencies can be expressed as decimals or  Gametes
percentages, but they are expressed most often as decimals.  on what h
are the only genotypes for the gene  of their ca
in question in the population, the frequencies must add upto  of netw ge
1 or 100%. So, if the frequency of AA is 0.36 (or 36%), the Murtatif
frequency of Aa is 0.48 (or 48%), and the frequency of aais  point mut
0.16 (or 16%), together they add up to 1 (or 100%). altered tri
In the absence of evolution, the frequencies of the geno-  the origin:
types willin theory remain the same forever. In this way, the  the prorcil
Hardy-Weinberg equilibrium hypothesizes that gene frequen-  mutation
cies remain the same because no evolutionary change takes  amino aci
place (Figure 4.5). the indivi
By determining the genotype frequencies for a popula-  man chros
tion ar different points in time, however, the Hardy-Wein-  codon. Tl
berg cquation establishes whether evolution s operating o acid valin
a particular gene. If the genotype frequencies change from  glutamic a
one generation to the next, the population is not in cquilib-  moglobin
rium—it s evolving. If the frequencics remain the same, the in this cha
population is in equilibrium—the population s not evolving, Asarel
at least with respect to the locus being studied. sertion, the
‘What might cause a population to change its allele fre- tircly. Thi
quencies and go out of equilibrium? As noted in chapters 2 no functi
and 3, genes are passed from generation to generation by o the DN
interbreeding within populations in particular and among  limited nu
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HARDY-WEINBERG LAW: TESTING THE

After

/

CONDITIONS OF GENETIC EQUILIBRIUM

In 1908, Godfrey Hardy (1877-1947), an English math-
ematician, and Wilhelm Weinberg (1862-1937), a German
obstetrician, independently recognized that some alleles are
ina state of equilibrium (Figure 4.4). If no mutation or natu-
ral selection or gene flow oceurs, if the population is large,
if mating is random, and if all members of the population
produce the same number of offspring, then genotype fre-

Since the three genotypes are the only genoty pes for the gene
in question in the population, the frequencies must add up to
1 or 100%. So, if the frequency of AA is 0.36 (or 36%), the
frequency of Aa is 0.48 (or 48%), and the frequency of aa is
0.16 (or 16%), together they add up to 1 (or 100%).

In the absence of evolution, the frequencies of the geno-
types will i theory remain thesame forever. n his way, the

quencies at a single gene locus will remain th one
generation. Morcover, the equilibrium frequencies will be a
function of the allele frequencies at the locus. This is called
the Hardy-Weinberg law of equilibrium. In the simplest case
(Table 4.1), a single locus has A (dominant) and a (recessive)
alleles, with respective frequencics of p and g. In assessing
the population as a whole, i is assumed that males and fe-
males have both alleles. The Hardy-Weinberg law predicts
the genotype frequencies for the next generation after one
mating, where p? is the genotype frequency for the AA ho-
mozygous alleles, 2pg is the genotype frequency for the Aa
(heterozygous) alleles, and g* is the genotype frequency for
the aa homozygous alleles. In other words, the total popu-
lation (100%) should be the sum of the frequencies of three
genorypes, expresed by the simple mathemaical equation
PP+ 2pg +q* = 1. If a hypothetical population were 60% A
(p=6) and 40% a (g = 4), the genotype frequencies in the
next generation would work out to AA = .36, A, A48, and
aa = 16. The frequencies can be expressed as decimals or
percentages, but they are expressed most often as decimals.

MUTATION: THE ONLY SOURCE OF

During cell reproduction, DNA almost always replicates it-
self exactly. Sometimes, however, the replication process pro-
duces an error or a collection of errors in the DNA code. If
the problem is not at once detected and corrected by a set of
enzymes that monitor DNA, a mutation results. The muta-
tion can be any heritable change in the structure or amount
of genetic material.

Because so much of any person’s DNA is noncoding
(see “Producing Proteins: The Other Function of DNA” in
chapter 2), many mutations do not affect the individual’s
health, well-being, or survival. A new sequence of coding
DNA that results from mutation may have profound con-
sequences, positive or negative. For example, the mutation
might code the DNA for a protein with an altered or dif-
ferent function than that performed by the protein coded
for in the original parent strand of DNA, or the mutation
might create a sequence that results in cither no protein

frequen-
cies remain the same because no evolutionary change takes
place (Figure 4.5).

y determining the genotype frequencics for a popula-
tion at different points in time, however, the Hardy-Wei
berg cquation establishes whether cvolution s operating on
a particular gene. If the genotype frequencies change from
one generation to the next, the population is not in equilib-
rium—it is evolving. If the frequencies remain the same, the

lati liby he population evol
atleast with respect to the locus being studied.

What might cause a population to change its allele fre-
quencies and go out of equilibrium? As noted in chapters 2
and 3, genes are passed from generation to generation by
interbreeding within populations in particular and among
members of the same specics in general, and genetic changes
result from one or a combination of the four forces of evo-
lution: mutation, natural selection, genetic drift, and gene
flow.

NEW ALLELES

or an abnormal protein (Figure 4.6). Mutations occur at
random, and they can occur in any cell, but the ones with
consequences for future generations take place in gametes.
Gametes may transfer mutations o offspring, depending
on what happens during meiosis in the parents. Regardless
of their causes or outcomes, mutations are the only source
of new genetic variation in a population.

Mutations involving incorrect base pairing are called
point mutations. A synonymous point mutation creates an
altered triplet in the DNA, but the alteration carries with it
the original amino acid. Because the amino acid is the same,
the protein formed is the same. A nonsynonymous point
mutation results in a matchup that brings along a different
amino acid. Such a mutation can have dramatic resules for
the individual carrying ir. For example, a mutation on hu-
man chromosome 11 converts a GAG codon into a GTG
codon. The GAG codon is encoded to produce the amino






Examples of Use

The sample below shows a document which was composed using a number
of components of our Suites. The columns were created by Column Flow.
The headers were created by Power Headers, and the text was vertically justi-

fied by Proper VJ.

Before

leaders Created by
Power Headers

Chapter 18 Economic
and Social Revoluti

Chapter 17 Global
Nationalism

Columns J
by Proper VJ
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Shown below is a document which used Column Flow to create boxed sec-
tions. The boxes were created automatically using alternate text frame styles
for text which is contained within the box. The boxed text can break across

pages and a separate box is created for each section!

2 ACAMPROSATE

Acamprosate can affect your judgment
tion. Do not drive or operate dangerous mag
this medicine.

Possible Side Effects

Almost 2 of every 3 people who take this m

a drug side effect.

¥ Most common: diarrhea.

¥ Common: headache, weakness, anxiety
problems.

V¥ Less common: pain, accidental injuri
gas, dizziness, dry mouth, tingling in tl
ing, sweating, chest pain, loss of appetij
impotence, abnormal vision, rash, vomi

V¥ Rare: heart or kidney failure, suicidality,
ism, rheumatoid arthritis, and urinary tra|
effects can occur in almost any part of
doctor if you experience anything uny
medication.

Drug Interactions
e Mixing acamprosate with naltrexone|
els of both drugs in the blood, but no|
needed.

Food Interactions
You may take acamprosate with or without

Usual Dose
Adult: two 333-mg tablets 3 times a da
Child: not recommended.

Overdosage

The only symptom associated with acam
been diarrhea. Overdose victims should
emergency room for observation and treat
ment, ALWAYS bring the prescription bottl

Special Information

Contact your doctor if you are breast-feedin

about becoming pregnant while taking this|
Take care while driving a car or perform|
If you forget to take a dose, take it as s

do not remember until it is almost time for y|

Before
2 ACAMPROSATE
Acamprosate can affect your judgment, thinking, or coordina-

tion. Do not drive or operate dangerous machinery if you are taking  After
this medicine.

Possible Side Effects

Almost 2 of every 3 people who take this medicine will experi-

ence a drug side effect.

¥ Most common: diarrhea.

¥ Common: headache, weakness, anxiety, depression, and
sleep problems.

¥ Less common: pain, accidental injuries, nausea, stomach
gas, dizziness, dry mouth, tingling in the hands or feet,
itching, sweating, chest pain, loss of appetite, weight gain
or loss, impotence, abnormal vision, rash, vomiting, and
constipation.

¥ Rare: heart or kidney failure, suicidality, psoriasis, hypothy-
roidism, rheumatoid arthritis, and urinary tract infections.
Rare side effects can occur in almost any part of the body.
Contact your doctor if you experience anything unusual
while taking any medication.

Drug Interactions
® Mixing acamprosate with naltrexone can increase the lev-
els of both drugs in the blood, but no dose adjustments are
needed.

Food Interactions
You may take acamprosate with or without food.

Usual Dose
Adult: two 333-mg tablets 3 times a day.
Child: not recommended.

Overdosage

The only symptom associated with acamprosate overdose has
been diarrhea. Overdose victims should be taken to a hospital
emergency room for observation and treatment. If you seek treat-
ment, ALWAYS bring the prescription bottle or container.

Special Information

Contact your doctor if you are breast-feeding, pregnant, or thinking
about becoming pregnant while taking this medicine.
Take care while driving a car or performing complex tasks.






Two Separate Header Variables
Defined Using Power Headers
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Examples of Use

Shown below is a typical sample of Hebrew layout.
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Column Flow
Defined Using Story Tools v 1% /
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Installation
Column Flow was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 23.

All the necessary components of Column Flow are installed in a single step

by our installers. The installer includes APID ToolAssitant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the
few steps required.

Macintosh Install

M NO ‘o Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction U InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
ffid Me ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will






Installation / Windows Install

be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

:Ili— Setup - Reflective Object:

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick ‘Next', If you would like to select a different folder, dlick 'Browse',

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!toolscom

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:

=
g tarl AutoFlow Pro Activated ro8

Column Flow Activated 1.0.7

) Style Utilitles Activated 1.0.8
- Proper V] Activated 1.0.6
Gt Help Reflective Objects Activated 1.05

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7

Story Control Activated 1.0.7

Drop Words Demo: 23 days left FActiuate 1.0.5

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InDesign. | “camecin o o wessie. resse wote.

Cancel






Purchasing Licenses and Activation

To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@in-tools.com Password: ok kK

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Before You Start

It is important to understand how Column Flow works, and what its limita-

tions are:

1. Column Flow does not break columns within a single text frame. A new

text frame is created in each place that columns are split or spanned.

2. Column Flow does not work dynamically. You must specifically invoke a
command to have Column Flow reflow your text when you edit it or re-style
it in such a way that text re-flows. For this reason, it is highly recommended
that you use Column Flow at a point when your text will change very little

or not at all.

3. Column Flow only works with text that have paragraph styles applied.
You cannot locally apply column settings to specific text. All settings must

be applied using paragraph styles.

4. Column Flow can be used to create boxes or background shading around
sections of text, but since it must break text frames to do this, it cannot be
used to create boxes or background shading around individual paragraphs

in a two column text frame.

Basic Setup

The setup procedure for Column Flow changed drastically between version
1/CS2 and version 2 for CS3 and later.

In version 1 (or when using CS2 in version 2) all column settings were set
by changing the style names to have a number prefix. The number prefix

defines the number of columns the text should take up.





Basic Setup / Preliminary Setup

In version 2 using CS3 or later, the setup is much more intuitive and much
less disruptive.

Preliminary Setup

Before you start using Column Flow, you'll need to do a couple of things:
1. You must make sure all your text has styles applied to it.

2. Additionally, you should create at least one object style for your text
frames which has all the settings you will need (such as: First Baseline Off-
set, Column Gutter, text inset, stroke color, background color, etc.). You will
generally want separate styles for single column frames and multiple col-
umn frames, and sometimes separate styles for alternates as well. All these
styles should be set up (or at least created) before you set up the Column

Flow options.

Configuration Setup
Once the preliminary set up is done, select InTools > Column Flow > Con-

figure Column Flow. This will bring up the following dialog shown below.

Please note: The Column Flow configuration settings are document-wide settings.
If it is necessary to use different settings in the same document, the settings must

be changed before each re-flow.

The only setup required before running Column Flow is the selection of the
object styles used for single column and multi-column frames. All the other

settings are optional.
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Vain ObjectSyls: Area 1 &
One Column Frame Style: | [None] H-l 1 Align to Grid
Multi-Column Frame Style: [ [None] [%] ] Align to Grid
Alternate Object Styles: Area 2
One Column Alternate: [ [None] I-G-l [l Align to Grid
Multi-Column Alternate: [ [None] l-i-l d Align to Grid
Options:  Area 3 Area 4
# Add/Remove Pages While Flowing? With Story Strings:
EA ply Space Before To One Column Frame Start Story On New Page
BEAEE L g
™ Apply Space Before To Multi-Column Frame (O Start Story Below Previous
Col Balancing: | Basi B‘
DT EEE S - [ Use Master Page Links 5
Keeps Optlons:Area 6 Area 7
Bottom Frame Removal: Don't Split Frames of 0 Columns
) None Don't Split Alt. Frames of 0 Columns
Medi
O E_ um (You can input a range of numbers.)
() Strict
™ Honor Keeps While Shrinking Frames
"1 Set by Style Name 8

1. In the dialog shown, there are many different areas. Of all the settings,
Area #1 and in some cases, area #2 are the most important. In Area #1, se-
lect the object styles that will be used for composing the single and multi-
column texts. If “Align to Grid” is checked, the text frames will be aligned to
the document-wide baseline grid and space will be added between the text
frames if necessary. These settings should be set up in the document “Grids”

Preferences.

nmm The “Align to Grid” option is very useful for ensuring that head-
ings which are normally not aligned to grid, line up with grid-
aligned body text at the top of a column.






Basic Setup / Configuration Setup

2. If your document requires the use of alternate styles (such as docu-
ments which have boxed sections), make sure to select the correct object

styles in area #2.
3. Area #3 has four configuration options:

a) M Add/Remove Pages While Flowing? | Enabling “Add/Remove Pages” will

cause Column Flow to add or remove pages as needed while flowing text. If
the option is not checked, text will only be flowed on pages which already

have a text frame of the story currently being flowed.

b) ™ Apply Space Before To One Column Frame "]__he second check-box defines

whether the space-before settings of the first paragraph will be used to place

the text frame lower on the page. If checked the space-before values will be
added to the space between a single column frame, and the text frame above

it. The “space after” setting of the previous paragraph is always applied.

C) ™ Apply Space Before To Multi-Column Frame | [f this option is checked the

space-before values will be added to the space between a multi-column
frame, and the text frame above it. The “space after” setting of the previous

paragraph is always applied.

d)  Column Balancing: | Basic 1| Column Flow offers a few different

options for balancing of columns at the bottom of a page. If “None” is se-
lected, the text frames at the bottom of a page will always be snapped to the
bottom page margin. If “Basic” is selected, the text frame will be shrunk up
to balance the columns as best as possible. (The amount the text frame will
shrink depends on the check-box in area #7.) If Line Long/Short is selected,
Column Flow will add or remove a line if the bottom text does not align
across columns and changing the number of lines would fix this. Column

Flow will only allow a difference of one line length across a single spread of
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facing pages. This means that if one page is a line long, the facing page will

not be a line short, and vice versa.

4. The “story string” option is for use in conjunction with Story Tools.
When flowing “story strings” (set up using Story Tools), each consecutive
story can start either on a new page, or immediately below the previous one
(provided there is enough room on the page). If “Start Story Below Previ-
ous” is selected, the alignment and spacing settings will be the same as for

within one story.

5. Option #5 is only visible if AutoFlow Pro is installed. AutoFlow Pro al-
lows for the creation of links between paragraph styles and master pages. If
the check-box is checked and the master page links are set up using Auto-
Flow Pro (please refer to the AutoFlow Pro documentation for more details),
Column Flow will automatically apply the correct master pages as it flows
the text.

6. Area #6 allows for control of how much text is forced on the bottom of a
page. InDesign allows keeps options to be broken, when honoring them will
cause a text column to be empty. Column Flow gives three options of ad-
herence to keeps options for text frames which fall on the bottom of a page.
“None” will leave any text frames that can be created on the bottom of the
page, even if doing so will violate keeps restrictions. “Medium”, will allow
text frames that don’t violate keeps at the end of the frame, but allow keeps
to be broken between columns. “Strict” will not allow any keeps options to
be broken in the bottom text frame, and will remove any bottom text frames

that will violate any of the keeps settings.

7. Area #7 has three different settings. The first two allow for sections to be

kept together. Don't Split Frames of 0 Columns | The first option is for text
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which uses the main object style. Don'tSplit Alt. Frames of |0 Columns | The

second option is for text which uses the alternate object styles. For both
fields, you can input a range of column numbers. Valid formats are comma
and/or hyphen separated numbers. For example: “2-4” will cause all text of
one, two, or three columns to be kept together. “1,3-5"will cause all text of 1,
3,4, or 5 columns to be kept together.

™ Honor Keeps While Shrinking Frames| The third option defines how much Column
Flow will shrink text frames after breaking the text. If the check-box is
checked, Column Flow will only shrink the frame as much as possible with-
out breaking keeps settings. If it is unchecked, the text frames will be shrunk
as much as possible.

8. Option #8 allows for legacy style names to be used to determine the
number of columns text takes up. If the check-box is checked, the number
of columns will be determined by the style name instead of the settings set
by the styles dialog.

Setting Up Styles
In the latest versions of Column Flow, defining style settings has become

very easy! To access the style dialog, select InTools > Column Flow > Col-

umn Flow Styles.... This will bring up the dialog shown below.
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e Style
— Paragraph Styles — Column Flow Settings
¥ [No Paragraph Style] i
Columns: .
[Basic Paragraph] Header
Header ) Main Style
Figure Caption (Text Styles) O Alternate Style
Main Text (Text Styles)
¥ Sub-Header (Header Styles)
TOC Body Text (TOC Styles) — Defined Column Flow Styles:
Figure Caption Alternate: No -

)4

Caption (Text Styles): Columns: 2, Header: undefined,
Alternate: No

Screen shot trailer (Text Styles): Columns: 2, Header:
undefined, Alternate: No

Number Level 2 (Text Styles): Columns: 2, Header:
undefined, Alternate: No

Numbered List (Text Styles): Columns: 2, Header:
undefined, Alternate: No

Picture Anchor (Text Styles): Columns: 2, Header:
undefined, Alternate: No

[

Picture Anchor2 (Text Styles): Columns: 2, Header:
undefined, Alternate: No v

<[ v €

L
g
v

— Style Structure View:
() "Based On" (O) Style Groups

( OK ) ( Cancel )

There’s only three different settings are set in this dialog: Columns count,
Header, and Main/Alternate Style. You must input a column count for the
styles, as well as select whether the main style should be used, or the alter-

nate. The Header option is only applicable if the column count is 1.

You can scroll through the “Defined Column Flow Styles” list to quickly see
which styles have which settings.

The Column Flow Style dialog presents the object styles of the current docu-
ment in a tree format. There are two distinct tree structure views available.
There is the “Based On” view and the “Style Groups” view. You can switch
between the two views at any time by clicking on the appropriate radio but-
ton.
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— Paragraph Styles Style GroupS View
Text Styles . « .
Faure Caseon 5 The “Style Groups” view presents the
ain Text
e taler styles in an expandable tree, with a
Number Level 2 . .
Numbered List . folder structure similar to the folder
Picture Anchor
. .

Piture Anchor2 structure of InDesign’s Object Style
Tip Continued . .
Tio Continued Bulleted panel. If you organize your object
License Aareement
Code 4
ot last line styles n style groups, you can use
Code Header . . . . o e

L wanwihnex this view to select either individual

Header Styles

Sect Head 1
Section Header styles or entire style groups.
License Sub-Header Y

¥ TOC Styles - .
70C Sub-Header . When a style group is selected, all the
TOC Body Text 3

A€ s K1 styles (and sub-group styles) in the

— Style Structure View: ———————————— selected style group will be associated

(0) "Based On" (@) Style Groups

with the Column Flow setting you choose.

— Paragraph Styles Based ()n Vle“’
¥ [No Paragraph Style] « » .
oo o] The “Based On” view presents a tree

Header
Figure Caption (Text Styles)
Main Text (Text Styles)

P Sub-Header (Header Styles)
TOC Body Text (TOC Styles)
Figure Caption

structure of all the styles, in which
each style can be seen in its relation
to the style upon which it is based.
The root of the style tree will always
be the [None] style as all styles

are ultimately based on [None].

When the styles are viewed in
the “Based-On” structure, all styles

I - <> which are based on the selected

— Style Structure View: style will be associated with the

© Based On" O Style Groups Column Flow setting you choose.
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Running Column Flow

To Run Column Flow, You simply select InTools > Column Flow > Flow...
All flowing is done to fit within the page margins and can be flowed on five

different levels.

1. Current Page: This option flows the selected story on the current page,
and fits as much text as possible using the current flow settings. It uses the
selected frame as the vertical starting point. This option should be used if a

lot of manual tweaking is to be done.

2. Restof Story: This option will flow the rest of the story starting from the
selected text frame. Pages will be added or removed if this option is selected

in the Column Flow Options.
3. Whole Story: This will re-flow the entire selected story.

4. Story String From Selection: This option will be grayed-out, unless a
story string was set up using the Story Tools plug-in. If the Story String was
properly set up, this option will flow the entire string starting from the se-
lected frame. Story String Flow will always add and remove pages as neces-

sary, regardless of the settings in the Column Flow Settings.

5. ‘Whole Story String: This will flow the Story String (if set up) starting
from the first story in the string.

umm Column Flow works much quicker when it creates pages and
text frames on the fly. It is therefore recommended when flow-
ing large amounts of text, to remove all subsequent pages, and

run Column Flow on overset text.
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nmm  To automatically create two multiple column frames one im-
mediately after the other: Insert a blank one column paragraph
with a leading of zero. This paragraph will act as a “column
breaker”, and will cause the text above it to be balanced across
the columns. The text after the blank paragraph will be bal-

anced independently.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of Javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic, it
requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-

ate the collection of plug-ins we offer in the same amount of development
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time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the



http://in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Department’s list of Specially Designated Nationals or the U.S. Commerce
Department’s Table of Denial Order. By downloading or using the Software, you are
agreeing to the aforementioned and you are representing and warranting that you are
not located in, under the control of, or a national or resident of any such country or on

any such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. In-Tools may immediately terminate
the Agreement if you breach any representation, warranty, agreement or obligation
contained or referred to in this Agreement. Upon termination, you must dispose of the
Software and all copies or versions of the Software by destroying the Software. In-Tools
reserves the right to modify the Software at any time without providing notice to you.
In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT, AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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Introduction

Introduction

Side Heads was created in response to numerous requests for a plug-in that
would enable the user to easily create side heads in InDesign. In this docu-
ment, the term “side heads” refers to any text which is attached to the main
text, but is defined with its own position. The position of the side heads may

or may not be within the bounds of the text frame of the main story.

This plug-in uses anchored frames, which is a standard feature of InDesign
CS2 and higher. In certain circumstances, Side Heads also makes use of the
notes plug-in which is installed in CS3 by default, and is available for op-
tional installation on the CS2 installation disk. We recommend installing
the CS2 notes plug-in if you will be using character-based side heads and

want to be able to undo them.

Side Heads not only creates the side heads for the text, it will also apply
formatting based on the object style settings which you set up. The frames
which Side Heads creates can be in-line, above-line, or anchored, depending

on your settings.

While the use of anchored frames removes the text from the text flow, the

text can easily be returned to the text flow for exporting of the text.

If you use a bit of creativity, Side Heads opens up some very interesting lay-
out possibilities. Below are some examples of how Side Heads has been used.

Thank you to Brad Walrod and Raphael Freeman for the illustrations.
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Mercer National Survey Before
of Employer-Sponsored
Health Plans 2007

Specialty Medical Benefits ®

Prescription drug three-tier copayment amounts Side Head Text
I Cord plan < Before Side Head Creation After

B Mail-order plan

Mercer National Survey
of

Health Plans 2007 Paragraph-Based Side Heads

Specialty Medical Benefits ®

Created Complete with

Formatting
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a H Mail-order plan
3

5

i
i
z
£

P
Gare management programs and services
Fercents G s otal 100 e 1o Al responses

programs and
services

32

due to muliple responses

The above illustration shows the effects of applying Side Heads with format-
ting settings set in the side heads object style. Please note the spreading of
the paragraphs in the bottom half of the page. Both paragraphs are in the
same frame and spread by vertical justification. This can be accomplished
automatically by setting the object style for the side heads frame to vertically
justify using our Proper V] plug-in.
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Side Heads P> Forkingship is the LorD’s

and He rules over the nations.

Ob.i Saviours shall go up to Mount Zion
to judge Mount Esau,
and the LorD’s shall be the kingdom.

Zehsa Then shall the LORD be King over all the earth.
On that day shall the Lorp be One and His name One,
(as it is written in Your Torah, saying:
Listen, Israel: the LORD is our God, the LORD is one.)

“This prayer, the concluding blessing of the Verses of Praise, i said standing.
nane? May Your name be praised for ever, our King,

the great and holy God, King in heaven and on earth.
For to You, LORD our God and God of our ancestors,
it is right to offer song and praise,

hymn and psalm,

strength and dominion,

eternity, greatness and power,

song of praise and glory,

holiness and kingship,

blessings and thanks, from now and for ever.

Blessed are You, LORD,

God and King, exalted in praises,

God of thanksgivings,

Master of wonders,

who delights in hymns of song,

King, God, Giver oflife to the world.

The above illustration shows a number of diversified uses for Side Heads.
The character based side heads show how individual characters can be
placed outside the bounds of the text frame. They can be aligned to either
the beginning of the paragraph (as shown on the top of the page), or to their

original placement (as shown on the bottom).

The paragraph based side heads have been used in a very unique way in this
document. They don’t look like “side heads” at all! The anchored object set-
tings on these “side heads” were set to “above line”. This accomplishes a
number of very unique things. 1. There is no need for a separate style for
paragraphs which have these “side heads” above them. The “space-before”
settings are applied above the “side head” paragraph! 2. Changing para-
graph and character attributes for a span of paragraphs will not effect the






Side Heads

“side heads”. For example: it is possible to select the entire text frame and

change the point size without the “side heads” being affected.

NOAH BERESHIT / GENESIS 11

years, and begot Re‘u: and Peleg lived after he begot Re'u two hun- 19
dred and nine years, and begot sons and daughters. And 20
Re'u lived thirty two years, and begot Serug: and Re'u lived after 21
he begot Serug two hundred and seven years, and begot sons and

daughters. And Serug lived thirty years, and begot Nahor: 22
and Serug lived after he begot Nahor two hundred years, and begot 23
sons and daughters. And Nahor lived twenty nine years,and 24
begot Terah: and Nahor lived after he begot Terah a hundred and 25
nineteen years, and begot sons and daughters. And Terah 26
lived seventy years, and begot Avram, Nahor, and Haran. Now these 27
are the generations of Terah: Terah begot Avram, Nahor, and Haran;

and Haran begot Lot. And Haran died before his father Terah in the 28
land of his nativity, in Ur-kasdim. And Avram and Nahor took wives 29
for themselves; the name of Avram’s wife was Saray; and the name

of Nahor’s wife, Milka, the daughter of Haran, the father of Milka,

and the father of Yiska. But Saray was barren; she had no child. And 30
Terah took Avram his son, and Lot the son of Haran his son’s sorff
and Saray his daughter in law, his son Avram’s wife; and they werlt
out with them from Ur-kasdim, to go into the land of Kenaan; g
they came to Haran, and dwelt there. And the days of Terah were,
hundred and five years: and Terah died in Haran.
Now the LORD said to Avram, Get thee out of thy country, andArom 1 12
thy kindred, and from thy father’s house, to the land that I

LEKH-LEKHA

and the souls that they had/acgdired in Haran;
into the land of
e land to the place 6

the Kenaani was then

Character Based

Side Heads
31

The above illustration shows a page in a bible currently being published us-
ing Side Heads. There are literally tens (if not hundreds) of thousands of side
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heads which are applied. The use of Side Heads saves weeks of manual labor.
Please note the three different side head frames all attached to the same line
(Lekh-Lekha, chapter 12, and verse 1). Additionally, note that verses 30 and
31 are both anchored to the same place. The conflict is automatically detect-

ed, and adjusted based on the settings chosen in the configuration window.
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Installation

Side Heads was developed using a product called “APID ToolAssistant” cre-
ated by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page S7.

All the necessary components of Side Heads are installed in a single step by
our installers. The installer includes APID ToolAssitant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MmOO ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction U InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
ffid Me ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )

A

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

:Ili— Setup - Reflective Object:

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additonal step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick ‘Next', If you would like to select a different folder, dlick 'Browse',

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!toolscom

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:

—
Fead Hanual

AutoFlow Pro Activated 1.0.8

Column Flow Activated 1.0.7

) Style Utilitles Activated 1.0.8
1 Proper V] Activated 1.0.6
Gt Help Reflective Objects Activated 1.05

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7
Story Control Activated 1.0.7

Drop Words Demo: 23 days left FActiuate 1.0.5

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | “camecin o 7ot wessie. resse wote.

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@in-tools.com Password: ok kK

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” checkboxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Setup

There is no limit to the number of side heads which can be set up within
a document. All the settings are unique to the individual side head style,
so you can mix and match any combination of side head setups within the

limitations described below.

There are three basic types of side heads; “paragraph-based” and “character-
based” and “footnote-based”

X Heip Q@+ FTox

=1

Active Page Item Developer... =
230578

AutoFlow
Column Flow
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To define a side head, select InTools > Side Heads > Configure Side

Heads... as shown above.

Paragraph-based side heads are defined on the paragraph level by the ap-
plied paragraph style. Any number of paragraph styles can be defined as side
heads. When a run of paragraphs are all defined as side heads, they are all
placed in an anchored frame together, even if they have different side head
definitions. The side heads are run in the order they are defined, so the first
side head in the list defines the entire run of paragraphs. This is true irrel-

evant to the order of the paragraphs.

Character based side heads are treated on an individual-basis.
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No matter what type of side head you are applying, you must set up an ob-
ject style first. The object style will define most of the attributes of your side
head. This includes position, paragraph style, and just about every other set-
ting you might want other than the size of the text frame which will contain

your side head.

Applying Settings

The first thing you must do when defining a side head, is to name it. Make
sure that all the names are unique. When you define your first Side Head the
following dialog will appear:

Name Your Side Head:

Side Head Name: Ei)
{ Cancel )

After naming your side head, you are presented with a dialog to pick the side
head type as shown:

Configure Side Head "Side Head"

Side Head type: (#) Paragraph Based i)
(") Character Based

() Footnote Based

Once a particular side head is defined as either a paragraph-type or a charac-
ter-type, that type can not be changed. All other attributes can be changed

later.
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Paragraph Type

Paragraph-type side heads are side heads defined by a paragraph style. The
paragraphs with the selected style are transferred to the side head frame. If
there is more than one paragraph with side head styles all styled paragraphs
will be moved together. If there is more than one style, the anchored frame
settings will be defined by the first style defined as a side head.

If the paragraph-type is chosen, you are presented with the following dialog:

Configure Side Head "My Side Head"

Make Side Heads From Style: | [No Paragraph Style] | :J EI)

Object Style for Side Head Frame: ' [None] f :j

Vertical Size of Frame: 50 pt

Horizontal Size of Frame: 50 pt

Options:
s ™ Remove Original Text?

The options in the dialog box are self-explanatory. In the top drop-down list
select the paragraph style which you are defining as a side head.

The area below that defines the attributes of the containing text frame: the
object style, and the size. The size is defined in your preferred units of mea-
surements. The default size is SO points by S0 points, but can be any size you
choose.

At the bottom of the dialog box is an option to either leave or remove the

original text. In most situations, the checkbox should remain checked. In
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situations where you want the text to be duplicated, rather than moved to

the side head frame (such as pull quotes), you should uncheck it.

Character Type
If the character-type is chosen, you are presented with the following dialog:

Configure Side Head "My Side Head"

Make Side Heads From Style: | [None] | :J GE)

From Within Paragraph Style: = Any | :! Cﬂ)
Object Style for Side Head Frame: | [None] | :J

Alternate Style One: | Original | :J

Alternate Style Two: = Original | :J

Vertical Size of Frame: 50 pt

Harizontal Size of Frame: 50 pt

Options:
P E Remowve Original Text?

E Remove Character Style?

Align Side Head: @ To Original Text Location
() To First Line in Paragraph

The first area in the dialog defines the source text. A character style must be
picked, and optionally a containing paragraph style. Nested styles are not
currently supported. You must have the character style manually applied to
the appropriate text.

The second area defines the text frame attributes. Object style and frame
size options are the same as the paragraph-type side heads. Alternate styles
are used when side heads collide (i.e. when there are two instances on the
same line.) If two side heads are anchored to the same line and have the

same definition, the first side head will take on the first alternate style, and
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the second will take on the second. There are currently no provisions for

more than two conflicting side heads per line.

As with paragraph-type side heads, the size is defined in your preferred units
of measurements. The default size is SO points by SO points, but can be any

size you choose.
At the bottom of the dialog box are the following options:

“Remove Original Text” provides the same functionally as in paragraph

style side heads.

“Remove Character Style”: If this box is checked, the character style will be
stripped from the source text when moved to the side head frame. The text
will take on all the attributes of the paragraph style as defined by the object

style of your side head frame.

The “Align Side Head” option allows you to anchor the side head to either
the original text position or the first line of the containing paragraph.

Footnote Type

Footnote-type side heads enable creation of side heads/notes from foot-
notes with the click of a button. The side notes can be changed back to foot-
notes just as easily. If the footnote-type is chosen, you are presented with the

following dialog:
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Configure Side Head "My Side Head"

Object Style for Side Head Frame: [ [None] 'ﬂ (i)
Vertical Size of Frame: 50 pt ( Cancel )

Horizontal Size of Frame: 50 pt

Options:
P E Remove Original Text?

E Remove Character Style?

1 Preserve Footnote References?

Align Side Head: f To Original Text Location
() To First Line in Paragraph

You will notice that these options are very similar to the character-style op-
tions. The first difference is that the styles are missing. This is because the
side heads are created from footnotes regardless of style. The second differ-
ence is, that footnote-based side heads have an option to preserve footnote
references. Please note that these are currently limited to Arabic numbers. Other
numbering styles (i.e. roman numerals, etc.) will not be honored. Side Heads
uses xml elements to keep the side note numbering undoable. These could
be shown in your layout view. If they are distracting, you may want to hide

them under View > Structure > Hide Tag Markers.

Creating Side Heads

Once your side heads and your object styles are properly defined, it’s time
to create your side heads.

Select “Create All Side Heads” from the sub-menu under “Side Heads”.
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Story Tools

Configure Side Heads

In most situations, once you have defined and run your side heads, your side
heads ar set.

Update All Side Heads

Sometimes further adjustments are required after you have created your
side heads. One common situation occurs when character-based side heads
conflict. When your text re-flows, some conflicts may resolve themselves
and new conflicts may appear. To rectify these situations, simply select up-
date all side heads, and all side heads will be properly adjusted.

Undo Side Heads

Undo Side Heads:

Side Head to Undo: = side4 :l: &
( Cancel )

You also have the option of undoing a side head. When a side head is un-

done, the text is returned to its original placement with its original style. If
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the side heads are footnote-based, the text will be converted back to foot-

notes. Simply select the side head definition to undo in the above dialog box.

Import Side Heads Definitions

After defining your Side Heads defintions in one file, it is very easy to use
those defintions in other files thus saving yourself work and possible errors.
To import Side Heads defintions from a different document, select: InTools
> Side Heads > Import Side Heads Definitions... and select your docu-

ment in the dialog.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-

sistant is a plug-in which allows very fine grained event processing using Ex-
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tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of
hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement
Please read the following document carefully!

Thisis alegal agreement (the Agreement) between you and Print Israel LLC (In-Tools),
the developer of the In-Tools software. This Agreement pertains to your use of the In-
Tools software and documentation which are provided to you by In-Tools (collectively,
the Software). By copying, installing, or otherwise using the Software, you accept all
the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the



http://in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE ORDATA.YOU ASSUME TOTAL RESPONSIBILITY AND
RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY






Side Heads

MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Department>s list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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What is Story Control?

What is Story Control?

Stories in InDesign have no logical order. The order of stories are in fact
completely arbitrary. While one can layout stories in a visual order by manu-
ally placing the text frames of one story following another, there is no good

way to automate layout across multiple stories.

The purpose of Story Control, is to remedy this shortcoming. Story Control
gives you the ability to break up stories while keeping the text order, as well
as define unrelated stories in a logical order. Once the stories are defined as
“Story Strings” (a series of stories with a defined order) there are many op-

tions which open up to us.

In fact, one of the impetuses for creating Story Control was a specific job which
came in as over 40 different Word documents. They were to be laid out in a
specific order. The problem was: there was no order identifiable by the file
names. The order was based on the first words in each document — a design-
er’s nightmare! Using Story Control, once all the files are imported — by drag
and drop for example, ordering the stories is a simple matter. Story Control
can automatically label the stories based on the first words. Tell Story Control
the correct order, and the stories are all laid out correctly. A time-consuming
and frustrating task becomes amazingly quick and easy with the Story Control

plug-in!

Story Control integrates with many of the other plug-ins available from In-
Tools. For example: breaking up a story into smaller stories can greatly im-
prove the performance of Proper V]. When a story is broken into smaller
ones using Story Control, Auto-Flow can be used to automatically add pages

as necessary. These pages will be added between stories, and will not ad-
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versely affect the layout. Column Flow can automatically flow story strings

one following the other.
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Installation
Story Control was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 12.

All the necessary components of Story Control are installed in a single step
by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

(o NeNé) ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INylools.com
Package Name Action Size

@ Introduction T InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
8 Read Ma ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )

A

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

It is recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Next = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick 'Next', If you would like to select a different folder, dlick 'Browse'.

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!tools.com

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:
AutoFlow Pro Activated 1.0.8

Column Flow Activated 1.0.7

Style Utilities Activated 1.0.8
Proper V1 Activated 1.0.6
Reflective Objects Activated 1.0.5

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7

Story Cantrol Activated 1.0.7

Drop Words Demeo: 23 days left ictivate oldnf.f

Drop Words creates “drop werds” commanly used In classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InDesign. | “comecin o mroois wesste. iesse ot

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@In-tools.com Password: Fdk HEHEEEE

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.



http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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General Use

Before a story string can be defined, the stories must be defined by a name.

This can be done either one-by-one, or for the whole document at once.

Defining Story Names

X Help ® % D o kL
Active Page Item Developer... = == . ===
AutoFlow H‘- W4 justification: ‘Stand_. |3
Column Flow
Drop Words [28 260 [

Formatting Tools
Multilingual Tools
Reflective Objects
Side Heads

Story Tools Mame Selected Story
pick the number of words it will be named MName Multiple Stories
ords-of each story allowing for easy-identifi Split Story By Style
String Named Stories
Flow Stories In String Order

LAYy Y YF Y ¥YYY

Please-note: There is-a limitation in-drop-downs,
acterswill nothe disnlaved . Foow oot dran.dmae

There are three ways to name stories:

1. The simplest way is to select each individual story, and select the menu
item “Name Selected Story”. If the story already has a name, the dialog will

display the current name and you can change it. If there is no name yet, it

will be blank.

2. Ifyou have many stories to name, this can get quite tedious! To help al-

leviate this, you have the option to “Name Multiple Stories”:
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Name Document Stories

Minimum Story Size: 2 ® Paragraphs w
() Words (" cancel )

m
(_) Characters

Name With First 2 Words

You probably don’t want to name every story in your document. (You can
end up with some very long drop downs later on!) This dialog gives you the
ability to filter out the stories to name based on size. Presumably you want to
name the longer stories in your document. The top area of the dialog defines
the minimum size of a story to receive a name. The lower area allows you to
pick the number of words it will be named with. The words will be the first

words of each story allowing for easy identification of your stories.

Please note: There is a limitation in drop-downs, and names with too many char-
acters will not be displayed. If you get drop-downs with empty items (i.e. no text)

that means your story names are too long, and must be shortened.

3. “Split Story By Style”: This is explained below.

Split Story

InDesign is not built to handle long stories very well. The program can get
sluggish, and reflows can take a while. Split Story By Style gives you the op-
tion to take a long story and split it into a number of smaller stories. This
greatly improves text handling, while maintaining the story order. Addition-

ally, it can be used to easily reorder sections of the text.

When splitting a story, if the story is named, all the sub-stories will be named
with the original name, plus a the number of the story in the string. So, My
Story will become: My Story, My Story2, My Story3, etc.
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If the story is not named, you are presented with the option of naming it. If
you choose to not name the story, the story will be split, but no story string

will created.

When splitting a story, you are presented with a drop-down to choose the
paragraph style which will be the start of every new story. The story will
be broken right before every instance of the selected paragraph style. You
also have the option to only break the story if the paragraph which has the
selected paragraph style applied is at the start of a text frame. You should
select this option if you want to maintain your layout. If the story is broken
in the middle of a frame, you will undoubtedly get overset text. If you have
our Auto-Flow plug-in installed, and the original story is set to Auto-Flow, the
Auto-Flow plug-in will add frames to fit all the text.

Defining Story Strings

Story Strings can be defined in two ways:

1. Automatically, while splitting a long story into many shorter ones. (As

described above)
2. Manually, using the “String Named Stories” menu item.

If you need to string stories manually, select “String Named Stories”, and
you are presented with a rather large dialog box. You have sixty drop-downs
which can be used to select the stories in their proper order. The list of sto-

ries are ordered in the drop-down alphabetically.

Please note: You can not currently add to an existing story string. If you must add
to a string, you must redefine the entire string from the beginning until the end
using the dialog. You are therefore (currently) limited to 60 stories per story string
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when defining them in the dialog. There is no limit to the number of separate story
strings which can be defined in any specific document.

Flowing Story Strings

Once your story string is defined, you can automatically flow it in the cor-
rect order regardless of the current order or position of the stories. Simply
select “Flow Stories In String Order” and they will be flowed one following
the other in the defined order, until there is no more over-set text. This can

be very useful for laying out text from many different files in a defined order.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific
processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using Ex-
tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.
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Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the




http://in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, ORAS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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“Why a Plug-in?”

The header variables included in InDesign since the release of CS3 are very
good. They work very well in the context for which they were intended.
However, for many complex layout situations, they fall short. Power Head-
ers addresses those shortcomings. The following is an overview of the im-

proved functionality available with Power Headers.

1. InDesign variables are limited to basing your headers on either para-
graph or character styles. In Power Headers there is an option to base it on
paragraph style, character style, or both (a character style within a specific
paragraph style). See page 20 for more information.

2. Inthe “use” drop-down, InDesign has two options: “First” and “Last”.

Power Headers has 8 options: 1. First Word 2. First Instance 3. Last
Word 4. Last Instance  S. First And Last: This option will put both the
first and last instances into the header if there are more than one instance
of the same variable text. This enables uses such as “Chapter 1” or “Chapter
2-3” depending on the content of the page. (There is a field for “between
text” for such situations.) 6. Current Instance: This option enables the in-
put of the last found instance of source text unless the source text is the first
line of text on the page. When an instance is found on the first line, or if an
instance is anchored to the first line, that instance will be appear in the header.
Otherwise, the previous instance will appear in the header. 7. Current and
Last Instance: This option combines the functionality of “Current Instance”
with “Firstand Last”. 8. All Instances: This option will populate the header

with all instances of the selected style. See page 21 for more information.

3. Conditional Text: Power Headers has an option to define conditional
text. Conditional text replaces the text in the “Text Before” or “Text After”
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fields of the configuration dialog. If the correct option is selected, the con-
ditional text will appear only on pages which do not have source text, and if
“Current Instance” is selected, the conditional text will appear on a page on

which the last instance was used. See page 25 for more information.

4. InDesign does not allow for choosing the frame order for the source
text. Power Headers has an option to choose the frame order. The order can
be either right-to-left, or left-to-right. These options are especially impor-
tant in the ME version when using Right-to-Left text. The frame order can
also be defined to either go down first and then across or vice versa, result-
ing in four frame order options: 1. “Top, Bottom, Left, Right” 2. “Top,
Bottom, Right, Left”. 3. “Left, Right, Top, Bottom”. 4. “Right, Left, Top,
Bottom”. This is defined at the variable level, so you can have different frame

orders in the same document. See page 22 for more information.

5. InDesign headers are page reflective, meaning they always reflect the
content based on which page they appear. However they cannot reflect
the content on the whole spread or a single column. Power Headers allows
you to select a “Source Range”. A source range can be defined to be a “Page”,
“Spread”, or “Column”. This enables creating “spread reflective” and “column

reflective” headers. See page 20 for more information.

6. InDesign offers no control over which pages display header text. This
requires creating a separate master page for pages which shouldn’t have the
header text. Power Headers solves this problem by providing three inclusion

options:

a) “Only Include on Pages With Source Style” will only insert a header
on a page which actually has text for the header.
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b) “Include Last Instance on Pages Without Source Text” will insert a

header, if there’s text of a story which has text for the header.

c) “Include Last Instance on Pages Without Story Text” will create
headers from the last previous occurrence in the document. See page 29 for
more information.

7. Power Headers has an option to ignore stories that have fewer than a

specified number of characters. See page 29 for more information.

8. InDesign variables are document-specific, and need to be created or
loaded in each document separately. Power Headers can create header vari-
ables across a whole book file.

9. Power Headers can be updated across a whole book file. See page 38 for
more information.

10. Alternate Styles: InDesign headers can only be based on one style. If
you want the header to be taken from style 1, or style 2, you are stuck! Power
Headers can define variables based on an unlimited number of styles! If you
have variations on your header styles, and want the headers to reflect any of
those styles, you can define “Alternate Styles” for your header definitions.
All the defined alternates will be treated as if they are of the same style. See

page 29 for more information.

11. Smart Title Case: The standard title case of InDesign is very “dumb”. All
words are capitalized no matter what they are. In the real world, this is fairly
useless. Power Headers can create a Smart Title Case which is rule-based.
The underlying word list is user-definable. See page 23 for more informa-

tion.
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12. Localized Formatting: InDesign does not provide a way to transfer local
formatting to the header. The styling must be done using character styling.
It is impossible to create a header with only one of several words bolded or
italicized. Power Headers gives an option to copy local (overridden) format-
ting to the header. It can even convert italics to the header base weight. See

page 26 for more information.

13. Text Composition: InDesign variables (including headers) are treated
as a single character. Because of this, headers cannot break across lines. This
makes multiple-line headers impossible. Power Headers keep the headers as

live text, and creates multiple-line header with ease.

14. Punctuation: InDesign gives no control over removing punctuation. It
is either enabled, or disabled. Power Headers gives a number of options. See

page 24 for more information.

1S. Ignore Blank Paragraphs: Power Headers ofters control over whether
blank paragraphs are transferred to the headers or not. While you would
usually not want to create headers from blank paragraphs, this option can be

used to create blank headers if needed. See page 28 for more information.

16. Paragraph Ranges: Power Headers offers the option of transferring an
entire paragraph range to the header. This can be used for some very inter-
esting applications. For example, a side bar can contain page reflective infor-

mation. See page 28 for more information.

17. Bullets and Paragraph Numbering: Power Headers ofters the option of
transferring bullets or paragraph numbering to the headers. You can use this
option in conjunction with the option to transfer local formatting or GREP
Processors (feature #20 on page 8) to style the bullets or paragraph numbers
differently than the rest of the header text. See page 27 for more information.
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18. Original Text Removal: Power Headers offers the option for the header
to not contain the found text. This is useful in cases where you need only the
paragraph numbers or custom text. It can also be used to remove specific

headers on specific pages. See page 27 for more information.

19. Resetter Styles: Power Headers offers the option to limit the instances
of the source text which appears in the headers. It does so by removing po-
tential header text when it finds a “Resetter Style”. You can define multiple
Resetter Styles, and each one can have unique settings. See page 30 for more

information.

20. GREP Processors: Power Headers ofters the option of applying post pro-
cessing to individual header variables. The processing can change the format-
ting and can change the content as well. This can be used to create headers
with abbreviated text or even entirely different text than what appears in the

document! See page 32 for more information.

21. Global GREP Processors: Power Headers offers the option of creating
Global GREP Processors, which are applied to the entire header frame, as
opposed to only the individual header variables. Global GREP Processors
not only make it easier to set up GREP Processors for an entire document;
they also enable the creation of compound headers, where different vari-
ables can interact in very interesting ways. Please refer to page 38 for more

information.
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Examples of Use

To illustrate some of the unique capabilities of Power Headers we are includ-

ing some screen shots of actual production files which were created using

Power Headers. The illustrations are courtesy of Brad Walrod.

Two Line Header S
.. o AnTER six . . THE JOURNKY FROM DIATFORM .y
* * * NINEF AND THREF~OUARTERS *
“Don’t talk rubbish,” said Uncle Vernon. “There is no platform He was quite right, of course. There was a big plastic number
nine and three-quarters.” nine over one platform and a big plastic number ten over the one
“It’s on my ticket.” next to it, and in the middle, nothing at all.
You'll .
Were g One Line Header —S -
bother.”
“Why Al CHAPTER ONT i *e THT BOY WHO LIVED i
things fri
“Takil “You'd be stiff if you'd been sitting on a brick wall all day,” said “No, thank you,” said Professor McGonagall coldly, as though
to have d Professor McGonagall. she didn' chink chis was the moment for lemon drops. “As I say,
“All day? When you could have been celebrating? T must have even if You-Know-Who has gone —”
Harry passed a dozen feasts and partics on my way here.” “My dear Professor, surely a sensible person like yourself can call
and nervd Professor McGonagall sniffed angrily. him by his name? All this “You-Know-Who' nonsense — for eleven
because “Oh yes, everyone’s celebrating, all right,” she said impatiently. years 1 have been trying to persuade people to call him by his
robes —; “You'd think they'd be a bit more careful, but no — even the Mug- propername: Voldemort.” Professor McGonagall flinched, but Dum.-
again to gles have noticed somethings going on. Tt was on their news.” She bledore, who was unsticking two lemon drops, scemed not to no-
was shut jerked her head back at the Dursleys’ dark living-room window. “I tice. “It all gets so confusing if we keep saying ‘You-Know-Who. [
the Durs] heard it. Flocks of owls .. . shooting stars. . .. Well, they're not have never scen any reason to be frightened of saying Voldemores
had been] completely stupid. They were bound to notice something. Shoot- name.”
Dudley i ing stars down in Kent — PIl bet that was Dedalus Diggle. He “I know you haven't.” said Professor McGonagall, sounding half
They | never had much sense.” exasperated, half admiring. “But you're different. Everyone knows
Harry's ¢ “You can't blame them,” said Dumbledore genely. “We've had you're the only one You-Know- oh, all right, Valdemort, was fright-
Harry d precious litcle to celebrate for cleven years.” encd of”
dead, fag “I know that,” said Professor McGonagall irritably. “But that’s “You flatter me,” said Dumbledore calmly. “Voldemort had
“Well, no reason to lose our heads. People are being downright careless, powers T will never have.”
placform out on the streets in broad daylight, not even dressed in Muggle “Only because you're 00 — well — nble to use them.”
t0 have b clothes, swapping rumors.” “Its lucky ic's dark. T haven't blushed so much since Madam
She threw a sharp, sideways glance ac Dumbledore here, as Pomfrey told me she liked my new carmuffs.”
though hoping he was going to tell her something, but he didn’, so Professor McGonagall shot a sharp look at Dumbledore and
she went on. “A fine thing it would be if, on the very day You- said, “The owls are nothing next o the rumors that are flying
Know-Who scems to have disappeared at last, the Muggles found around. You know what everyone’s saying? About why he's disap-
out about us all. I suppose he really has gone, Dumbledore?” peared? About what finally stopped him?”
“It certainly seems so,” said Dumbledore. “We have much to be It seemed that Professor McGonagall had reached the point she
thankful for. Would you care for a lemon drop?” was most anxious to discuss, the real reason she had been waiting
“A whar?” on a cold, hard wall all day, for neither as a cat nor as a woman had
“A lemon drop. They're a kind of Muggle sweet I'm rather she fixed Dumbledore with such a piercing stare as she did now. It
fond of” was plain that whatever “everyone” was saying, she was not going

Shown above is a screen shot from the 10th-anniversary edition of Harry
Potter and the Sorcerer’s Stone. Some chapters feature two line headers.
Power Headers makes it possible to create these automatically, with only one

header definition for all the chapters.
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The illustration below shows the combined capabilities of the Smart Title
Case and the ability to automatically copy local formatting to the header
text. Note especially, the different capitalization on the two uses of the word
“the” in the Smart Title Case at the bottom of the page.

(b)
FIGURE 10.5 Homo rudolfensis
This fossil hominid is believed by some researchers to be a separate species from Homo habilis, owing to its larger size.

general body plan and overall morphology (bigger brains, smaller faces), here the
two species are discussed as Homo habilis.

As Leakey and his associates recognized, H. habilis differs in its anatomy from
the robust australopithecines dating to about the same time in East Africa and South
Africa. Australopithecus boisei had an enormous chewing complex—its back teeth,
jaws, and face were very large—but it had a small brain. In sharp contrast, H. ha-
bilis had a smaller chewing complex and a larger brain. Combined, the reduced
chewing complex and increased brain size gave H. habilis’s skull a more rounded,
or globular, appearance. Most anthropologists agree that these attributes indicate
that H. habilis began the lincage leading to modern humans.

Still unconfirmed is the identity of H. habilis’s immediate ancestor. The anthro-
pologist Tim White’s morphological comparisons between H. habilis and the earlier
australopithecines suggests that the ancestor was Australopithecus garhi, because
its face, jaws, and teeth are most similar to H. habilis’s. White suggests that the
evolutionary transition took place sometime around 3.0-2.5 mya.

Italicized Words All Caps Source Text

Olduvai ®/
Gorge &

HOMO HABILIS:JHE FIRST SPECIES
OF THE GENUS HOMO

For many years, Homo habilis was known from just skulls and teeth. Anthropolo-
gists had no idea what the rest of the skeleton looked like. Excavations at Olduvai
Gorge in the 1980s by Donald Johanson and his associates led to the discovery
of a very fragmentary, but important, skeleton of H. habilis, known as “OH 62.”

TANZANIA . |
7 2

Homo Habilis: The First Species of the Genus Homo 307

_

Italics Formatting Retained at

Destination Font Weight Text Converted to Smart Title Case
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Installation
Power Headers was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 44.

All the necessary components of Power Headers are installed in a single step

by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

(o NeNé) ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INylools.com
Package Name Action Size

@ Introduction T InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
8 Read Ma ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )

A

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

It is recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Next = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick 'Next', If you would like to select a different folder, dlick 'Browse'.

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!tools.com

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:

=
P it arL AutoFlow Pro Activated 18

Column Flow Activated 1.0.7

) Style Utilities Activated 1.0.8
- Proper V1 Activated 1.0.6
Gt Help Reflective Objects Activated 105

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7

Story Cantrol Activated 1.0.7

Drop Words Demeo: 23 days left FActivate 1.0.5

Drop Words creates “drop werds” commanly used In classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

Connecting to In-Tools Website. Please wait...

When it does, you will need to restart InDesign.
Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@In-tools.com Password: Fdk HEHEEEE

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.



http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Basic Use

Conceptual Introduction:
Power Headers works on a principle of “building blocks”. Each variable defi-
nition can be one element in a string of header text. Header text can be com-

posed of any number of header variables, as well as static header text.

For example: Your header text can be composed of [Author] [Book Title]
[Chapter] [Chapter Number] [Chapter Name] [Page number]. These can
all be in the same text frame, and you can mix and match InDesign standard

variables, Power Headers variables and static text all in the same text frame.

Setup

Preparing Your Document

Before you create your header variables, you should follow these steps:

1. Create a text frame on your document master page. Your header text

will be placed in this frame.

2. Select the frame and select InTools > Power Headers > Label Header

Frame..., or right ifa'ed Power Headers |2 Add Variable >
Reflective Objects » Label Header Frame
3. [ labelthe Headerframe | Type in (or select) alabel for you header
Header Frame %) € ok ) frame. The name of the label is unim-

portant, but it should be something
which you will be able to identify later.

Once you label your header frame, a little label box will appear on the bot-
tom right corner of the frame. You can turn off the visibility of
this label by selecting: View > In-Tools > Hide Header Frame Labels.
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4. Create a character style with the correct styling (if any) for your variable
header text. It is advisable to name it something which includes “header” or
something similar.

Now you are ready to create your header variable.
Points to keep in mind when setting up your headers:

i Don’t Confuse the concepts of Header Frame Labels and
Header Variables. Simply labeling a header frame will not
define a header. Labeling a header frame will only allow
the selected frame to contain the header which you will
define in the next step.

nmp-  If you have more than one header frame on the page (each with
a different label), and don’t have any special styling for the
header text, (which can’t be set on the paragraph level), one
character style can be used for all the headers provided that
there is only one variable per frame!

nmm  You do not need to define more than one header label even if
you are defining more than one header variable. The only rea-
son why you might want to create more than one header label,
would be to prevent header frames from being overridden
from master pages unnecessarily, or to use the same charac-
ter style in multiple variables. In fact, to avoid confusion, we
recommend not defining more than one Header Label unless

absolutely necessary.
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Creating Your Variable Definitions

There are many options when defining header variables, but the defaults
should be correct for most uses. Assuming the defaults are correct, there
are only a few things which need to be selected. The functionality of Power
Headers is the same in CS2, CS3 and CS4, but the user interface is enhanced
for increased usability in the CS3 and later versions. Below are screen shots
of the user interface for both CS2 and CS3/ CS4.

CS2

Define Header Variable

Variable N: ¢ Header 1 *Variable* Style: [ 4
‘ariable Name: Header ariable* Style ¢ Header H-i
Header Frame Label: | Header Frame )—ﬂ
Source Char. style: | Any )—‘p’ ] Copy Local Formatting
Source Para. style: | Section Header H—i E Italics at Base Weight
S| R [ 4
ource Range ¢ Page H TotBture:
T i g
ype ¢ First Instance H Text After:
F QOrd i i
ek > s L H Text Between/Conditional:
Ch: Case: 4-
angsiiase 5 Nolg g H Conditional Text: (&) After
T T = =
Punctuation: | Remove Trailing White Space H () Before
Options:
@ Only Include on Pages with source style Include Conditional Text: ¥ When No Source is on Page
(D Include Last Instance on Pages without source style ™ When Next Source is on Page
() Include Last Instance on Pages without story text

More Options: Ignore Stories Less Than 100 Characters
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CS3/ CS4

— Variable Definition

Variable Style: [ header H
‘ Variable Name: Header Frame Label: [ header I-G-‘
— Source Styles
Source Char. Style: [ Any H ( Alternate Styles... ) ( Resetting Styles... )
Source Para. Style: [ Header H ™ Don't Transfer Text
— Settings:
Source Range [ p C
e age H Text Before:
Type: [ First Instance =
Frame Order: [ Top,Bottom,Left,Right H Teock After:
Change Case: [ No Change H Conditional Text:
Punctuation: [ Remove Trailing White Space H () Before (@) After

"1 Copy Local Formatting ¥ Italics at Base Weight [ Copy Paragraph Numbering

glgnore Blank Paragraphs M Limit Instances to One Paragraph

— Options:
Include Conditional Text

O Only Include on Pages with source style SWhen (M5 e i e B

(O Include Last Instance on Pages without source style ; .
v When Next Source is on Page

® Include Last Instance on Pages without story text

— More Options: @
Ignore Stories Less Than 100 | Characters GREP Processors...
Close

As you can see, the layout of the dialog is somewhat different between the
two versions, but most of the options are basically the same. There are some
options which are specific to CS3 and later. These will be discussed later in

the manual.
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Basic Setup
There are four basic things which must be chosen while setting up the vari-

able.

1. variable Name: [Header 1 Name your variable: Type into this field the name
of your variable. What you name it is unimportant. It should be whatever

name is easiest for you to identify.

2. variableStyle: (Header [3) Pick your variable style: In the drop down list
shown, select the character style which you set up in step #4 in the previous

section, “Preparing Your Document”

3. HeaderFrame Label: (Header... [3) Select your header frame label: The drop-down
list contains all labeled frames on your document master pages. Select the

label you used in step #3 in the previous section.

Note: If you labeled a frame on a regular page (i.e. not a master page), that label
will not show up in the list. You can use frames on regular pages, but you must
label a frame on a master page somewhere with the same label. The master page

does not need to be used.

nmm  Header frame labels are not required. The headers can be set up
without them. It is however, advisable to use them. There are
four reasons for using the labels:  1: The updating of headers
is quicker when labels are used.  2: If labels are not used, it is
necessary to override all master frames for the headers to prop-
erly update. This makes a mess of your pages. 3: The use ofla-
bels allows for semi-automatic removal of overrides on header
frames. 4: The labels enable the use of just one character style

for any number of header frames.
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4, | B Pick your source styles: The

Source Para. style: [ Section Header '%) source styles are the applied

styles in the text which will be picked up to be copied to your header (i.e. the
text which will “fill” your variable text). You must select a style. It can be either
a paragraph style, a character style, or both. If you select both a paragraph
style and a character style, then text will be applied to your header, only if you
have the selected character style within the selected paragraph style. If the
character style is applied to text in a different paragraph, the text will be ig-
nored. Please note: Characters are only found if the character style is applied di-
rectly. Styles applied through nested styles will not be found.

Congratulations! You have succeeded in setting up a basic header. If you
have properly followed all the steps, and inserted a header variable in some
text (page 34), when you select InTools > Power Headers > Update Docu-
ment Headers, the headers will be updated to reflect the page text.

Additional Settings:

While the default settings for headers might fit your needs, it is very prob-
able that they won't. The options for updating the headers are very powerful
and very easy to set up, but it does require some understanding of what each
option does. Below is a list of all the selectable options, and instructions on
how to use them.

1.  Source Range | Ppage I4) Source Range: This option al-

» «

lows definition of “Page Headers”, “Spread Headers”, or “Column Headers”.
Page Headers will find instances on the same page only, Spread Headers will
find instances on the whole spread, and Column Headers will find instances
in the same column as the header. The columns are defined by column

guides; any part of a text frame which falls inside the vertical bounds
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defined by the column guides will be defined as belonging to that column. If
a text frame spans more than one column, all header frames in those col-
umns will reflect that text. If a header frame spans more than one column,
the header text will reflect the last column of that span (i.e. the first or last

instance of the last column.

2. Type: [First Instance %) Type: This drop down list has seven op-

tions: 1: First instance: This option finds the first instance of your selected
style on the page. 2: Last Instance: This option finds the last instance of
your selected style on the page.  3: First word: This option finds the first
word on the page with your selected style applied.  4: Last word: This op-
tion finds the last word on the page with your selected style applied.  S:
First and Last Instance: This option inserts both the first and the last in-
stance of the selected style on the page into the header placeholder. When
selecting this option you should select the text which goes between the two
instances in the “Between” field (see setting #7 on page 25). If the headers
are selected to run also on pages without source text (see setting #16 on
page 29), the last instance will be used on following pages. 6: Current In-
stance: The text inserted in the header using this option depends on where
the source content is located. If there is no source text found, the header will
show the last found instance. If there is source text found but it is not in the
first line of text on the page, the last found instance will also be used. If there
is source text in the first line on the page, or the text is anchored to the first
line, the found source text will be used. 7: Current and Last Instance: This
option combines the “current Instance” with the “last instance” The “text
between” option in “Current and Last Instance” is similar to the “text be-
tween” option in “First and Last Instance”. 8: All Instances: This will fill the

header with all instances on the page.
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Please Note: Transferring formatting will not work on All Instances if punc-
tuation removal is selected. If you need to transfer formatting and remove
punctuation on all instances, you should remove the punctuation using
GREP Processors instead. Please see page 32 for an explanation of GREP
Processors.

nmm  The first and last instances can span more than one paragraph.
This offers the ability to create multi-line / multi-paragraph
headers. Using the appropriate “Remove Punctuation” option
(see setting #S on page 24), multiple paragraphs can be com-
pressed into one, or be left as separate paragraphs. However,
care must be taken when applying styles to ensure that more
text than intended is not copied to the header.

3. FrameOrder: [Top,Bottom,Left Right %) Frame Order: This option sets the
search order for the text. The search order determines what is considered

the “first instance/word” and what is considered the “last instance/word”
Since this setting is set on the individual variable level, you can have more
than one such setting per document. This is especially useful when laying
out multi-lingual books in which some of the text is right-to-left, and some
is left-to-right. There are four frame order options:  1: “Top, Bottom, Left,
Right”.  2: “Top, Bottom, Right, Left”.  3: “Left, Right, Top, Bottom”.  4:
“Right, Left, Top, Bottom”.

The diagram on the left illustrates four text frames on
A c apage. Ifoption 1 is selected, the search order will be
“A, B, C, D" If option 2 is selected, the search order
will be “C, D, A, B”. If option 3 is selected, the search
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order will be “A, C, B, D”. If option 4 is selected, the search order will be “C,
A,D,B’

4.  Change Case: [ No Change i) Change Case: These settings give

you the option to change the case of the words which are inserted into your
header. The options are fairly straight-forward. The choices are: “No Change”,
“UPPER CASE’, “lower case”, and “Title Case”. Except for “Title Case”, they

are self-explanatory.

“Title Case” works intelligently. This means that only words which are “sup-
posed to” be capitalized in a title are capitalized. There are two word lists to
allow you control over this behavior. The word lists can be edited by bring-
ing up the preference window. Please refer to page 35 for information on

how to access the preference dialog.

nmm>  The word lists should always be edited using the dialog. The
word list files should never be edited directly. For Smart Title
Case to work correctly, the word lists must be sorted in a spe-

cific way, and the dialog ensures that it is.

The rules which the title case uses are as follows:

The first and last words are always capitalized, as well as any word follow-

< /»

ing a period (full stop) or colon. Any compound word separated by a “/”,

“»
*)

tor capitalized. Any other word will be capitalized unless it appears in the

dash or m-dash will have the letter immediately following the separa-

lowercase word list. Any word appearing in the list will be lowercase only
if it is not a “starting” word. For example: In the title, “The Last of the Mo-
hicans’, the first word “the” will be capitalized, while the second time “the”
appears will not. This is because the first word is the beginning of the sen-

tence. Similarly, in the title, “Lion: The King of the Jungle”, the first word
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“the” will be capitalized because it follows a colon. The lowercase word list
can be edited to include any words you like. All words should be separated
by a single space.

Any word appearing in the “special case” will always be capitalized exactly
as it appears in the file, regardless of position. This is useful for words like
“InDesign”, “USA”, “UK, etc., which have capitals in the middle of the word.
This file can also be used to force lowercase on specific words and override
the default rules. So, let’s assume you would like the word “a” to always be
lowercase, even if it is the first word in your header text. You would simply
put the word “a” in your special case list, and it will always be lowercase.
When a word appears in both lists, the special case list supersedes the low-

€rcase one.

S.  Punctuation: [ Remove Trailing White Space  [$) Punctuation Removal: Power Head-

ers offers a number of options for punctuation removal: 1: Don’t Re-
move. 2:Remove Trailing White Space.  3: Remove AllExtraSpace. 4:

Remove Trailing Punctuation.  §: Remove All Punctuation.

“Don’t Remove” does exactly that. It will remove nothing. This includes any
trailing returns you might have. If you select a paragraph style as your source
style, and select “Don’t Remove”, you will get a return after the header text.
This might be useful if you want a header which spans a number of lines, but
if not, your trailing static text in your header will likely “disappear” when it

gets overset by the extra return.

The default setting is “Remove Trailing White Space”. This is the most com-
mon need in headers. It will remove any spaces, tabs, returns, soft returns, or
what-have-you, which follow the found text.
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“Remove All Extra Space” will convert all of the above mentioned characters
to regular spaces. It will also convert double spaces to single spaces. So, if
you have two paragraphs which will both go into the header, and you need
them to become one, “Remove All Extra Space” will do that for you.

“Remove Trailing Punctuation” does everything “Remove Extra Space” does,

»

but it will also remove trailing punctuation. This includes “,2":;!

“Remove All Punctuation” will remove all extra spaces and all punctuation,

regardless of where it is situated.

If you need more specific character removal, make sure to read about GREP
Processors (page 32). GREP Processors allows for very precise processing.
6. Textefore: | | Text Before / Text After: These two fields are for

Teaafer [ text which should be inserted either before or af-
ter (or both) your variable text. The reason you might want to use this op-
tion rather than simply typing the text into your header frame, is that text
will not appear on a page which doesn’t receive variable header text. (See

setting #16 on page 29 about inclusion options.)

7.  TextBetween: Text Between: This option is to be used in con-
junction with the “First and Last”, “Current and Last”, and “All Instances”
options described in setting #2. This is the static text to be inserted between
the two, provided that there is two or more instances to be inserted into the

header. If there is less than two instances found, this text will be ignored.

8.  Conditional Text: Conditional Text: This option is available if
any type besides the ones which support text between is selected. It will replace
the “Text Before” or “Text After” in cases where the source text does not ap-

pear on the page. In the case that the “Current Instance” is selected, it will
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replace the “Text Before” or “Text After” on pages which have a found in-
stance, but is not on the first line (which causes the last instance to appear).
Both of these options are optional. (See setting #17 on page 29)

9. Osefore @after This option determines whether conditional text (set-

ting #8 above) replaces the “Text Before” or the “Text
After”.

10.  CJcopyLocal Formatting. Copy Local Formatting: This option should be
checked if you want local formatting to be copied to your header. The defini-
tion of “local formatting” depends on what kind of styles you selected as the
source styles. If you selected a strictly paragraph-based header (i.e. you se-
lected “Any” as the character style), local formatting will be defined as any
characters styled differently than the paragraph style. This can be through
character styles, or as local overrides. If however you selected a character
style as your source style, local formatting will be defined only as local over-
rides. Please note: Copy Local Formatting cannot be used together with Remove
All Punctuation. In the CS3 version it will not be selectable, and in the CS2 ver-

sion, you will get a warning.

11. ®alics at Base weight  [talics at Base Weight: This option is to be used in
conjunction with “Copy Local Formatting”. If this option is checked, and
your local formatting contains italics, the italics will be applied at whatever
weight you set your headers. This option assumes your font uses standard
naming conventions. It only works if “italics” is named as such. It will not
work for “oblique” or “tilted” or whatever other terms might be used. Some
fonts have a number prefix for different fonts in a family. Such named fonts
will not work either, because the names will not match. It also assumes that

the base weight is called “Regular”. If it’s called “Roman” or some other
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name, and the header is styled at that weight, it will not work either. It will
however work with fonts which have different optical sizes.

12. [ Copy Paragraph Numbering Copy Paragraph Numbering: If this option is
selected, any bullets and numbers applied to the source text will be copied
to the header. This includes any prefixes or suffixes. With this option select-
ed, the default behavior is to copy the text along with the paragraph num-
bers. If you need just the numbers, you can select “Don’t Transfer Text”
(setting #13 below).

13. [IDeon't Transfer Text Don’t Transfer Text: The main function of this option
is to complement the “Copy Paragraph Numbering” option. With this op-
tion selected, the found text will not be transferred to the header. Only Text
Before, Text After, Text Between/Conditional Text, and paragraph num-
bers and bullets will be transferred. If you need only the paragraph numbers

to appear in the headers, select this option.

nmm  There are some useful tricks made possible by the Don’t Trans-

fer Text option:

4 Smart use of conditional text can be used to insert custom
text using any conditions which can be defined in the condi-

tions options.

4 Variables are applied in order. This enables some very inter-
esting applications: Let’s say you want a header on any page
which (for example) doesn’t start a chapter, you can do this eas-
ily. It requires defining two header variables—both of which
should be defined with the style which starts your chapters. Set
the first variable to create headers on all pages. In the second

variable, set it to create headers only on pages with source text,
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but select Don’t Transfer Text. The second variable will effec-

tively erase the text created by the first variable!

14. ™ ignore Blank Paragraphs Ignore Blank Paragraphs: When there is a para-
graph with no text, you probably do not want it to be used for the source
text. This option will cause any paragraphs which have no printing charac-

ters to be ignored and not be considered a found instance.

This option is only accessible in CS3 or above. In CS2, the behavior will
always be to ignore blank paragraphs.

1S. #Limit Instances to One Paragraph Limit Instances to One Paragraph: When
the source text contains a span of paragraphs which all match the source
style, you have the option of choosing how much text will get transferred to
the header. If this option is selected, only the first or last paragraph (which-
ever is defined in setting #2)in the span will appear in the header. If the op-
tion is not selected, the entire span will be copied to the header. This can
result in a header with multiple paragraphs. The paragraphs can be short-
ened to a single paragraph using the punctuation removal options (setting
#5 above) or GREP processors (page 32).

This option is only accessible in CS3 or above. In CS2, the behavior will

always be to limit instances to one paragraph.

Please note: “Limit Instances to One Paragraph” can effect whether Power
Headers considers there to be more than one instance on a page. If the op-
tion is selected, the first paragraph will be considered the first instance, and
the last paragraph the last instance. If it’s not selected, and there’s one span

of many paragraphs found, there will be only one instance—of the whole span.
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16 ® Only Include on Pages with source style
* (D Include Last Instance on Pages without source style
(O Include Last Instance on Pages without story text  three inclusion OptiOIlS. The

Inclusion Options: There are

first option will only create header text if there is text on the page to transfer.
The second option will create header text from the last instance, provided
that there is a story on the page which has the style selected in the variable.
The third option will create header text from the last instance on every sub-
sequent page. The “Last Instance” can be either a word or a found instance,

depending on the header type.

17. FineudeConditional Text Conditional Text Options: In this section,
@When No Source is on Page

i : there are two check boxes. These check
v When Next Source is on Page

boxes define when the conditional text is
used (see setting #8 on page 25). If the first check box is selected (When No

Source is on Page), the conditional text is used on pages which have no

source text at all. The second check-box is for use in conjunction with the
“Current Instance” option. When “When Next Source is on Page” is selected,
and the “Current Instance” is selected, the conditional text will be used
when the previous instance is used and a source is found on the page (i.e. the

found source text is not in the first line of text).

18.  Ignore Stories Less Than ‘100 | Characters  imiting Story Size: This option ignores
stories smaller than the specified size. The purpose of the limit is to speed up
the updating of the headers. Setting this properly is extremely important! If
the number is set too high, your text can be missed. If the number is set too
low, and you have a lot of short stories (for example — side heads), updating

headers can take considerably longer!

Alternate StleS [ Alternate Styles... |
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This option is designed to deal with situations where there is more than one
style used in similar fashions. This enables any number of styles to be used
to define the header variable. The correct instance of any one of these styles

will produce header text.

The setup of the alternate styles is somewhat different between CS2 and
CS3 or later. In CS2, the alternates are defined using a menu item: InTools
> Power Headers > Define Alternate Style. The menu item needs to be
selected again for each alternate defined. In CS3 the alternates are defined
from within the variable definition dialog. Using this Button: ( Alterate styles )
in CS3 or CS4 will bring up a dialog which allows the creation and deletion

of alternates. In CS2, CS3, and CS4, choosing to create a new alternate will

R . . . . Alternate Styles
bring up a dialog which looks like this:
Character style: (Any ) | @00k
. . . Paragraph style: (Amy W) | Ccancal)
There are two drop-down lists in the dialog. . Comd

The options in the drop-downs are the same as the style definitions in the
main dialog. Any combination of character styles and paragraphs styles can
be defined as alternates. These settings can be set irrespective of the style
settings in the main dialog. The only limitation is that there must be at least

one style selected.

Resetter Styles (CS3 or later)
This option is only accessible in CS3 or above. Unfortunately, in CS2, there

is no way to reset the header, based on styles.

Resetter Styles offer a tremendous amount of control over which text will
appear in the header and when. When a Resetter Style is encountered, some
or all of the found style instances will be removed from the potential text
that the header may contain. Resetter Styles can be used in a lot of advanced

uses, but probably the most common use is in hierarchical headers such as
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the ones you see in this manual, where there is main header text followed
by sub-header text—but only if applicable. When a new section starts, the
sub-header text from the previous section must be removed, as well as any

instances on the current page prior to the start of the current section.

Resetter Styles are defined within a specific variable by clicking on the “Re-
setter Styles...” button.

%

Style List @
resetter [ Cancel )
(_ New )

You can define an unlimited number of Resetter Styles, and each Resetter
Style can have different settings. To create a new Resetter Style, click “New”.
To edit an existing one, select the desired Resetter Style and click “Edit” or
double click the selection. To remove a Resetter Style, select the style you
wish to remove and click “Delete”.

As with the other source style options of Power Headers, Resetter Styles can

be selected as either paragraph styles, character styles, or both.

Name: |Resetter ] @
S Cancel
Character Style: [ Any H
Paragraph Style: [ Saction Header (Header Styles) =

Options
Current Page: [ Only use instances AFTER FIRST reset s... H-‘
Reset After Page: [ Only use instances AFTER ALL reset sty... | &)
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There are two basic functions for Resetter Styles: Limiting the range on a

current page, and removing header text which was picked up on a previous
page.
For the current page, there are five options:

v Don't Reset

Only use instances AFTER FIRST reset style.

Only use instances BEFORE LAST reset style.

Only use instances AFTER ALL reset styles.

Don't use any instances on pages with reset styles

1: “Don’t Reset” will do nothing.  2: “Only use Instances AFTER FIRST
reset style” will cause Power Headers to discount any instances on the cur-
rent page before a Resetter Style.  3: “Only use Instances BEFORE LAST
reset style” will cause Power Headers to discount any instances after the last
Resetter Style on the page. 4: “Only use Instances AFTER ALL reset style”
will cause Power Headers to discount all instances each time a Resetter Style
is encountered for the current page. 5: “Don’t use any instances on pages
with reset styles” will cause Power Headers to discount all instances if a Reset-

ter Style is encountered anywhere on the current page.
For following pages there are three options:

Don't Reset
¥ Only use instances AFTER ALL reset styles.
Reset style erases all instances on the same or previous page.

1: “Don’t Reset” will do nothing. ~ 2: “Only use Instances AFTER ALL
reset style” will cause Power Headers to discount all instances each time a
Resetter Style is encountered on a previous page. 3: “Reset style erases all
instances on the same or previous page” will cause Power Headers to blank

out the headers after any page that Resetter Style is seen.

GREP Processors (CS3 or later)
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GREP processors offer a tremendous amount of flexibility in controlling
the content and formatting of your headers. They can be used to style part
of your header with a specific character style. They can be used to add or
remove parts of your header according to your specific needs. Clicking the

GREP Processors button will bring up the following dialog:

GREP Processors
GREPs m
Periods to Smileys

You can add as many GREP Processors to your variables as you like. Click on
the New button to create a new GREP Processor, the Edit button to change

an existing one, and the delete button to remove the selected one.

GREP Processors utilizes features that were not available in InDesign prior
to CS3, and therefore is only available in CS3 or above.

Clicking the “New” or the “Edit” button will bring up the dialog below. In
the dialog, there are two required settings: the GREP Name, and the Find
contents. If the Change contents and Character style are both left blank, the
GREP Processor will remove the specified GREP query from the header. If
the Change field is filled, in, the found text will be replaced with the change
text, and if a character style is selected, the style will be applied. Any GREP
which InDesign accepts in the Find/Change dialog, is acceptable for GREP

Processors as well.
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- BEees

Crep Name: | periods to Smileys

Find: |y, { OK ,
change: (E634 ]
Character Style: | No Style =)

Please Note: GREP Processors are applied in the order that they are defined.
There are times that the order of the GREPs can effect the end results, so

take care as to which order they are defined.

If you need GREP Processors to be applied to all variables, you can create
Global GREP Processors (page 38).

Inserting Header Variables

AutoFlow Pro P N |
Power Headers » Add Variable » Section Header
Reflective Objects » Label Header Frame Sub-Section

Once a header variable is defined, the variable can be inserted into a text
frame by right-clicking in a header frame which is labeled with the correct
label. If the variable is defined without a header label assigned, the variable
can be inserted in any text frame. The variable will replace the selected text.
Creating the variable will automatically apply the correct style and wrap the
variable in xml tags. If the tags are visible in the view preferences, there will

be a visual indication of where the header variable starts and stops.

If the text frame is not labeled with the correct header label, no header vari-
able will be inserted.
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Updating Headers

Power Headers does not work dynamically. This means that updating head-
ers is required after the initial setup, and then again after each re-flow of
text which could affect the header content. It is however, very easy to up-
date them. Simply select “InTools > Power Headers > Update Document

Headers”. This will update all of your defined header variables.

Automatic Updates

There are certain times when the headers can be automatically updated to
help prevent mistakes. There are three main triggers for this: 1) When a doc-
ument is saved. 2) When a document is printed. 3) When Header Frames

become detached from a master page, or become doubled up.
There is a preference dialog for controlling the behavior in each of these
three situations:

Power Header Preferences

— Update Document Headers I)

On Save: [ Confi | ( 1Y
onhrm Cancel )

On Print: [ Confirm

ar| |an| |a»

When Header Frames Reset: | Don't Update |

— Edit Case Exceptions

(" Edit Lowercase List ) [ Edit Special Case List B

"I Save as Application Defaults

For each of these three situations, you can decide to either update without

warning, update after a confirm, or not update.
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If the “Save as Application Defaults” check-box is selected, the updating
preferences will be saved as the default for the application. The application
defaults will be used unless specific preferences are set on a specific docu-

ment.

Header Frame Overrides

When Power Headers updates the header text, any header frames which
reside on master pages are automatically overridden. This means that the
frames which started off being on the master page and were not editable,
become located on the individual pages and are editable like any other text
frame. This is analogous to command/control-shift-clicking on a master
frame.

This can become an issue when re-flowing pages, and especially when ap-
plying master pages. When applying a new master page to an existing one,
any overridden master page items get completely detached from the master
page, and if the item exists on both masters, you wind up with double items.
This is particularly an issue with header frames. When the duplicate frames
appear on the page, both copies would get updated by Power Headers. Power
Headers solves this problem by automatically removing the original mas-
ter frame when frames become doubled up. Additionally, when the master
header frame is edited, the overridden master frame on the local pages will

be automatically updated on the next update of Power Headers.

There is a menu item: “Remove Overrides on Header Frames...” under the
Power Headers menu. This will return the (chosen) header frame on selected
pages to the master page (and will revert any variable header text to the de-
fault master text). This option was included in the original release of Power

Headers because it lacked the automatic removal of master frame overrides.
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Power Headers as of version 2.0 will automatically remove overrides when
necessary, so this menu item should not be needed under normal circum-

stances.

Stacking Order and Groups

When overriding master page objects in InDesign, the stacking order can
be affected. This is because master page items are always below regular page
items. When master page items are overridden, they become regular items,
which sometimes causes changes in the stacking order. The exact behavior
was changed between CS2 and CS3. In CS2, all items when overridden are
moved to the top of the stacking order, while in CS3 they are kept on the
bottom of the stacking order. When overriding master header frames, Power
Headers always overrides them in the order in which the header variables

are defined.

If the stacking order of header frames is important, it can be handled in one
of a few ways: 1.  Place the header frames on different layers. Objects on
different layers keep their stacking order when overridden. 2.  Group the
frames. If a header frame is grouped with other objects, the entire group will
be overridden together. When removing overrides on the header frames,
the entire group will be returned to the master page as well. 3. Make sure
to define the header variables in the order which will keep them stacked
properly: For CS2 this would mean defining the bottom-most one first. In
CS3, the top-most one should be defined first.

Please note: Overridden header frames should not be grouped or ungrouped
on local pages. If they are not kept in their previous “grouped state”, remov-

ing overrides may not work correctly.
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Global GREP Processors

Besides the variable-specific GREP Processors, it is possible to define Glob-
al GREP Processors. The difference between the two, is that the variable-
specific ones are only applied to the text of the specific variable, and at the
time the variable is created. Global GREP Processors will be applied to the

entire header frame. They are applied after all variables are updated.

One example of a very powerful application of Global GREP Processors is
“compound headers”, for example, you can create a header which can contain
[Chapter 1, Verse 1 — Chapter 2, Verse 7] or [Chapter 1, Versel — Verse 11],
depending on the content. To define such a header, you would create two
header variables as First and Last (or Current and Last) Instance. For the
Text Between of the Chapter Header, you'd use some uniquely identifiable
text, and create a GREP query to remove the text between and reorder the
position of the last instance of the chapter header to between the two in-

stances of the verse header.

Book Files
Headers can also be run on all documents in a book file. To run the headers

on a book file, both the book file and any single document must be open.

Running headers on book files is a two step process. First the header vari-
ables must be synchronized across all the book files. The defined master
document is used for the definitions. To synchronize the variables, select
InTools > Power Headers > Synchronize Book Variables. Once the book
documents all have their header variables defined, all that needs to be done
is select InTools > Power Headers > Update Book Headers. This process

updates all the book files, but doesn’t save them. Rather, it leaves them all
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open so you have the option of reviewing the changes before saving and

closing the files.

Loading Header Variables

Once you define variables in one document, those variables can be loaded
in another document as well. To do so, select: InTools > Power Headers >
Load Header Variables... You will be presented with a dialog to pick a docu-
ment. Once you select a document, the variable definitions in the source

document will be loaded.

Please Note: If you have more than one style in your document with the
same name, the variables might not be loaded correctly, so please try to keep

your style names unique.

Scripting

Most of Power Headers’ functionality can be accessed via scripting. Scripting
access to Power Headers is provided by sending custom events to the plug-
in. To do this you must first get a reference to the Power Headers plug-in.
This is done using the loadedScriptedPlugins document method. The load-
edScriptedPlugins method returns an Array. Therefore, to create a variable

which references Power Headers you'd write:

ExtendScript Code:
var powerHeaders = myDoc.loadedScriptedPlugins("powerheaders")[0]

AppleScript Code:
tell myDoc

set powerHeaders to item 1 of (loaded scripted plugins label "powerheaders")
end tell
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Visual Basic Code:
Set powerHeaders = myDoc.LoadedScriptedPlugins("powerheaders")[1]

Once you have a valid reference to Power Headers, you simply tell Power
Headers to handle a custom event:

ExtendScript Code:
powerHeaders.handleScriptEvent (eventCode:String,[eventData:String],[delay:
integer]);

AppleScript Code:
tell powerHeaders

handle script event event code (String) [event data (String)] [delay (Integer)]
end tell

Visual Basic Code:
powerHeaders.HandleScriptEvent (eventCode:String,[eventData:String],[delay:
integer])

In the above code, the event code is the custom event which you tell Power
Headers to handle. The event data is the data sent to the event handler, al-
though not all events require event data. The delay in milliseconds is when
the event is sent. This argument is totally optional. If left out, the event will
be sent immediately. If it’s 0, it will be sent when InDesign becomes idle.

Otherwise it will be sent after the specified delay.





Scripting /

Event Codes
Below is a list of acceptable event codes along with the description of what

they do and the required event data (if any):
Please Note: The event codes and event data are case sensitive.

Please Note: The loadedScriptedPlugin property is a child of a document. The
event will be handled in the document containing the loadedScriptedPlu-

gin specified.
Event Code Description Event Data
externalDisableHeaders | Temporary disables Power N/A

Headers for the parent
document of the specified
plugin. This is useful for
making a script run quicker.

Example in ExtendScript:
powerHeaders.handleScriptEvent ("externalDisableHeaders");

externalEnableHeaders | Re-enables Power Headers N/A
functionality after it has been
disabled.

Example:

powerHeaders.handleScriptEvent ("externalEnableHeaders");

externalRunHeaders Causes Power Headers to N/A
update all header variables in
the document

Example:
powerHeaders.handleScriptEvent ("externalRunHeaders");

externalLoadHeaders | Loads Power Header variables | String of the fullName
from a different document of the source
document
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Event Code | Description | Event Data

Example: (given a reference to a File object of the source file)
myFileName = String(myFile.fullName)
powerHeaders.handleScriptEvent ("externalLoadHeaders", myFileName);

externalLabelFrame Gives a Header Frame a label Comma separated
string of two items:
the text frame id and
the Header Label

Example: (given a text frame with an id of 291)
powerHeaders.handleScriptEvent ("externalLabelFrame","291,Header Frame");
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Sample Script
Below is a sample Javascript which will update all Power Headers variables in

the current document:

var doc = app.documents[0];
var powerHeaders = doc.loadedScriptedPlugins ("powerheaders")[0];
if(powerHeaders){// if Power Headers is not loaded, the item will be undefined
powerHeaders.handleScriptEvent ("externalRunHeaders");
} else {
alert("Power Headers is not loaded!");

¥
Here’s the same script in AppleScript:

tell application "Adobe InDesign CS4"
set theDocument to active document
tell theDocument
set powerHeadersPluginList to loaded scripted plugins label "powerheaders'
if length of items of powerHeadersPluginList is greater than 0 then
set powerHeaders to item 1 of powerHeadersPluginList
tell powerHeaders
handle script event code "externalRunHeaders"
end tell
end if
end tell
end tell
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Script Labels

APID, (and in turn Power Headers) makes extensive use of script labels for
tracking objects. If you must use script labels on text frames, ideally you
should use private labels (used with the insert label and extract label meth-
ods). If you must use the public labels you should append the existing labels
instead of simply replacing the existing ones. Otherwise you stand the risk
of trampling Power Headers settings specific to text frames.

In other words, always use:

myTextFrame.insertLabel("myCustomLabel")

or if absolutely necessary:

myTextFrame.label = myStoryOrPageltem.label+"myCustomLabel"

instead of:

myTextFrame.label = "myCustomLabel"

Cookbook

For some examples of how to use Power Headers, please refer to the Power

Headers forum.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s



http://in-tools.com/learning/forum/power-headers/

http://in-tools.com/learning/forum/power-headers/
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version of Javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic, it
requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for
the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement

License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the




http://in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, ORAS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Department’s list of Specially Designated Nationals or the U.S. Commerce
Department’s Table of Denial Order. By downloading or using the Software, you are
agreeing to the aforementioned and you are representing and warranting that you are
not located in, under the control of, or a national or resident of any such country or on

any such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect






Viar'7) el s L= 07 L=

to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. In-Tools may immediately terminate
the Agreement if you breach any representation, warranty, agreement or obligation
contained or referred to in this Agreement. Upon termination, you must dispose of the
Software and all copies or versions of the Software by destroying the Software. In-Tools
reserves the right to modify the Software at any time without providing notice to you.
In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT, AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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What'’s A Reflective Object?

The need for reflective objects might not be apparent at first, but we are con-
fident that once you start using them, you will not know how you worked

without them!

Simply put: a reflective object is any page item which keeps its page position

relative to the spine (whether it’s a text frame, graphic, etc.).

Even guides can be set as reflective, so you don’t need to create separate mas-

ters just because you need a different set of guides in part of your document.

But Who Needs Them?

When laying out documents with facing pages, design elements which have
a distinct position relative to the spine are usually present. For example, look
at the placement of the number tabs in this manual. While in many situa-
tions, creating design elements on master pages is ideal, often it is not. A

primary example is master text frames.

The problem with these elements become apparent when pages are added
or removed. Very often a recto page becomes a verso page or vice versa.
This causes the layout to become reversed. Correcting these pages can be
an extremely time consuming process! Defining these objects as “reflective”

causes them to take a mirrored position when the page changes sides.

To illustrate this point, we are including two screen shots of a document
which uses Reflective Objects for positioning graphic elements in the side bar
area. In this document, these elements couldn’t be created as anchored ob-
jects because of the text wrap applied to many of them. When the top right

page was removed from the figure on the left, the layout on all the following
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pages was automatically adjusted as shown in the figure on the right. A spe-
cial thank you to Brad Walrod for providing these illustrations.
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Another use for reflective objects is simplifying symmetrical design. Design

elements which appear in symmetrical positions on both recto and verso
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pages only need to be created once. After creating them on one side, they
can be copied to the facing page en mass, and each object will take an oppos-
ing position to its original! The page number tabs and headers in this manual

for example, were created using this method.
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Installation
Reflective Objects was developed using a product called “APID ToolAssis-

tant” created by Rorohiko. This necessary central controller does alot of the
low-level processing. If you are interested in the technology behind the develop-
ment, you can read the addendum on page 19.

All the necessary components of Reflective Objects are installed in a single

step by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install
S NO ‘s Install Publisher Suite
N E l. Custom Install on "Macintosh HD”
INylools.com :
Package Name Action Size

® Introduction U InDesign C53 Install 5.3 MB
e ™ InDesign C54 Install 5.8 MB

Tl # InDesign €55 Install 5.5 MB
& License ™ Documentation Install 11.8 MB
© Destination Select
B Installation Type
® Installation
® Summary

Space Required: 28.3 MB Remaining: 56.23 CB
( Go Back ) ( Continue )
Vi

On Macintosh you will be offered the option to install on CS3, CS4, or CSS

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nnw»- Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign C54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick 'Next'. If you would like to select a different folder, dick 'Browse'.
C:\Program Files (x86)\Adobe\Adobe InDesign C54] Browse...






Reflective Objects
IKGlLIeCinGe OpPilecg=2

Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

ek

lin!tools.com

m Plugins
Product Status Latest Version
ﬂ World Tools Activated 0. 1.0.5 Update
Fead el AuteFlow Pro Activated e 1.0.8

Column Flow Activated 0. 1.0.7

Style Utilities Activated .0, 1.0.B
Froper V] Activated 0. 1.0.6
Reflective Objects Activated 0. 1.0.5

Power Headers Activated -0, 2.0.5

Side Heads Activated 0. 1.0.7

Story Control Activated 0. 1.0.7

Drop Words Demo: 23 days left FActiugte 0. 1.0.5

Drop Waords creates “drop words”™ commanly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-

ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes. _

When it does, you will need to restart InNDesign. | " comecing o 1ntoos webste. pesse wot.
Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: sales@in-tools.com ET T H EXEXEXEERE

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

Euy

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Okay. So, How Do I Use It?

Basic Application of Settings:

Il Heip - xE

APID ToolAssistant... N B (8 "
AutoFlow > 3 .-
Column Flow >
Drop Words >
Formatting Tools |
Multilingual Tools L.
Reflective Objects > Remove All Reflective Settings
Side Heads > Reflect Position
Story Tools > Reflect Shape
| Reflect Content

e | Reflect All

©w st Configure Reflective Defaults...

W W%emw== Define Reflective Style...

Deactivate Reflective Objects
| Activate Reflective Objects
T e s Trigger Object Reflection

Using Reflective Objects is very easy. Objects can be set either by selecting the
menu command, or by right clicking, and selecting from the context menu.
Simply select an object (or multiple objects), and select InTools > Reflec-

tive Objects > Reflect Position. Removing settings are done the same way.

Using Reflective Objects:

Once an object is set to reflect, it can be moved around like any other object.
The plug-in works in the background keeping track of its position. If the ob-
ject is moved to an opposing page—either manually, or by adding/remov-
ing pages — it will immediately jump to the correct position. The same is

true for objects which are copied and pasted.
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nnm>  If you want to get some design elements temporarily out of the
way, but you don’t want to lose their position, do the following:
Set the objects as reflective, and then drag them to the paste-
board. When you move them back to the page, each object will

automatically take its original page position.

Other Settings Options:

You might have noticed some more reflective options: Besides setting ob-
jects to keep their reflective position, they can be automatically flipped. The
four reflective settings are as follows: Reflect Positions keeps the position.
Reflect Shape will flip the frame but not the content. Reflect Content will flip
the content but not the frame. Reflect All will flip both the frame and the

content.

Reflect Reflect

Positi P Posi

Reflect Reflect
e Shape

tnstnod
M toslleA
All - - 1A

In the above screen shot, the items on the left are the original objects and

a guide. The objects on the right have been reflected by duplicating the
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left page. Quite obviously, reflecting content is much more appropriate for

objects than for text!

Reflective Defaults:
Reflective Objects Defaults:

New Object Settings: @
¥ Don't Reflect (&)

() Reflect Position
() Reflect Shape
() Reflect Contents
() Reflect All

New Guide Settings:

%) Don't Reflect
() Reflect Position

Reflective settings can be set for newly created objects by changing the “Re-
flective Object Defaults” In the screen shot above, notice that the defaults
can be set separately for objects and guides. Object defaults can be set to
one of five settings. There are only two settings for guides, as they don’t have

shape or content.

Default settings only affect new objects created after changing the default

settings. Existing objects remain with whatever settings were applied.

Object Style settings (see below) supersede the default settings. This means
that if your default object style (the one applied when creating new objects)
has a reflective property, the setting of the object style will be used.
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Setting Object Styles:
The full power of reflective objects can only be realized by using object

styles.

Define Reflective Object Styles

Object Style to Define: | [None] | :! Ei)
With Settings: = No Settings | :J lﬂ)

Apply to Existing Objects? @

Existing Settings:

Don't Reflect:  No Styles
Reflect Position: No Styles
Reflect Shape: | No Styles
Reflect Contents: | No Styles
Reflect All:  No Styles

N ECRE
B SERT SR SURE SERW S

In the above dialog you will see two distinct sections. The top half is where
you define the settings, while the bottom half is strictly informational.

(Changing the selections in the drop down lists does nothing.)
To define reflective settings for an object style:
1. Select your style from the top drop-down list “Object Style to Define”.

2. Select the appropriate setting from the second drop down list “With Set-
tings”.
Please note: There is a distinct difference between “No Settings”, and “Don’t

Reflect” If “No Settings” is selected, new objects created with the selected
style will have the settings defined as your defaults. If “Don’t Reflect” is
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selected, new objects will not reflect regardless of your defaults. Addition-
ally, applying an object style which is set to “Don’t Reflect” will remove any
reflective settings, while applying ones set to “No Settings” will preserve

prior settings.

3. To apply the settings to existing objects of the selected style, check “Ap-
ply to Existing Objects”. If you just want to create settings for new objects,

uncheck the option.

Libraries

Reflective objects can be saved in a library, and will retain their reflective set-
tings. However, they will not retain their position information when placed
in a document. After placing objects from a library, the new position infor-
mation may not be recorded for up to a second or so. Make sure not to move

newly placed objects for a second or two.

Book Files

When changing page numbers in book files, the page sides might change.
To insure that objects reflect properly when adding documents to a book, or
updating page numbers, make sure the documents are open. If they are not
open, the objects will not reflect. If for whatever reason reflective objects did
not reflect when they should have, it is still possible to force them to reflect
manually. Simply select: InTools > Reflective Objects > Trigger Object
Reflection. This will only effect objects which changed page sides, but were
not reflected. It will not effect objects which remain in their proper position.

It is therefore safe to repeatedly select this menu option.
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Transferring Documents

All reflective settings are stored within the document. These settings are
saved even if the document is transferred to a computer which doesn’t have
Reflective Objects installed. The stored information includes each object’s po-
sition and page side. Documents can therefore be successfully transferred

without issues.

One issue which can come up is as follows: Lets assume the document is
transferred to a computer which doesn’t have Reflective Objects installed, and
reflective objects are moved. When the document is transferred back to a
computer with Reflective Objects installed, objects will have their original po-

sition stored. This can cause the object to move to unexpected places.

To solve this issue, reflective objects should be “Deactivated”. All this does is
erase the stored positions of all the objects in the document. To start record-
ing position information again, simply select “Activate Reflective Objects”.
Deactivating reflective objects does not change the reflective settings. They
remain reflective. It simply removes the information of where they are po-

sitioned.

Another reason you might want to deactivate objects would be for copying
between documents. If you copy a reflective object to an opposing page even
in another document, Reflective Objects will attempt to move it to its reflective
position. This might cause you to have to fight against Reflective Objects for
correct positioning in the new document. One way to avoid this, is to deacti-
vate all reflective objects in the source document before copying the objects.
Another way would be to deactivate the objects in the target document.
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Please note: The deactivated state of reflective objects is a document-wide
setting. All objects in a deactivated document will remain deactivated until
the document is activated once more. Objects copied between documents
will take on the activated state of the target document. For example: an ob-
ject copied from a deactivated document to an activated one will become
activated. However, the position of the object will be the new position, not
the old position in the deactivated document. An object copied to a deac-
tivated document will become deactivated, and no positioning data will be
recorded. Copying objects between two activated documents will have the

same effect as copying objects to another page in the same document.

CS3ME users please note: Winsoft changed behavior in right-to-left docu-
ments in CS3 version 5.0.1. Previously, the zero point of the document was
at the top left in all documents regardless of document direction. In version
5.0.1, the zero point was moved to the top right on right-to-left documents.
This causes all measurements on the page to be negative numbers. When
changing document direction, all the reflective positions become invalid. If
you are using Reflective Objects in CS3ME version 5.0.1 you must reactivate
objects after changing document direction. Failure to do so may cause ob-
jects to disappear! This issue has been fixed in the 5.0.2 update. We strong-
ly advise updating to 5.0.2.

Scripting

Applying Settings
The main functions of Reflective Objects can be accessed through scripting.
To apply reflective settings to objects, simply append one of four strings

to an object’s label: “<ReflectiveObjectls’, “<ReflectiveObject2s’,
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“<ReflectiveObject3>’, “<ReflectiveObject4>". These labels correspond
to the four reflective options in order. So an object with a script label which
contains <Reflect iveObject1>will be set to reflect position, and so on. Sim-
ply applying the script lables will just assign the objects as being reflective.
They will not cause any position data to be recorded. To insure that the data
is recorded, and the objects will be automatically reflected, make sure to
modify them in some way after the label is changed or manually activate the

reflective properties of the reflective objects. (see below).

Using Event Handler Codes

Besides applying the settings to the objects, the plug-in can be communi-
cated with directly. This is accomplished by sending event handlers to the
plug-in.

To send an event handler to Reflective Objects you must first get a refer-
ence to the plug-in. The plug-in is accessed using the document load-
ed plugins method. The correct syntax in Javascript would be: doc.
loadedScriptedPlugins ("reflectiveobjects"). In AppleScript that
would be (Within a document “tell”): loaded scripted plugins label
"reflectiveobjects". No matter which scripting language is being used,
the plug-in is returned as a single-item array. So if you get a reference to the
first item of that array you then have a valid reference to Reflective Objects.
To further illustrate this point, this line of code (assuming a valid reference
to a document) will return a reference to Reflective Objects in javascript:

var reflectivObjectsPlugin=doc.loadedScriptedPlugins ("reflectiveobjects") [0]

Once you have a reference to the plug-in, you can then send event handlers

to the plug-in . There are three different event handlers which can be used:
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externalReflectObjects, externalDeactivateReflection,
and externalActivateReflection. These three event  han-
dler codes correspond to the three last menu options un-
der Reflective Objects namely: “Deactivate Reflective Objects’,
“Activate Reflective Objects”, and “Trigger Object Reflection”. To send
the event handler codes to the plug-in you should do something like this:

reflectivObjectsPlugin.handleScriptEvent ("externalReflectObjects™")

The event code “externalReflectObjects” is used to simulate the effect of
modifying all reflective objects in the document. This is useful to force the
immediate reflection of objects within a script. The reflection normally hap-
pens atidle time, and if a script closes the document or makes modifications
too quickly, the reflection may not happen automatically. Another situation
where you would want to invoke this event handler, would be when book
documents have been updated while they were closed. As explained in sec-
tion on books, changing book files while the documents are closed will cause
them to not be reflected automatically. Invoking externalReflectObjects
will fix this issue.

If your script will be moving around objects, and you do not want to
fight Reflective Objects for positon of the objects make sure to invoke

“externalDeactivateReflection” before moving things around.

The event code “externalActivateReflection” commonly has two uses.
First of all it should be used the same way Activate Reflective Objects is used
in the user interface: to activate reflection after it has been disabled. The sec-
ond use in scripting is to cause the position data to be written when objects

are assigned reflective properties by changing their script label.
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For further illustration on scripting Reflective Objects download the sam-

ple scripts from In-Tools” website.

Addendum
What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.




http://www.in-tools.com/indesign/scripts/samples/reflect_examples.zip

http://www.in-tools.com/indesign/scripts/samples/reflect_examples.zip



Reflective Objects
Gl Cine OpPilescg=2

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you

accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.



http://www.in-tools.com/privacy.html
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Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the
Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
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INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Department>s list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions
This Agreement and the relationship between In-Tools and you shall be governed in ac-
cordance with the laws of the State of New York. Any dispute between you and In-Tools





License Agreement

regarding this Agreement will be subject to the exclusive jurisdiction of the state and
federal courts in the State of New York. You agree to submit to exclusive jurisdiction in

the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use
of the Software and supersedes any other communications or advertising with respect
to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-

cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.
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YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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What is Style Utilities?

What is Style Utilities?

Style Utilities is a collection of functions designed to aid in formatting text

efficiently and accurately.

Currently Style Utilities includes the following functions:

1.

2
3
4
S.
6
7
8

Conditional Paragraph Style Changer.
Style Between Delimiters

Create Multi Line Styles.

Consecutive Styles.

Apply Next Styles.

Create Hyperlinks from URLs.
Change Case by Style.

All Caps to Small Caps.

We hope to add more utilities in the near future. If there is a formatting util-

ity that you would like to see added to this collection, please contact us at

wishlist@in-tools.com. Registered users are eligible for free upgrades as

new utilities are added.




mailto:wishlist@in-tools.com
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Installation
Style Utilities was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 16.

All the necessary components of Style Utilities are installed in a single step
by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MNO o Install Publisher Suite
N k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction T InDesign CS3 Install 5.3 MB

E InDesign C54 Install 5.8 MB
R Read Mo ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )

A

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nnw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext > ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign C54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick ‘Mext', If you would like to select a different folder, dlick 'Browse'.

iles (x86)\Adobe\Adobe InDesign CS4 Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!toolscom

m Plugins

j ‘ Product Status Version Latest Version
World Tools Activated 1.0.4 1.0.5 Update:

Fead el AutoFlow Pro Activated 1.0.8 1.0.8

Column Flow Activated L.0.7 1.0.7

Style Utilitles Activated 1.0.8 1.0.8

I Proper VJ Activated 1.0.6 1.0.6

Bt Help Reflective Objects Activated 1.0.5 1.0.5
—

Power Headers Activated 2.0.5 2.0.5
Side Heads Activated 1.0.7 1.0.7
Story Control Activated 1.0.7 1.0.7

Drop Words creates “drop words” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | " comecin o 7o wessie. resse wote.

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: | sales@In-tools.com Password: ]

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

Euy

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Conditional Paragraph Style Changer

This utility is used for changing the styling of paragraphs based on the con-
tent in the beginning of the paragraph.

Paragraph Style Changer

Original Style to Change: ' [No Paragraph Style] | :J E
End Style: | [No Paragraph Style] | :J ﬂ)

Apply Character Style to First Words: [ [None] = J
If This Character Found: .
In This First Number of Words: 1

Select InTools > Style Utilities > Conditional Style Changer, and the
above dialog box will appear. Select the style you want to change in the first
drop-down list, “Original Style to Change” In the second drop down list,
select the new style. You also have the option of selecting a character style
to apply to the specified number of words. In the first input field type in the
character which will trigger a style change. The style change will be trig-
gered if the character is found anywhere in the first number of words de-

fined in the second input field.





Style Between Delimiters

Style Between Delimiters
This utility is used for applying text styling between two defined characters

or set of characters. One very common use would be to apply character

styles using custom tags.

Apply Character Style Between Delimiters

Use Current Find Settings Instead _| i’
From Paragraph style: Any ] :! [ Cancel )
Character style to apply: [None] | :!

Starting Character(s): (
Ending Character(s): )

Characters Between: (One or both fields can be empty)
No Less Than:
No More Than:

Apply To: @ Document
() Story
() Selection

Select InTools > Style Utilities > Style Between Delimiters... to bring up
the above dialog. There are four sections to the dialog box. The top area
allows you to select the styles. The first drop-down list, “From Paragraph
Style”, will limit the search to a specific paragraph style. Select “Use Current
Find Settings Instead” to search by criteria such as color, character style, etc.
The last find settings used in the application find and replace dialog will be
used to find the text. Please note: If the “Use Current Find Settings” is checked,
the selection of the paragraph style is ignored.

Starting Character(s) is the delimiter at the beginning of the text to be
styled. Ending Character(s) is the ending delimiter. The delimiter is styled
as well as the text.
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“Characters Between” give an option to limit the number of characters be-
tween the delimiters. If the minimum field is left blank, there is no mini-

mum. If the maximum field is left blank there will be no maximum.

Additionally there is an option to limit the search range. The options are
context-sensitive. If there is nothing selected in the document, the only se-
lectable range will be the document. If there is a story or part thereof se-
lected in the document, the “story” radio button will appear. If there are at
least two characters selected, the “Selection” radio button will appear as well.

Selections can be either text or text frames.

Create Multi Line Styles

“Create Multi Line Styles” applies styles based on the number of lines of the
formatted text. It will change the original style to the new one, if it takes up
the selected number of lines. Use this utility to easily style header text and
the like. Select InTools > Style Utilities > Create Multi Line Styles an the
following dialog will appear:

Multi Line Style Changer

0K
Source Paragraph Style: | [No Paragraph Style] )%’i ;3

(" Cancel )

line style: | Original

1
2 | line style: | Original

Both the one and two line style drop-down lists are optional. To make no
changes to either single lines of text or double lines of text, just leave the

selection as “Original”.





Consecutive Styles

The number of lines defaults to 1 for the first style and 2 for the second style.
The default vaules will change the styles if the paragraphs have one or two
lines respectively. These values can be changed to whatever you like, offering

flexibility in the utility’s use.

Consecutive Styles

Consecutive Styles is a utility which applies styles to consecutive paragraphs
of specific styles. It can be used in a number of different situations. It can be
used to change the style of any paragraph of a particular style followed by
a paragraph followed by a specific other style. It can be used to change the
style of a paragraph preceded by a specific style. It can also be used to change
the styling of a number of identically styled paragraphs, by either changing

the first one or the last one.

To use Consecutive Styles, select InTools > Style Utilities > Restyle Con-

secutive Paragraphs... and the following dialog will appear:

Consecutive Styles |

First Paragraph Style: ' [No Paragraph Style] |—:i Change To: ' No Change |—:J (i;

Second Paragraph Style: | [No Paragraph Style] I—:J Change To: | No Change I—:] (_ Cancel )

In the shown dialog, select the original paragraph styles on the left, and the
resultant paragraph styles on the right. You can select to change the first,
secnd, or both. If you have a range of identically styled paragraphs (a list for
example), and would like the first or last paragraph to have a unique style,
do the following: To create a unique first style, create the fist paragraph style
and apply it to all the paragraphs (by a search and replace, or by modifying
the existing style). Then select the first style in both dropdowns on the left,
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and select “No Change” in the top “Change to” dropdown and the “not-first
style” in the bottom “Change To” dropdown. To create a unique last style,
do the same thing in reverse (changing the first paragraph instead of the

second).

Apply Next Styles

InDesign has the ability to define “next styles” to paragraph styles. “Next
Styles” are paragraph styles which should be applied after the defined one.
This is great when typing or pasting in text. You can set up a whole series of

styles which can each be applied in turn.

When you have text which is already placed, it’s a bit trickier to get “next
styles” to be applied, but that can be done as well. You need to select a span
of text and right click on the paragraph style in the paragraph style panel.
this brings up this context menu:
Edit "H1"...
Duplicate Style...

Delete Style
Redefine Style

Apply "H1"
Apply "H1", Clear Overrides

Apply "H1" then Next Style

Apply "H1" then Next Style, Clear Overrides

Copy to Group...
New Group from Styles...

After selecting Apply [style] then Next Style, the entire “next style chain”
will be applied to the selected text.

A problem becomes apparent however, when you have a style scattered

around your document which should have a series of styles following it, but
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it can not be looped in a structured loop (for example, if you have a series
of headings and then a non-determined number of body text paragraphs).
That’s why we created the “Apply Next Styles” function. It searches the docu-
ment for every instance of the style you select and then applies all the “next

styles” in turn. To use, just select the beginning style and press OK.

Paragraph Style: [H1 I-G-q (—GI(—’

Cancel

Create Hyperlinks from URLs

This utility will automatically create hyperlinks from any text it recognizes
asavalid URL. It’s very smart, and will ignore manually inserted line breaks

on long URLs as well.

You can select the character style to apply as well as the scope of text to

change (Document, Story, or Selection).

Style to Apply: [ hyperlink

Scope: [ Story
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Change Case by Style
This utility will change all text with the specified style(s) to the selected case.

Change Case By Style

Case: | Smart Title Case %i [ Cancel )
N

Paragraph Style: | Any Style

Character Style: | Any Style

Scope: | Document

— Edit Case Exceptions

(" Edit Lowercase List ) ([ Edit Special Case List B

There are four different options: UPPERCASE, lowercase, Smart Title Case,
and Sentence case. Uppercase, lowercase, and sentence case are the same
results you would get by changing the case manually. Smart Title Case, is (as
the name suggests) very smart! It will automatically convert text to title case
based on complex rules! Additionally, there are two word lists to allow you
control over this behavior. The word lists can be edited by clicking on one of

the “edit buttons” in the dialog shown above..

nmm  The word lists should always be edited using the dialog. The
word list files should never be edited directly. For Smart Title
Case to work correctly, the word lists must be sorted in a spe-

cific way, and the dialog ensures that it is.

The rules which the title case uses are as follows:
The first and last words are always capitalized, as well as any word follow-

< /»

ing a period (full stop) or colon. Any compound word separated by a “/”,
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«»

., dash or m-dash will have the letter immediately following the separa-
tor capitalized. Any other word will be capitalized unless it appears in the
lowercase word list. Any word appearing in the list will be lowercase only
if it is not a “starting” word. For example: In the title, “The Last of the Mo-
hicans”, the first word “the” will be capitalized, while the second time “the”
appears will not. This is because the first word is the beginning of the sen-
tence. Similarly, in the title, “Lion: The King of the Jungle”, the first word

“the” will be capitalized because it follows a colon. The lowercase word list
can be edited to include any words you like. All words should be separated
by a single space.

Any word appearing in the “special case” will always be capitalized exactly
as it appears in the file, regardless of position. This is useful for words like
“InDesign”, “USA”, “UK’, etc., which have capitals in the middle of the word.
This file can also be used to force lowercase on specific words and override
the default rules. So, let’s assume you would like the word “a” to always be
lowercase, even if it is the first word in your header text. You would simply
put the word “a” in your special case list, and it will always be lowercase.
When a word appears in both lists, the special case list supersedes the low-

ercase one.

nmm  The Smart Title Case of Style Utilities uses the same logic as
the Smart Title Case of Power Headers, and both use a single
set of text files for the lowercase and special case definitions.

Editing the list in either plugin will affect the other.

You can select a paragraph style, a character style, or both for options of

which text to convert. You can also select what scope of text to convert
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(Document, Story, or Selection). If neither a character style or paragraph
style is selected, all the text in the selected scope will be converted.

All Caps to Small Caps

This utility will convert text encoded as all caps to proper small caps. It of-

fers a lot of flexibility in the styles it converts as well as the range of text it

converts:
Convert All Caps to Small Caps
Paragraph Style: | Any Style }%i E OK 3
Character Style: | Any Style N Cancel )
Scope: | Document F%i
Apply Style: [ No Style F%i

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic, it
requires “event processing”. This means that certain events trigger specific
processes to take place. There is limited event-triggered scripting available
in CS3.
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To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including
without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the




http://www.in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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About Drop Words

“Drop Words” is a technique used extensively in Hebrew typesetting. He-
brew drop words differ from standard drop caps in a number of ways. Firstly,
they are applied to the whole word, while standard drop caps are generally
applied to just the first letter. Secondly, they are used on (almost) every
paragraph. This is something which makes manual setting of the drops un-
practical. Lastly, the drops are “virtual drops”. With normal drop caps, the
characters which are dropped are enlarged to take up the number of lines for
which they are set. Drop words, although often slightly larger than the rest of
the text, only take up the first line. The line below is indented to start directly
below the second word.

Creating all this formatting manually is a very tedious process. This plug-in
was created to automate the process of creating these virtual drop words.
There is a script originally written by Dave Saunders, and ultimately im-
proved upon by us which helps in the automation. The script can be down-
loaded from here. However you may find it cumbersome and inefhicient to
use in production work, especially when there is a need to update them at
a later point in time. Additionally the script can take a relatively long time
when run on long documents. Drop Words was completely re-written to en-
able much more extensive automation and ease of use, as well as being very
quick to run. The typographical quality of the dynamic drop words created
by the Drop Words plug-in is also superior to that of the script.




http://www.in-tools.com/indesign/scripts/freeware/OneWordDrop.zip
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Installation
Drop Words was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 14.

All the necessary components of Drop Words are installed in a single step by

our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MmOO ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction U InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
ffid Me ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

:Ili— Setup - Reflective Object:

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick ‘Next', If you would like to select a different folder, dlick 'Browse',

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!toolscom

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:

—
Fead Hanual

AutoFlow Pro Activated 1.0.8

Column Flow Activated 1.0.7

) Style Utilitles Activated 1.0.8
1 Proper V] Activated 1.0.6
Gt Help Reflective Objects Activated 1.05

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7
Story Control Activated 1.0.7

Drop Words Demo: 23 days left FActiuate 1.0.5

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | “camecin o 7ot wessie. resse wote.

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@in-tools.com Password: ok kK

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Drop Words #1

There are two versions of the drop words function available using the Drop
Words plug-in. They are named “Drop Words”, and “Drop Words 2”. The
setup and usage of the two versions are very different and will be explained

separately.

Setup

Drop Words uses paragraph styles as the basis for creating the drop words.
You must set up your document with styles for the drop words to properly
function. “Drop Words #1” creates drop words using the standard drop caps
function of InDesign. To properly create the drop words, the drop caps set-
tings in your paragraph styles must be properly set up. The paragraph style
should have the drop caps set to drop two lines. The number of characters
set to drop is unimportant. It will be adjusted to the correct number of char-

acters by Drop Words.

To ensure that the first word(s) retain the proper size and vertical position,
the paragraph style should be set up using a character style for the drop cap.
The drop cap character style should be a reduced size. The exact size would
depend upon the point size and leading of the paragraph. Additionally, the

baseline shift will need to be moved up.

Note: The size of the drop cap characters can be reduced by either changing the
point size, or by using glyph scaling. The glyph scaling method will work in cs and
cs2. In cs3, there is a bug, which does not allow applying the glyph scaling in a
drop cap, so the point size must be changed instead.
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Running Drop Words #1

Before applying the drop words in a document, you must select which para-
graph styles should have the drop words applied. The styles to receive the
drop words can be added, modified, or removed. Here’s the dialogs for se-
lecting the styles:

Define Word Drop Word Caps

Paragraph Style to Define: [ [No Paragraph Style] 3] x> Word Caps from paragraph style: | [No Paragraph Style] 3] ]
( Cancel ) (" Cancel )
What to Do: &) Create New Word Drop Number of Words: 1

O Modify Style

) Remove

In the first dialog, for each paragraph style to receive the drop words, click
“Create New Word Drop”. If you would like to modify an existing definition,
select the appropriate style, and click “Modify”. Creating a new drop word,
or modifying an existing one, will bring up the second dialog. The options
for setting the drop word definitions are very straight-forward. Select the

paragraph style, and the number of words to drop.

Once all the styles are set up, apply the drops to the specified number of
words, by simply selecting: InTools > Drop Words > Run Drop Words.
This will update all the paragraphs in the document.

Please note: All settings applied by Drop Words #1 are static. When the drop
words are applied, the paragraph styles will appear as overridden. (They will
have the little “plus” sign near the style name.) Clearing overrides will undo the
effects of Drop Words. Additionally, changes to the drop word text will not cause
a dynamic update. Either one of these situations necessitate running Drop Words

again.
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Drop Words #2

Drop Words 2 is a complete rewrite on the concept of drop words. It works
using an entirely different method, and requires a totally different setup. The
reason we included both functions, is there are advantages to both ways.
(Although the advantages to the second method probably outweigh the dis-

advantages — you decide!)

The advantages to Drop Words #1 are as follows: =~ ® Drop words #1 can be
run on text before it is properly placed. It doesn’t matter if the text is over-
set, etc. Drop Words #2 requires the text to be set. At the very minimum it
must not be overset, but ideally it should be set in its final formatting before
creating the drop words. ~ ® Drop Words #1 can be vertically justified us-
ing InDesign’s built in vertical justification, while Drop Words #2 cannot.
To vertically justify text formatted using Drop Words #2, you can use our
Proper V] plug-in instead. = ® Drop Words #1 can be created on the whole
document at once (assuming the styles are previously chosen), while Drop
Words #2 must be run for each style separately. ® Drop Words #2 will
only work using CS2 and higher.

The advantages of Drop Words #2 are as follows: ~ ® The spacing between
the drop word and the rest of the text is adjusted to match the spacing in the
rest of the line. Spaces in drop caps (used in Drop Words #1) are fixed spaces,
and not adjusted by the justification of the paragraph. The flexible spacing
in Drop Words #2 creates a much more unified look. ~® The drop words
in Drop Words #2 are dynamic. This means that editing the drop words will
automatically adjust the size of the drop words. Deleting the drop word text
will remove the drop words entirely. ® Drop Words #2 does not override

the paragraph style settings, so clearing overrides will not effect the drop
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words. @ Any drop caps bugs in InDesign (and there are quite a few...)
will affect Drop Words #1 but not Drop Words #2. @ The drop words in

Drop Words #2 require no resizing or baseline shifting.

Setup

Since drop words are only used in right to left text, Drop Words 2 was de-
signed to function on right-to-left paragraphs only. If you try to run it on
left-to-right paragraphs, nothing will happen.

To run Drop Words 2, you must set up two different paragraph styles. The
first style will apply formatting to the parent paragraph, while the second
one will apply the formatting to the drop words alone. If there is more than
one word in the drop word, the second style can be set up to apply all the for-
matting to the different words using nested styles. The second style should
be set up using the true point size and baseline position (unlike Drop Words
#1).

Using Drop Words 2

To create “Drop Words 2” drop words, simply select: InTools > Drop Words
- Run Drop Words 2. This must be repeated for each paragraph style.

Drop Words

r oK
Drop Words from Paragraph Style: = [No Paragraph Style] | :] ;)
Paragraph Style to Apply to Drop Words: = [No Paragraph Style] | :! ﬂ)

Number of Words: 1 ':] " Resize all Drop Frames

Above is the dialog used for creating “Drop Words 2” drop words. The op-

tions are self-explanatory. The top drop down list is for selecting the parent
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paragraph which should receive the drop words. The second drop down list
is for selecting the paragraph style to apply to the words which are to be
dropped. In the “Number of Words” input field, select the number of words
to drop. “The Resize all Drop Frames” option will force an update on all
existing drop words in the selected style. It is not usually necessary, but the

option offers a way to force the re-flow.

Drop Word Re-formatting

Once the drop words are created, the size of the drop will be adjusted auto-
matically any time the drop words are edited. Depending on the number of
drop words, and the processor speed of the computer, the updates can take
some time. If the text is reformatted in a way that affects a number of drop
words, you will be prompted to okay the updates. If you cancel the updates,
make sure to select “Force Update” to fix the spacing (and possibly overset
drop words). You can force the update by selecting InTools > Drop Words
- Force Update Drop Words 2.

Please note: Do to an unresolved issue with the Drop Words plug-in, it is pos-
sible to sometimes be prompted more than once in rapid succession after changing
formatting. If there was only one change of formatting, it is safe to dismiss all
prompts following the first one.

Removing Drop Words

The drop words are created as inline frames in the story stream. The text of
the drop words themselves are actually a separate story. If the text is export-
ed to be edited in an external program, the drop words must be removed
first. To remove the drop words simply select InTools > Drop Words >
Undo Drop Words 2. If no text is selected, you will be presented with the
following dialog:





Drop Words #2

Remowe Drop Words |

oK
Remowve Drop Frame in Style: [ Al ) :'] ;}
Cancel

You have the option of removing the drop words from either the whole doc-
ument, or only from a specific paragraph style. IF there is text selected, you

will have an additional option as shown in the dialog below:

Remove Drop Words
Remove From: {®) Selection @
() Paragraph Style
Remowve Drop Frame in Style: [ Al | :i

If “Selection” is selected, only the drop words in the selected text will be

removed.

Applying Drop Words to Selected Text

If you need to apply the Drop Words to specific text, that can be done as
well. Select “InTools > Drop Words > Drop Selected Paragraphs...” and
select the number of words to drop, and style to use for the Drop Words:

Drop Words |

OK
Paragraph Style to Apply to Drop Words: [[No Paragraph Style] |+% '] ;)

Number of Words: 1 :] [ Cancel
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Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID Tool-
Assistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of
hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-

sistant plug-in installed can create and use these attached scripts. There
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are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.
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License Agreement

License Agreement
Please read the following document carefully!

Thisis alegal agreement (the Agreement) between you and Print Israel LLC (In-Tools),
the developer of the In-Tools software. This Agreement pertains to your use of the In-
Tools software and documentation which are provided to you by In-Tools (collectively,
the Software). By copying, installing, or otherwise using the Software, you accept all
the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the




http://www.in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, ORAS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE ORDATA. YOU ASSUME TOTAL RESPONSIBILITY AND
RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN ANY





License Agreement

MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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MindHyph 1.0.1 for Adobe InDesign/InCopy

Installing Hyphenation Languages

MindHyph currently supports the Hyphen hyphenation services. As of the time of printing this is currently
about 50 languages. For an up-to-date list of languages available please go to the MindHyph url at http://
www.mindsteam.com/products/MindHyph/languages.html. MindHyph 1.0.1 ships with Hyphen 2.6.

Hyphen is a related project to the Hunspell dictionary project, which is supported by MindSteam’s “MindSpell”
product. As such, the hyphenation files need to be installed into the “MindSpell->Hunspell” language director-

ies. The MindHyph plug-in file is installed into the “MindSpell” directory as well.

MindHyph initially installs one hyphenation dictionary, English: USA. To install additional languages you will
need to download a hyphenation dictionary.

You will find Hyphen compatible hyphenation dictionaries at the following urls:

http://wiki.services.openoffice.org/wiki/Dictionaries
http://ftp.services.openoffice.org/pub/OpenOffice.org/contrib/dictionaries/

On Macintosh the installed hyphenation languages are located at:

/Applications/InDesign CS<x>/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

On Windows the installed hyphenation languages are located at:

/Program Files/InDesign CS<x>/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

In all the above examples the folder name <xx_yy> should be replaced with the correct ISO language and cou-

ntry codes for your language. For example, en_Us is English (United States). Please note the use of case in the
folder name.

”

The hyphenation file will have the string “hyph_” prepended to the name of the language and country code. So
“hyph_en Us.dic” is the required file for the English: USA hyphenation.
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Be aware that not all hyphen data files are named the same. In some cases they may be named “hy ”. Itis
essential the file be renamed to match the format expected by MindHyph, “hyph xx yy.dic”.

Note: Hyphen .dic files can be found inside OpenOffice 3.0 extensions. These are zip files which end with the
.oxt filename extension. To extract the Hyphen .dic file, rename .oxt to .zip and extract the archive. Then
copy the “hyph_xx yvv.dic” file to the Hunspell language directory as described above.

OpenOffice dictionary extensions can be found here:
http.//extensions.services.openoffice.org/en/dictionaries

The first two (in some cases three) letters are lowercase and represent the language name. These are mand-
atory, they can be followed by an optional country code. There must be an underscore separator *_" between

the language code and the country code. The country code is in uppercase.

More info on language codes is found here:
http://en.wikipedia.org/wiki/ISO_639

More info on country codes is found here:
http://en.wikipedia.org/wiki/ISO_3166

After installing MindHyph your InDesign Plug-ins and Dictionaries folder should look something like:

Adobe InDesign C55
£ Configuration
[0 Documentation
[ Fonts
£ Legal
[ Logs
[&] Plug-Ins
» [ Data Services
v [ Dictionaries
|ﬂ Dictionary Editor Dialog.InDesignPlugin
» [ uo
» [ MindGrammar
v [ Mindspell
» @ Aspell
v Hunspell
v [enus
[ en_us.aff
& en_US.dic
s hyph_en_US.dic
[ thes_en_us.dat
D thes_en_US.idx
» [ ruRU
> [0 Mac 0s X
|| MindHyph.InDesignPlugin
|ﬂ MindSpell.InDesignPlugin
|ﬂ MindThes.InDesignPlugin
Filters
Graphics
InCopyWorkflow
Interactive
Layout
Mindsteam
|ﬂ LanguagelLamp./nDesignPlugin
4] LanguageLampPro.InDesignPlugin
|| | anguageLampUl.InDesignPlugin
ﬂ MindEngine.InDesignPlugin
|ﬂ MindGrammarPro.InDesignPlugin
|ﬂ MindGrammarUl.InDesignPlugin
|ﬂ MindSpellPro.InDesignPlugin
|ﬂ MindSpellUl.InDesignPlugin
| MindThesULInDesignPlugin

4dryvvryvwvyy

FEEEERE

dvyvyvrvyy
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Activating MindHyph in InDesign and InCopy for Existing Languages

After initial installation, MindHyph needs to be activated in the Dictionary panel of the InDesign/InCopy pref-
erences. You may only use one hyphenation service per language at a time. Choose the Language you wish to
apply work with. Then in the Hyphenation menu choose the “MindHyph” menu item.

Afterward you will need to set the preferences and then quit and restart InDesign. This allows the linguistic
manager to register the languages and hyphenation services.

“_

General Dictionary

Interface
Type — Language: ( English: USA H-‘
Advanced Type

fUsers/mindsteam/Library/Application Support/Adobe Linguistics /Dictionaries (Ac
Compasition

Units & Increments
Grids
Cuides & Pasteboard

Dictionary =S R[] dh =
Spelling

Autocorrect Hyphenation: [ MindHyph I-G-‘

Notes Spelling: | Proximity |

Track Changes = -

Story Editar Display Double Quotes: " 1-]

Display Performance Slng[e Quotes: 1 ﬂ

Appearance of Black
File Handling
Clipboard Handling
MindGrammar Compose Using: ['User Dictionary and Document l-ﬂ
Mindspell

— Hyphenation Exceptions

— User Dictionary

"1 Merge User Dictionary into Document
E Recompose All Stories When Modified

( Cancel )(—6!(—3

Dictionary Preferences

Using MindHyph

After setting up the languages for MindHyph you are ready to begin using the hyphenation service. MindHyph
works just like the built-in hyphenation for InDesign. You can open the Dictionary dialog and hyphenate words
with the Hyphenate button, and use the Paragraph panel to define hyphenation parameters.
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Uninstall

Uninstallation on Mac OS X systems

To uninstall MindHyph, open the MindHyph folder in your Applications folder. You will find a sub-folder for
each InDesign/InCopy version MindHyph has been installed for. Open the sub-folder of the installation you
would like to remove, double-click on Remove, and then follow the uninstall program instructions.
Uninstallation on Windows systems

To uninstall MindHyph, open the MindHyph folder in \Program Files\Mindsteam Software. You will find a
sub-folder for each InDesign/InCopy version MindHyph has been installed for. Open the sub-folder of the insta-
llation you would like to remove, double-click on Remove, and then follow the uninstall program instructions.
Support

An up-to-date FAQ for MindHyph for Adobe InDesign/InCopy is available at:

http://www.mindsteam.com/products/MindHyph/faq.html

Contact us by mail at support@mindsteam.com

Adobe, InDesign and InCopy are either registered trademarks or trademarks of Adobe Systems Incorporated in
the USA and/or other countries. Microsoft Windows is a registered trademark or trademark of Microsoft Cor-
poration in the USA and/or other countries. Mac OS X is either a registered trademark or trademark of Apple
Computer, Inc.

Copyright 2010 Mindsteam Software

|Z| Mind Hyph Page 5






Mind Spell

Version 1.3

Reference Manual

SSSSSSSS





MindSpell 1.3 for Adobe InDesign/InCopy

For the latest information on MindSpell view the read me file with this installer.

Installing dictionaries

After you have installed MindSpell, you will likely want to install dictionaries to use with InDesign/InCopy. You
will need to install the dictionary folders before launching InDesign. The dictionary folders described below will
define which new languages will be created in InDesign, and which services are available to these new languag-
es as well as existing languages.

Hunspell

For both Macintosh and Windows the Hunspell service is supported.

You will find Hunspell dictionaries at the following urls:

http://wiki.services.openoffice.org/wiki/Dictionaries
http://ftp.services.openoffice.org/pub/OpenOffice.org/contrib/dictionaries/

Install your Hunspell dictionary in:
InDesign/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

The hunspell dictionary folder <xx_yv> must contain the files xx_vvy.dic and xx_vv.aff. These files com-
prise the heart of the dictionary service. For example, the en_us folder would contain the en Us.dic and
en US.aff files.

Note: hunspell dictionaries can be found as OpenOffice 3.0 extensions, zip files which end with the .oxt file-
name extension. To extract the hunspell dictionary files, rename .oxt to .zip and extract the archive. Then copy
the files to the hunspell directory as described above.

OpenOffice dictionary extensions can be found here:

http.//extensions.services.openoffice.org/en/dictionaries
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Aspell
For both Macintosh and Windows the Aspell service is also supported.
Aspell dictionaries can be found at these urls:

ftp://ftp.gnu.org/gnu/aspell/dict/Oindex.html|
http://aspell.net

Install your Aspell dictionary in:
InDesign/Plug-ins/Dictionaries/MindSpell/Aspell/<xx YY>

Mac OS X
For Macintosh, the Mac OS X spelling services are also supported.

For Mac OS X, the dictionaries are determined by the folder structure and already created by the installer.
Depending upon which version of Mac OS X you are using will determine which languages are pre-installed by
the installer. Additional Mac OS X languages can be added via the same manner, however it will be up to you to
install the appropriate Mac OS X spelling service for that language.

The installed Mac OS X dictionaries are at:
InDesign/Plug-ins/Dictionaries/MindSpell/Mac OS X/<xx YY>

Note that in Snow Leopard, Mac OS X 10.6, the OS supports Hunspell dictionaries, so it is possible to use the
Hunspell dictionaries via the Mac OS X spelling service.

In all of the above examples the folder name <xx_YY> should be replaced with the correct ISO language and
country codes for your language. For example, en_US is “English (United States)”. Normally the packages found
on the Hunspell and Aspell sites have their folders already named with the appropriate codes.

The first two letters are lower case and represent the language name. These are mandatory. They can be fol-
lowed by an optional country code. There must be a separator ‘' between the language code and the country
code. The country code is in upper case.

More info on language codes is found here:
http://en.wikipedia.org/wiki/ISO_639

More info on country codes is found here:
http://en.wikipedia.org/wiki/ISO_3166
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After installing your dictionary folders your InDesign plug-ins Dictionaries folder should look something like

this.
& Dictionary...signPlugin [ Aspell - = |9 en_us.aff
2 uo = [ Hunspell - en_US.dic
[ Mindspell [ Macosx P - m = README_en_US.txt

|=] MindSpell....signPlugin

4| e

First launch

Initializing MindSpell is a two launch process. The first time you launch InDesign after installing MindSpell you
will need to select which spelling services you wish MindSpell to support. Also you will need to choose if you
wish to use InDesign language names (when available) or alternatively ICU language names. For example, “Eng-
lish: US” when the preference is on or “English: United States” when it is off. You may make these settings in
the MindSpell preferences panel, shown below.

“

Ceneral MindSpeII

Interface

Type —Spelling Service Provider

Advanced Type g GNU Hunspell

Composition g GNU Aspell

Units & Increments

— ™ Mac 05 X

Cuides & Pasteboard

Dictionary ~Language Names

Spelling .

P ™ Use InDesign Language Names
Notes.

Track Changes —Spell Check Options

Sl L) ] Ignore UPPERCASE Words
Display Performance X

Appearance of Black "1 1gnore Words with Numbers
File Handling

Clipboard Handling
MindGrammiar

MindSpell
—

A—
w 4
v w
— o —
5§ O F T W A R E

( Cancel )E—OI(—)
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Once you have selected the spelling services you would like to use and set the Language Names flag relaunch
InDesign. MindSpell will parse the folder structure of the dictionaries to create the necessary InDesign lan-
guages (if they do not yet exist).

Spell Check Options

There are two additional settings when spell checking a document when using one of the MindSpell spelling
services. You can ignore all words in uppercase, and you can ignore all words containing one or more digits.

Spell Check Options

[ lignore UPPERCASE Words
] Ignore Words with Numbers

Activating MindSpell in InDesign and InCopy for Existing Languages

After installation, MindSpell has to be activated in the dictionary section of the InDesign/InCopy preference
panel. Simply select the language you wish to use. Then in the Spelling Services menu select the service. You
may have more than one service installed. For instance on the Mac, you could have all three services “Aspell”,
“Mac OS X”, and “Hunspell” installed. You may only use one spelling service per language at a time. Below is a
screen shot of the Dictionary preferences panel.

— Language: English: USA F':'i

HO:Users: mindsteam:Library:Preferences:Adobe InDesign:Version &.0:en_US:Dictior

== @l ¢ =

Hyphenation: a Proximity H"J

Spelling:
Double Quotes: Hunspell
[ Aspell |

Single Quotes: | Proximity E
S

User Dictionaries

MindSpell for InDesign/InCopy uses XML-based user dictionaries. If you would like to continue using the user
dictionaries of the standard InDesign/InCopy correction tool “Proximity” with MindSpell, you will be able to
export them using Proximity and to import them using MindSpell. Use InDesign’s dictionary dialog to achieve
this.
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Scripting

In MindSpell 1.3 we have introduced two new scripting events to the scripting model. spell check and
suggest have been added to the word object in scripting.

Spell Check Event

A word object can call the spell check event and it will return a value indicating if the word is correct, mis-
spelled, or uncapitalized.

5 main();
& function main()
7 H{
B app.scriptPreferences.userinteractionLevel = UserintermctionLevels.intermctWithAll;
g if (app.documents.length != 0}
10 = {
11 Elj if (app.selection.length 1= 0)
12 =] {
13 var mySelection = app.selection[0];
14 switch (mySelection.constructor.name)
15 = {
16 Elj case "Word":
17 = {
18 var spellResult = mySelection.spellCheck();
19 alert (spellResult);
20
21 var suggestions = mySelection.suggest{);
22 alert {suggestions});
23
24 break;
25 = ¥
26 default:
27 =
28 alert{"Please select a word and try again."};
29 - 3
30 - 3
31 - b
32 else
33 =
349 alert{"FPlease select a word and try again."};
3s - b3
36 R
37 else
3B = {
39 alert{"Please select a word and try again.");
40 e
4 )

Spell Check and Suggest JavaScript
Suggest Event
A word object can also call the suggest event and it will return a list of spelling suggestions to the word.

Note: This even works if the word is correctly spelled.
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Uninstallation
Uninstallation on Windows systems

To uninstall MindSpell, open Program “Files\Mindsteam\MindSpell for Adobe InDesign/InCopy inthe
Windows start menu, select Remove, and then follow the uninstall program instructions.

Uninstallation on Mac OS X systems
To uninstall MindSpell, open the Mindspel1l folder in Applications. You will find a sub-folder for each InDe-

sign/InCopy version MindSpell has been installed for. Open the sub-folder of the installation you would like to
remove, click on “Remove”, and then follow the uninstall program instructions.

Support

An up-to-date FAQ for MindSpell for Adobe InDesign/InCopy is available at:
http://www.mindsteam.com/products/mindspell/faq.html|

An up-to-date list of available languages can be found at:
http://www.mindsteam.com/products/mindspell/languages.html|

Contact us by e-mail at support@mindsteam.com

Adobe, InDesign and InCopy are either registered trademarks or trademarks of Adobe Systems Incorporated in
the USA and/or other countries. Microsoft Windows is a registered trademark or trademark of Microsoft Cor-
poration in the USA and/or other countries. Mac OS X is either a registered trademark or trademark of Apple
Computer, Inc. Aspell and Hunspell are licensed under the GNU LGPL license.

Copyright 2008-2010 Mindsteam Software
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What is World Tools? /

What is World Tools?

Prior to InDesign CS4, the only way to work with Documents which con-
tain right-to-left components (which are necessary for Arabic or Hebrew
composition) was by using the ME (Middle Eastern) version of InDesign.
With CS4, this has all changed. Adobe has included an additional composer
called the World-Ready Composer which is capable of composing right-to-
left languages. The World-Ready Composer also has the added capability of
composing Indic languages.

Under the hood, all of the functionality of the ME version of InDesign is
there in every version of InDesign CS4. Adobe has decided to keep this
functionality hidden. The ME capabilities are only apparent when one tries
to open ME documents (they open flawlessly in CS4). The composer which
is enabled by default is the regular composer used in previous versions of

InDesign which does not support right-to-left text.

World Tools was created to exposed this dormant capability within CS4. It
enables the World-Ready Composer as well as provides a user interface to
be able to use it. It was created to enable all users of InDesign to edit docu-

ments with Arabic, Hebrew, and Indic text.

What World Tools is NOT!
World Tools is not a full replacement for the ME version of InDesign. There
are many reasons why one would want or need to purchase the ME version

of InDesign.

First of all, World Tools is based on technology which Adobe considers
unsupported. Adobe did not expose the World-Ready Composer, because
they are not ready/willing to support it yet. We have tested the technology
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to the best of our ability, and it works well, but they are bugs in the compos-
er which the ME version addresses. If any of these bugs are show-stoppers,
then the ME version is the only solution. We will address bugs in the user in-
terface to the best of our ability, but any bugs in the underlying technology,
is beyond out abilities to address. There is no guarantee by Adobe that they
will even attempt to fix ME related bugs in incremental updates of CS4. This
being said, we would like to receive any information on ME related bugs, so

we can try to analyze them and alert Adobe of their existence.

Also, World Tools does not attempt to achieve the level of integration that
the ME interface has. As a result, the interface of the ME version is much

smoother and more familiar.

If you need control of right-to-left text in Photoshop, Illustrator, or Dream-
weaver, it might pay to buy the ME version of the Creative Suite

Some advantages of World Tools are: 1) price — you don’t need to buy awhole
new program just for right-to-left composition. 2) Timely updates — histori-
cally, the ME updates took much longer to be released than the regular ones.
3) Use of right-to-left functions in the CJK versions of InDesign. The ME
versions and CJK versions of InDesign are mutually exclusive. 4) Localized
interfaces — World Tools can be used with any version of InDesign — no mat-
ter what the language of the user interface might be. The ME version only
has English (IE), French, Hebrew, and Arabic interfaces.

World Tools also includes a number of functions which further aid in multi-

lingual layout:

1. Apply Hebrew Character Style: This will apply a user-defined character
style for Hebrew text within a non-Hebrew paragraph.
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2. Apply Latin Character Style: This will apply a user-defined character
style for text which uses the “Latin” writing script within a non-Latin para-
graph. (“Latin” includes: English, Spanish, French, etc.)

3. Straighten Quotes: This is for making quotes “dumb”. Useful for lan-

guages which don’t use curly quotes, such as Hebrew.

4. Switch Story Direction: This provides a menu item for reversing story
direction. The menu item makes it possible to assign a keyboard shortcut to

reverse the direction from right to left and left to right.

S. Create Spread Numbering: This creates “spread numbering” in which
both pages on a spread will be assigned the same number. The numbers will

only increase every other page.
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Installation
World Tools Pro was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 37.

All the necessary components of World Tools Pro are installed in a single step
by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MNO o Install Publisher Suite
N k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction T InDesign CS3 Install 5.3 MB

E InDesign C54 Install 5.8 MB
R Read Mo ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmm» Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe'\Adobe InDesign C54' for InDesign CS4.

To continue, dick "Next'. If you would like to select a different folder, dick ‘Browse',

iles (x86) \Adobe \Adobe InDesign C54 Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs

lin!toolscom
——— g

Product Status Latest Version

World Tools Activated -0. 1.0.5 Update:
AutoFlow Pro Activated 0. 1.0.8
Column Flow Activated -0. 1.0.7
’? Style Utilitles Activated 0. 1.0.8

1 Proper V] Activated 0. 1.0.6
(et Help

Reflective Objects Activated -0. 1.0.5

Power Headers Activated -0. 2.0.5
Side Heads Activated 0. 1.0.7
Story Control Activated
—

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | “comecin o 7o wesste. resse wote.

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: | sales®@In-tools.com Password: ok ak ke

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

Euy

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Introduction

Plug-in Versions
Wold Tools CSS comes in two version: a basic version, as well as World Tools

Pro. The difference between the two versions are as follows:

World Tools (Basic) contains features which are necessary for right-to-left
layout, including all the necessary menu commands, style, and find/change
integration, as well as a dedicated World Tools (ME) panel which gives con-

trol of all the necessary features ME related features is a single inteface.

World Tools Pro has all the features of World Tools Basic plus access to fea-
tures used by Chinese Japanese and Korean (CJK) languages. Additionally,
World Tools Pro contains a Composite Font Editor, which can create and
edit “composite fonts” which use different fonts installed in your system de-
pendent on the specific unicode range of your text. There are Kanji, Kana,
Roman, Number, punctuation, straight quote, Hebrew, and Arbaic ranges.
Composite Fonts are exceptionally useful when composing mulitlingual

text in a single paragraph.

ME Options

Directional Settings
There are many different levels of directional controls when dealing with

right-to-left text. Below is an overview of what each type of control does.

1. Document Direction: Controls the binding direction (i.e. which way
the book opens). When a book lays with the front cover up, a left bound
(Roman) document has the spine on the left side, while a right-bound docu-

ment has the spine on the right. Right binding is used for right to left lan-
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guages such as Hebrew and Arabic, as well as Japanese books which are set

in a vertical orientation.

2. Story Direction: Controls which way the columns flow in a multicol-
umn text frame. The story direction is controlled in the ME version by us-
ing the ME text frame tool when creating the story, or changing the story
direction in the story panel. In World Tools, it’s controlled by using the Story

Direction menu items or the World Tools panel.

3. Table Direction: Controls the column direction within tables. In the
ME version, it’s controlled by a button on the tables panel, in World Tools, it’s
controlled by the Table direction menu options or the World Tools panel.

Please note: There is no option for setting the table direction in table styles.

Table direction must be set manually for each table.

4. Paragraph Direction: Do not confuse this with paragraph alignment.
The paragraph direction controls the overall direction of a paragraph. For
example: if you type an English word and then a Hebrew/Arabic word fol-
lowed by a period, if the paragraph direction is left to right the English word
will be on the left, the Hebrew/Arabic word will be to the right of that, while
the period will be all the way on the right. If the paragraph direction is right
to left, the direction will be reversed with the English word on the right, the
Hebrew/Arabic word to the left of that, with the period all the way on the
left. If there is not a mix of directions within the paragraph (i.e. all English
text), the only effect of paragraph direction will be on the punctuation at the
end and the position of drop caps/numbering/bullets.

nnm  There is a difference in behavior between the ME version and
World Tools. In the ME version, when you change the paragraph

direction, the paragraph alignment is automatically reversed
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as well. We have found this behavior annoying (we think the
alignment should be kept as it’s defined!) so we changed it in
World Tools The alignment can be manually set to whatever you

want.

S. Character Direction: This controls the direction of characters. “Word”
will come out “droW” when set to right to left. “Default” determines the di-
rection based on the writing script. When set to “Default” neutral characters

(like punctuation) are determined by the surrounding characters.

6. Keyboard Direction: In CS2 version 4.0.2, Winsoft introduced “Key-
board Direction”. The idea sound nice at first, but one which we believe is ill
conceived. Basically Keyboard direction does the same thing as Character
Direction (although character direction trumps keyboard direction when
there’s a conflict). The difference is that keyboard direction can be set au-
tomatically while typing. There’s an option to have the keyboard direction
on neutral characters inferred by the keyboard layout used when typing. If
a right to left keyboard layout is used, the keyboard direction is set to right
to left and vice versa. The problem is (besides the double functionality) that
people don’t always use the correct keyboard layout while typing. When
switching between languages, it’s very common to not switch keyboard lay-
out until starting to type. The neutral characters then have their direction
set by the user. The real problem is directional neutral characters (like pa-
renthesis, brackets, etc.) The appearance of the characters are affected by
their direction. For example: (parenthetical statement) will be encoded
<0028>parenthetical statement<0029> if the parenthesis are right to left
and <0029>parenthetical statement<0028> if the parenthesis are left to
right. This really gets messy once you start doing search and replaces, etc.
Things get really messed up and the user has no idea why...





ME Options /

To make matters worse, the keyboard direction settings do not show up as
style overrides so there’s no indication that they are applied unless you go

and check the keyboard direction menu listing...

We have not included the ability to set keyboard direction because we are
opposed to its existence. We strongly advise anyone receiving files from an
outside source to use the “Remove Keyboard Direction Overrides” com-
mand to ensure there are no keyboard direction settings anywhere in the

document.

Additional CJK Directional Controls

1. Column Orientation: In Japanese composition, text can be either verti-
cal or horizontal. When text is composed horizontally (as is the case in Ro-
man text), text columns are vertical—and column guides are as well. When
composing multi-column vertical text, the columns are horizontal. World
Tools Plus allows for setting horizontal columns in the World Tools (CJK)
panel.

2. Text Orientation: Japanese text can be set horizontally or vertically. For
vertical text, the story orientation should be set to vertical. This is set in the
World Tools (CJK) panel as well.

3. Table Orientation: Japanese tables which have vertical text are similar-
ly set as vertical rather than horizontal tables. Again, this is a toggle in the
World Tools (CJK) panel.

World-Ready Composer

As stated above, InDesign’s World-Ready composer creates the ability to
properly compose right-to-left text and all related features. It is our under-
standing that the World-Ready composer is based on Winsoft’s ME code
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base, so for the most part, the functionality should be similar to the ME
version. Any features relating to text composition which are available in the
ME version, but have not been available in the Roman version, will only
be properly composed if the World-Ready Composer is enabled. Any bugs
which might be related to the World-Ready Composer will also only be an
issue if the World-Ready composer is enabled for specific text. Some exam-
ples of features which are only available with the World-Ready Composer

are: localized digits, diacritic positioning, Hebrew / Arabic numbering, etc.

Japanese Composer

To use many of the myriad features offered by World Tools Pro, you must
use the Japanese composer. This includes vertical text, kinsoku-shori, moji-
kumi, tatechuyoku, ruby, kenten, character rotation,etc. Few, if any, of these
features will work unless the composer being used is the Japanese one. To
use the Japanese composer, select it in any of the drop-downs which allow

for setting the composer.

Please note: The World-Ready Composer and the Japanese Composer of the
CJK (Chinese, Japanese, and Korean) versions of InDesign are mutually ex-
clusive. The World-Ready composer does not support CJK line breaks or
the other CJK features, and the Japanese Composer does not support right-
to-left text or other ME features. This means that you must choose whether
you need proper ME / Indic composition, or CJK composition. Each para-
graph can be set with a different composer. For paragraphs with mixed CJK
and ME / Indic text, you must decide which composition rules are more
important. To access features of the Japanese Composer you must use either
World Tools Plus, or the CJK versions of InDesign.
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Working with World-Ready Documents

There will be three instances where you would be working with a World-
Ready document. 1) You are working on an existing ME document (created
in the ME version). 2) You are creating a new document which will have
right-to-left text. 3) You are editing an existing Roman or CJK Document,
and would like to add right-to-left text to the existing document.

Existing ME Documents

Existing ME documents will open correctly in any version of InDesign. You
do not even need World Tools for this. The World-Ready Composer will be
enabled by default and you can even make minor edits to the ME text. For
any edits which require control over ME features, though, you would need
either World Tools or the ME version of InDesign.

Existing Documents

To add ME or Indic text to an existing Roman or CJK document, you must
enable the World-Ready Composer. For Roman Documents, you can sim-
ply select “Enable World Ready Composition”. This will change any instance
of the regular Paragraph Composer or Single-line Composer to the corre-
sponding World-Ready Composer. For CJK documents, selecting this op-
tion will not have an effect on text that has the Japanese composer applied.
Instead you must select the World-Ready Composer for the appropriate
paragraphs or Paragraph Styles.

New Documents
By default, new documents in InDesign do not have the World-Ready Com-
poser enabled. To enable the World-Ready Composer, you can simply cre-

ate a new document and select the World-Ready Composer instead of the
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regular composer. There is also “Enable World-Ready Composition” in the
menu options which enables the World-Ready Composer for all text and
paragraph styles in the document. A document which was World-Ready en-
abled by World Tools is identical to a document which was created in the

ME version of InDesign.

Binding Direction

Binding Direction refers to the side of the pages on which a book is bound.
Books are either right bound or left bound. Books which are primarily writ-
ten in left-to-right languages are left bound, while books which are primar-
ily written in right-to-left languages (Hebrew or Arabic) are right bound.
The other type of book which is right bound is vertical Japanese. Japanese
books which are set horizontally are left bound, while ones set vertically are

right bound.

Binding direction can be set using the menu item: InTools >World Tools
Document > Right Bound/Left Bound Document. The binding direction
can also be set using the World Tools panels (see page 25).

ME Character Settings

OpenType Settings

There are a number of OpenType settings not normally available in the Ro-
man version of InDesign. World Tools makes these settings available under
the Character menu. The OpenType features require a font which supports
them. The additional features available are as follows: 1) Historical Forms:
These are special forms of letters which are generally somewhat archaic.
2) Justification Alternates: These are special stretched forms of glyphs which
are generally used to better justify text. These are the forms used by “Naskh
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Justification”. 3) Localized Forms: There are different forms of glyphs in
some languages. This feature applies the localized form. 4) Mark Position-
ing: Presumably this applies mark positioning programmed using the “mark”
OpenType feature. In our tests, we have not seen any effect by changing this
setting. We recommend using the Diacritic Positioning settings instead.
S) Overlap Swash: This enables swashes to overlap the following glyph pre-
venting unsightly spacing. This is commonly used in Arabic. 6) Stretched
Alternate: Enables the stretched forms of glyphs. 7) Stylistic Alternate: Uses
the glyph form programmed with the “salt” OpenType feature.

Kashidas
This option enables the use of kashidas in Arabic fonts. Kashidas are ex-

tended elements of glyphs which are used when justifying Arabic text.

Digit Types

Different languages around the world use different digit formats. The most
commonly used format for digits is what we call Arabic digits (1,2,3, etc.).
The World-Ready Composer supports 18 different digit formats.

Diacritic Positioning

(8] Diacritic Positioning...

Diacritic Position | OpenType I—:]

Horizontal 0 Vertical 0

The Diacritic Positioning dialog is a non-modal dialog which controls the
position of diacritic marks. For automatic OpenType positioning of marks,
select “OpenType” from the upper drop-down list. If you are using an old-
er non-OpenType font, you can select any one of the other options. The

» «

“Loose”, “Medium” and “Tight” settings affect the vertical placement of dia-
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critics in Arabic. In addition to the automatic placement, the diacritic can be
manually moved by editing the Horizontal and Vertical values. These values

are measured in 1/1000 em units.

Character Direction

Character direction controls which characters are considered right-to-left
and which ones are considered left-to-right. Under normal circumstances
Roman characters (as well as most writing scripts in the world) are left-to-
right. Arabicand Hebrew are the primary examples of scripts which are right-
to-left. When the character direction is set to “Default” InDesign tries to de-
termine automatically what the correct character direction is. For the most
part, this is simply a function of which Unicode range the glyph falls within.
Ifit’s in the Hebrew or Arabic range, it will be right-to-left, otherwise, it will
be left-to-right. For neutral characters (i.e. punctuation), InDesign uses an
algorithm to determine if they should be right-to-left or left-to-right. This is
based on the paragraph direction as well as the surrounding characters. Gen-
erally the Character Direction should be left with the default setting, unless

the default behavior puts neutral characters in the wrong place.

Keyboard Direction

In World Tools we did not include the ability to set keyboard direction. We
do not recommend its use, and we recommend removing all keyboard direc-
tion overrides on existing documents by selecting InTools >World Tools

- Character Direction >Remove Keyboard Direction Overrides.

CJK Character Settings
All CJK settings are set using the World Tools (CJK) panel. Please see page

25 for more information.
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Digits
World Tools Pro offers the ability to set any one of 20 numbering formats
which enables the use of the standard numbering systems used by many dif-

ferent languages.

Character Rotation

World Tools Pro offers the ability to rotate individual characters. For this
to function correctly, the Japanese composer must be used. If one of the
other composers are used, the entire paragraph will be rotated by the values

entered.

Tsume
Tsume is used to adjust the space around a character. It is similar to track-

ing controls, but designed specifcally for the needs of CJK typesetting.

Leading and Trailing Aki

These controls adjust the leading and trailing space of characters.

Tatechuyoko

Tatechuyoko is used to create a row of horizontal text within a column of
vertical text. It is commonly used for things like numbers. Tatechuyoko is
set on the character level and each span of text which has tatechuyoko ap-

plied will be a single row of text.

Ruby

Ruby is text decorations which are used to help in pronuciation of certain
characters. World Tools offers a toggle to turn on and off ruby. It also offers
a dialog which gives fine control over the appearance of the ruby. The dialog
is available from the World Tools (CJK) fly-out menu.
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Kenten

Kenten is a text adornment used to emphasize or distinguish words. World
Tools Pro offers a dialog for controlling kenten. It is available from the World
Tools (CJK) fly-out menu.

Warichu
Warichu is in-line text annotations. Whether text is considered warichu, can
be toggled using the warichu checkbox in the World Tools (CJK) panel.

Rotate non-CJK

When composing vertical type, you have the option to set non-CJK text
either upright or sideways. By deafult, non-CJK text will appear sideways. If
you would like it to appear upright, make sure “Rotate non-CJK” is selected.

Paragraph Settings

Paragraph Direction

The paragraph direction sets the overall direction of the paragraph. This
should not be confused with paragraph alignment. For example: if you type
an English word and then a Hebrew/Arabic word followed by a period, if
the paragraph direction is left to right the English word will be on the left,
the Hebrew/Arabic word will be to the right of that, while the period will be
all the way on the right. If the paragraph direction is right to left, the direc-
tion will be reversed with the English word on the right, the RtL word to
the left of that, with the period all the way on the left. If there is not a mix
of directions within the paragraph (i.e. all English text), the only effect of
paragraph direction will be on the punctuation at the end and the position
of drop caps/numbering/bullets.
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Here are some examples of left aligned left-to-right paragraphs:

. A bulleted paragraph.

“n»ay” is “Hebrew”.

“duyel)” is “Arabic”.

Here’s a few left aligned right-to-left paragraphs:
. Abulleted paragraph.

“m “maay “Hebrew”.

“0950 “dsyel “Arabic”.

Paragraph Numbering Formats

Besides the standard Roman Numbering Formats for numbered lists, World

Tools includes six ME numbering formats as well as eleven CJK formats.

Paragraph Justification Options

There are three different paragraph justification options available. These are
all applicable when the text is set to “justified”. The “Standard” setting sim-
ply adds space to justify text. The “Arabic” option will use kashidas to take
up space if kashidas are enabled. The “Naskh” option will use naskh justifi-
cation. If an OpenType font has justification alternates (jalt) programmed
into the font and “Naskh” is selected, these alternates will be used to justify
the text. The algorithm used is unpredictable. The justification alternates

will work in any language.
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CJK Paragraph Settings
All CJK settings are set using the World Tools (CJK) panel. Please see page

25 for more information.

Composer
To correctly compose CJK text, you must select the Japanese composer. The

Japanese composer enables all the CJK related features.

Kinsoku Shori

Kinsoku defines the basic kinsoku shori options for line breaking rules.
World Tools Pro offers five different kinsoku options: hard, soft, Korean,
Simplified Chinese and Traditional Chinese.

Mojikumi
The mojikumi setting allows for fine control over the spacing used when

breaking lines. World Tools Pro offers sixteen mojikumi presets.
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# World Tools (ME)
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(12 Default | [ Tatechuyoko
oo =]  [ElRuby

B ow = [ ] warichu

Vs o = [_] Rotate non-CJK
sl

To access the World Tools panels, select Window > World Tools > World
Tools (ME) or World Tools (CJK). These panels offers access to most of the
right-to-left and CJK features enabled by World Tools Pro.

ME Panel

In the ME panel, the top section offers toggles for Document Direction, Sto-

ry Direction, and Table Direction. The next section offers control of para-

graph attributes such as the composer, Paragraph Direction and Arabic jus-

tification options. The bottom section offers controls for character settings

including direction, digit formats and kashidas. Additionally, there is precise

control over diacritic positioning.
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CJK Panel

The CJK panel is similarly broken into logical sections. There is control over
the various direction and orientation options using toggles in the top sectio
of the panel. In the second section, there is also control over the different
composer options as well as line breaking and spacing options (kinsoku-
shori, mojikumi and gyoudori). The bottom section has the necessary char-

acter related options.

Ruby Settings
There are many ways Kenten and Ruby can be fine tuned in Japanese com-

position. World Tools Pro offers dialogs for controlling these settings:

Ruby Settings
Font: | Kozuka Gothic Pra | Ruby Content: OK
o s | |
Alignment: | s | D Qverhang D Auto Scaling
Parent Overhang: | One Ruby | [ Auto Align [ Auto Tey Auto Scale
Ruby Type: | EERi e | E OpenType Pro I:‘ Auta Tey Include Roman
Fill Color: | |
T A T A
Stroke Color: | | Size: =]  stroke: =
Overprint Fill: | Auto | Fill Tint: @ Stroke Tint: @
Overprint Stroke: | Auto | X Offset: 50 @ Y Offset: 50 @
Parent Spaclng:| | X Scale: 100% @ ¥ Scale: 100% @
Position: | Above Right | Parent Scaling: 66% @ Tey Digits: 1 @

The Ruby dialog is accessible from the World Tools (CJK) flyout menu:

Kenten...

Composite Font Editor...

About
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Kenten Settings
Kenter settings are available using a similar dialog also available in the World
Tools (CJK) flyout menu:

%

= |
ot s |
Alignment: | Center |
Slze: IE Stroke: iﬁ
Character Set: | Character Input |
X Scale: |100% || Y Scale: 100% (=
Kind: | Sesame Dot | - |j © |j

- Stroke Tint: 5 Fill Tint: iﬁ
Distance: 1 iﬁ

Custom Character:

Position: | Abowe Right |
Fill Color: | | Stroke Color: | |
Owerprint Fill: | Auto | Overprint Stroke: | Auto |

Composite Fonts
Composite fonts is a feature which has existed in the CJK versions of InDe-
sign for a long time, and in World Tools Pro, we are bringing their use to all

InDesign users for the first time.

Composite Font: My Custom Composite Font *
Range ot siie wxe | Baseine | V/scle | Wocle | [
Kana Kozuka Mincho Pro R 100% o 100% 100% ks
Roman Minion Pro Regular 100% o 100% 100% v
Hebraw Vilna Regular 110% o 100% 100% 04
Arabic DecoType Naskh Regular 100% o 100% 100% v
Add Range
Kozuka Mincho Pro |[® 100% (5|0 ~(100% [5+(100% 5+ [
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Simply put, composite fonts are pseudo-fonts which are made up of two or
more real fonts. Composite fonts allows you to select which fonts should be
used for specific Unicode ranges to correctly display characters in many dif-

ferent languages while using only a single font.

Creating Composite Fonts

To create a composite font do the following:

1. Open the Composite Font Editor. The Composite Font Editor is avail-
able from one of three locations: Window > World Tools > Composite
Font Editor, the fly-out menu of the World Tools (ME) panel or the fly-out
menu of the World Tools (CJK) panel.

2. Click “New Font”. This will create a new composite font with a single
range (Kanji). Kanji is the base range for every composite font, and it can-
not be changed. All adjustment of the other ranges are relative to the base

range.

3. Name your composite font. You can type the name directly into the
composite font combo-box. The name you give it will be the name which

appears in the font lists.
4. Add any ranges you need.

S. Select the font to use for each range. You can specify scaling and base-

line shift as well.

Using Composite Fonts
Composite fonts are used the same way regular fonts are used. Simply se-
lect your custom composite font from the font drop-down list. Documents

which use composite fonts have the composite font data embedded in the
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file, and should open correctly on any system using InDesign CSS5. The one
limitation is that all fonts used in a composite fonts must be installed for the
composite font to display correctly. The “document fonts” feature of CSS is

not compatible with composite fonts.

Style Settings

Paragraph Style Options

General Style Name: Main Text

Basic Character Formats Location: Text Styles

Advanced Character Formats World-Tools Options

Indents and Spacing Paragraph

Tabs

Paragraph Rules Direction: | Left to Ri... B: Justification: | Standard B:
Keep Dptions

Hyphenation Character Diacritics

lustification

Direction: | Default B: Diacritic Position: | OpenType B:
Span Columns —
Drop Caps and Nested Styles Digits: | Default B: Adjustments: Vertical: +0

GREP Style ) ) T
) Kashidas: | On o Horizontal: =0

Bullets and Numbering

Character Color

OpenType Features OpenType

Underline Options [ Justification Alternate M Mark Positioning _| Overlap Swash

Strikethrough Options
> [ Stylistic Alternate | Historical Forms [_| Roman ltalics
World-Tosls Options &) =] =

|| Stretched Alternate ELocaIized Forms

[ Preview (" Cancel ) E—GH

World Tools ME style settings are set in the standard style dialogs. Shown
above is the paragraph style options. Almost all the World-Ready options
are set using the “World-Tools Options” section. This includes, direction,

justification, character attributes, and OpenType attributes. The one excep-
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tion is the composer options which are added to the composer drop-down
in the “Justification” section as show below:

Cr e Lad Il
Adobe World-Ready Single-line Composer

[T v Adobe World-Ready Paragraph Composer

Adobe Japanese Single-line Composer

Adobe Japanese Paragraph Composer

Adobe Paragraph Composer

Adobe Single-line Composer

Single Word Justification-

I

The character style dialog is similar, but without the paragraph level attri-

butes:
Character Style Options
General Style Name: Header
Basic Character Formats Location:
Advanced Character Formats World-Tools Options

Character Color
Character Diacritics
OpenType Features

Underline Options Direction: B: Diacritic Position: B:
Strikethrough Options

World-Tools Options Digits: B: Adjustments: Vertical: =
Kashidas: B: Horizontal: =

OpenType

[=] Justification Alternate [=] Mark Positioning [=] Overlap Swash
[=] Stylistic Alternate [=] Historical Forms [=] Roman lItalics
[=] Stretched Alternate  [=] Localized Forms

[ Preview (" Cancel ) E oK 3

CJK Style Settings

There is currently no section in the style dialogs for setting CJK options, so
itis not possible to adjust CJK settings directly in the style dialogs. However,
it is possible to define styles with CJK settings. To do so, is a two step pro-
cess: 1. Set whatever CJK specific settings you need using the World Tools
panel. 2. Use the “Redefine Style” command.
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Redefine Style is accessible from a number of locations: a) There’s a key-
board shortcut: Command/Control + Option/Alt + shift + R. b) From the
control panel you can select Redefine Style from the dropdown next to the
style dropdown. c) Right clicking the style listing in the style panel d) The
command is available in the style panel flyout menu. Once a style is defined
with CJK options, these options will appear in the list of style attributes.

Find/Change Options

All ME World Tools options can be selected in both the find and change
dialogs as well:

Find Format Settings

World-Tools Options

Paragraph

Direction: | Right to... B: Justification: | B:
e Character Diacritics
an Calumns — R . m
Direction: | q. Diacritic Position: | B.
Bullets and Numbering L -
Characts Digits: | )-_—i: Adjustments: Vertical: =
OpenTy Kashidas: | B Horizontal: ~
Underl ions
Strikethrough Options CResTybe
Conditians [=] Justification Alternate [=] Mark Positioning [=] Overlap Swash

World -Tools Options.

[=] Stylistic Alternate [=] Historical Forms [=] Roman Italics
Drop Caps and Other

[=) Stretched Alternate  [=] Localized Forms

Other Options

Table Direction

The direction of a table determines whether columns start on the left or
right. The table direction is set by selecting InTools > World Tools > Ta-
ble Direction > (Left To Right / Right To Left). Table direction cannot be
set in table styles. The direction must be set manually on an individual basis.

The table direction can also be set in the World Tools panel (see page 25).
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Story Direction

The story direction controls whether columns of text in multi-column
frames flow from the right-to-left or left-to-right. The story direction is indi-
cated by the position of the in-ports and out-ports of text frames. The story
direction can be switched at any time by selecting InTools > World Tools
- Story Direction > Left to Right/Right to Left Story. The story direction

can also be set in the World Tools panel see page 25 for more information.

Footnote Numbering Options
Besides the standard Roman footnote numbering formats, World Tools in-
cludes four ME numbering formats as well as two CJK formats. This setting

is a document-wide setting, and is applied to the current document.

Chapter Numbering Formats
The Chapter Numbering format is also a document-wide setting. World

Tools includes six ME formats and eleven CJK formats.

Page Numbering Formats

The page numbering format is the format that the numbers take when using
automatic page numbers. Besides for the standard Roman number formats,
World Tools enables the use of four ME formats. The page numbering format

is applied to the section of the current active page.

World-Ready Composer

World Tools adds two new menu items to the Control Panel and Paragraph
Panel drop-down menus. Besides the standard Single-line and Paragraph
Composers, you can select the World-Ready variants of these composers.
Usually, there’s no reason you'd want to use the regular composers over the

World-Ready ones. The World-Ready composer is a super-set of the regular
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composer. However if you encounter a bug which is specific to the World-
Ready Composer, switching to the regular composer would be a work-
around the bug (although that would preclude working with ME text.) Also,
if you are using the CJK versions of InDesign, you might want to select the
Japanese Composer instead. The World-Ready Composer is a parallel com-

poser, and does not support the Japanese aspects of the Japanese Composer.

Additional Options

Apply Hebrew Character Style

A “writing script” is the set of characters used by the computer to compose
text. Each writing script uses a unique set of characters. Each scriptis unique,
but a script can include more than one language. For example, the Hebrew
script is used by Hebrew and Yiddish. The Latin script is used by English,
Spanish, French, and many others. The “Apply Style” functions recognize

characters based on their script, and apply character styles accordingly.

“Apply Hebrew Style” creates a Hebrew Character Style for Hebrew text.
This function should be used when the main paragraph text is in a language
other than Hebrew, and the Hebrew text needs its own formatting. It identi-
fies any text belonging to the Hebrew writing script, and takes into consid-
eration all Hebrew letters, nikud (vowel marks), and taamei hamikra (cantil-
lation marks). Additionally, it makes all single and double quotes “dumb’,
and applies the style to punctuation within Hebrew text. For example the
statement: This is jayn “Tixn” 190! becomes: This is yiyn “Txn” 790! In this
example the Hebrew style is styled with Fontbit David at a reduced size, the
quotes within the Hebrew statement had the Hebrew style applied to it and

were straightened. The exclamation point immediately after the Hebrew text
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retains its regular formatting. The character style should be set before run-

ning this command.

Apply Style To Hebrew Characters:

Source Paragraph Style: = Any 3] Ei)
Character Style to Apply: | [None] =2 ] (__Cancel )
Apply To: ) Document

() Story
() Selection

The above dialog box shows the options for applying the style. In the “Source
Paragraph Style” drop down list you can either select “Any” or a specific
Paragraph Style in your document. Choosing “Any” will apply the character
style to any Hebrew text in all the paragraphs of the specified range. Choos-
ing a specific style will limit the application of the style to text styled by that
specific Paragraph Style. Use the “Character Style to Apply” drop down list
to select the Character Style to apply.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Apply Latin Character Style
This option is similar to “Apply Hebrew Character Style”. It styles text be-
longing to the Latin script within a paragraph whose main language uses a

different writing script.
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Apply Style To Latin Characters:

Use Current Find Settings Instead [ ﬁ
Source Paragraph Style: = Any | :] ([ Cancel )
Character Style to Apply: ' [None] =5

Apply To Numbers 8

Apply To: @ Document
() Story
() Selection

The above dialog box shows the options for applying this style. Select “Use
Current Find Settings Instead” to search by criteria such as color, character
style, etc. The last find settings used in the application find and replace dia-
log will be used to find the text. Please note: If the “Use Current Find Settings”
is checked, the selection of the paragraph style is ignored. Whether or not this
box is checked the “Character Style To Apply” must be selected. If “Apply
To Numbers” is selected, numbers within the Latin text will be styled with

the selected character style.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Straighten Quotes
Hebrew and some other languages do not use curly quotes. Very often, curly
quotes can creep into Hebrew text unintentionally. Straighten Quotes was

created to deal with this issue.
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Straighten Quotes based on Style

Character Style to Change: = Any -5 ] ﬁ

Fa

Paragraph Style to Change: = Any B Cancel )

Apply To: @ Document
() Story
(") Selection

The options in the above dialog box are self-explanatory. Select a character
style, a paragraph style, both, or neither. You can also select the text range as
in to the “Apply Character Style” dialogs.

Switch Story Direction

Story direction in InDesign ME version is determined by text tool used to
draw the text frame containing the story. If the ME type tool is used, the
story direction will be right-to-left. If the regular type tool is used, the story
direction will be left-to-right. The importance of story direction is primarily
in the direction of text flow in multi-column text frames. The story direction

is set for the story as a whole, and not on a frame by frame basis.

Without this plug-in, InDesign ME allows story direction to be changed af-
terwards by selecting a different story direction in the Story Palette / Panel.
It is a very inconvenient way to switch story direction, since the only other
function of the Story Palette / Panel is the rarely accessed Optical Margin
Setting. The “Switch Story Direction” option provides a convenient way to
change the story direction. Since the command is a menu item, it allows you

to create a keyboard shortcut make changing story direction even easier.
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Number by Spread
This utility offers the option to increase page numbering once per spread
instead of once per page. This is useful when both pages in a spread need to

show the same page number.

Spread Numbering

Starting Page: | 1 ) ook )
Ending Page: 7 I:] (_ Cancel )

By default, the starting page will be the first page in the document, and the
ending page will be the last. These numbers can be set to any page in the

document, thereby giving spread numbering to only part of the document.

Undoing Spread Numbering
Spread numbering can be undone as well. The numbers in the drop-down

list will be the current page numbers — 1,1,2,2, and so on.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of Javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.
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To achieve true integration, plug-ins must be programmed using C++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using Ex-
tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters.

For more information see Rorohiko’s web site at www.rorohiko.com.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the



http://in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.






		What is World Tools?

		What World Tools is NOT!



		Installation

		Macintosh Install

		Windows Install



		Purchasing Licenses and Activation

		Introduction

		Plug-in Versions



		ME Options

		Directional Settings

		Additional CJK Directional Controls

		World-Ready Composer

		Japanese Composer



		Working with World-Ready Documents

		Existing ME Documents

		Existing Documents

		New Documents

		Binding Direction



		ME Character Settings

		OpenType Settings

		Kashidas

		Digit Types

		Diacritic Positioning

		Character Direction

		Keyboard Direction



		CJK Character Settings

		Digits

		Character Rotation

		Tsume

		Leading and Trailing Aki

		Tatechuyoko

		Ruby

		Kenten

		Warichu

		Rotate non-CJK



		Paragraph Settings

		Paragraph Direction

		Paragraph Numbering Formats

		Paragraph Justification Options



		CJK Paragraph Settings

		Composer

		Kinsoku Shori

		Mojikumi



		World Tools Panels

		ME Panel

		CJK Panel

		Ruby Settings

		Kenten Settings



		Composite Fonts

		Creating Composite Fonts

		Using Composite Fonts



		Style Settings

		CJK Style Settings



		Find/Change Options

		Other Options

		Table Direction

		Story Direction

		Footnote Numbering Options

		Chapter Numbering Formats

		Page Numbering Formats

		World-Ready Composer



		Additional Options

		Apply Hebrew Character Style

		Apply Latin Character Style

		Straighten Quotes

		Switch Story Direction

		Number by Spread

		Undoing Spread Numbering



		Addendum

		What is “APID ToolAssistant”?



		Acknowledgements

		License Agreement



